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Preface

This guide provides information about using and interpreting some advanced features 
of Oracle's StorageTek Tape Analytics (STA). It provides concepts and procedures for 
using these features.

Audience
This document is intended for new and experienced users of STA.

Documentation Accessibility
For information about Oracle's commitment to accessibility, visit the Oracle 
Accessibility Program website at 
http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.

Access to Oracle Support
Oracle customers have access to electronic support through My Oracle Support. For 
information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or 
visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing 
impaired.

Related Documents
The STA documentation set consists of the following documents.

For users of the STA application
■ STA Quick Start Guide—Use this guide to introduce yourself to the STA application 

and some features of the user interface.

■ STA User’s Guide—Use this guide for instructions on using STA application 
features, such as the Dashboard, templates, filters, alerts, Executive Reports, 
logical groups, and STA media validation.

■ STA Screen Basics Guide—Use this guide for details about the STA user interface. It 
describes the screen navigation and layout, and the use of graphs and tables. 

■ STA Data Reference Guide—Use this guide to look up definitions for all STA tape 
library system screens and data attributes.



xii

For installers and administrators of the STA server and application
■ STA Release Notes—Read this document before installing and using STA. It 

contains important release information, including known issues. This document is 
provided with the STA media pack download.

■ STA Requirements Guide—Use this guide to learn about minimum and 
recommended requirements for using STA. This guide includes the following 
requirements: library, drive, server, user interface, STA media validation, and IBM 
RACF access control.

■ STA Installation and Configuration Guide—Use this guide to plan for installation of 
STA, install the Linux operating system, install the STA application, and then 
configure library connections, users, and email addresses.

■ STA Administration Guide—Use this guide to learn about STA administrative tasks, 
such as error logging, server administration, database backup and restore, STA 
services configuration, password administration, and SNMP connection 
configuration.

■ STA Security Guide—Read this document for important STA security information, 
including requirements, recommendations, and general security principles.

■ Third Party Licenses and Notices—Read this document for information about use of 
third-party technology distributed with the STA product.

Conventions
The following text conventions are used in this document:

Convention Meaning

boldface Boldface type indicates graphical user interface elements associated 
with an action, or terms defined in text or the glossary.

italic Italic type indicates book titles, emphasis, or placeholder variables for 
which you supply particular values.

monospace Monospace type indicates commands within a paragraph, URLs, code 
in examples, text that appears on the screen, or text that you enter.
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What's New

This section summarizes new and enhanced features for StorageTek Tape 
Analytics v2.0.

STA v2.0, April 2014
New and enhanced features are described in the following manuals.

STA Requirements Guide
■ New guide that includes all minimum requirements for installing STA and using 

selected features

■ New minimum requirements to support STA v2.0

– Oracle Enterprise Linux (OEL) or Red Hat Enterprise Linux (RHEL) 6.3 or 6.4

– New minimum library firmware levels

– New drive firmware levels

■ Enhanced library and device support

– Support for LTO-6 drives

– Support for Oracle's StorageTek T10000D drives

– Support for SNMP library traps 13 and 14, providing enhanced library data 

– Support for Tape Transport Interface (TTI) 5.40, providing enhanced data from 
StorageTek T10000C and T10000D drives

STA Installation and Configuration Guide
■ Upgrade process to migrate STA v1.0.x database to STA v2.0

■ New ability to create STA usernames from within the STA user interface

■ New ability to assign user roles to STA usernames

■ Enhanced information provided when performing a library SNMP Check/Test 
Connection or Get Latest Data

STA Quick Start Guide
■ New guide that introduces new users to the STA application and some features of 

the user interface



xiv

STA User's Guide
■ New guide that describes how to use STA application features and interpret the 

data displayed by STA

■ New user roles that determine the screens and activities individual users can 
access

■ Enhanced Dashboard

– Over 50 new graph, table, and report Dashboard portlets provide summary 
views of your tape library system

– Highly customizable Dashboard display allows up to 30 portlets, arranged 
and filtered according to your specifications.

– Predefined Nearline Dashboard templates provide hourly, daily, weekly, or 
monthly system utilization summaries.

– New mobile Dashboard display

■ Enhanced template management

– New and enhanced STA predefined templates

– New Template Quick Links screen provides one-click access to predefined and 
custom templates.

– New Templates Management screen provides system-wide management of all 
templates.

– Users can assign their own default templates by screen.

– Users can import and export templates for sharing with other users.

■ Enhanced Filter dialog box, providing the following abilities:

– Filter by multiple exclusive or inclusive criteria

– Filter for blank attribute values

– Filter by user-defined logical group

– Reset an applied screen filter with one click

■ New Executive Reports based on customized Dashboard templates

– User-defined Executive Report policies allow you to specify report content 
and frequency.

– Reports are run automatically or on demand.

– Reports are generated in PDF format.

– Reports can be automatically emailed to selected addresses.

■ New logical groups for organizing drives and media

– Manual logical groups are user-maintained.

– Dynamic logical groups are automatically updated based on user-defined 
criteria.

– Logical groups can be used in defining selected policies and filters.

■ New alert policies and generated alerts notifying you of events and conditions in 
your tape library system

– User-defined alert policies allow you to specify alert generation criteria and 
frequency.
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– Alerts can be automatically emailed to selected addresses.

■ New STA media validation feature for T10000 T1 and T2 media 

– Requires minimum library firmware levels and T10000C and T10000D drive 
firmware levels supporting TTI 5.40.

– Provides automated media validations based on user-defined policies.

– Provides on-demand manual validations of single or multiple media.

– Media Validation Overview screen provides user management of validation 
requests.

– Provides comprehensive reporting of validation results.

– Optional automated drive calibration and qualification feature ensures 
validation drives are high performing.

STA Screen Basics Guide
■ Reorganized Navigation Bar throughout

■ New screen display best practices for avoiding and troubleshooting browser 
display issues

■ New user Annotations for List View table records and Dashboard. Annotation 
History is displayed in the Detail View.

■ Additional table Export formats—XLS, CSV, and PDF

■ New spark charts graph type used in Dashboard table portlets

STA Data Reference Guide
■ New screens for library hardware components—robots, cartridge access ports 

(CAPs), pass-thru ports (PTPs), and elevators

■ New screens for Alerts and Media Validation activities

■ Notifications Overview and Analysis screens have been renamed to All Messages 
Overview and Analysis

■ New Messages screens for libraries, drives, and media

■ New data attributes

– Media and Drive Health Trends

– Library and library complex capacities, including media slots and drive bays

– Library and library complex host request data

– Data for library hardware components—robots, cartridge access ports (CAPs), 
pass-thru ports (PTPs), and elevators

– Drive tray serial number

– Drive port speed

– Alerts detail and counts

– Media validation data

– Tape Alerts received from drives are now consistently labeled and grouped
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STA Administration Guide
■ STA processes split into three managed servers, which can be managed 

individually

■ Processed SNMP records are periodically purged from the database to minimize 
database growth.
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Getting Started 1-1

1Getting Started

Oracle's StorageTek Tape Analytics (STA) is an intelligent monitoring application 
available exclusively for Oracle's StorageTek Modular Tape Libraries. It simplifies tape 
storage management and allows you to make informed decisions about future tape 
storage investments based on the current health of your environment.

STA allows you to monitor globally dispersed libraries from a single, browser-based 
user interface. You can manage open systems and mainframe mixed-media, and 
mixed-drive environments across multiple library platforms. 

STA's detailed performance trending analyses allow you to increase the utilization and 
performance of your tape investments. These analyses are based on a continually 
updated database of library operations. STA captures and retains data from your tape 
library environment and uses this data to calculate the health status of your library 
resources (drives and media). STA aggregates data according to a variety of criteria 
and displays it in tabular and graphical formats, allowing you to quickly assess 
environment activity, health, and capacity. 

How This Section is Organized
This section introduces you to basic login and screen display features of the STA user 
interface. The following topics are discussed: 

■ "Supported Devices" on page 1-1

■ "STA Login Sessions" on page 1-2

■ "Login Tasks" on page 1-3

■ "Help" on page 1-7

Supported Devices
This section identifies the devices supported by STA. See the STA Requirements Guide 
for complete details about minimum firmware levels and other requirements.

In general, the newer the drive model and the more up-to-date the drive and library 
firmware, the richer the data that STA receives and the more in-depth the analysis it 
can perform. For best results, it is recommended that you update your drive and 
library firmware to the most current versions. 

StorageTek Modular Tape Libraries 
■ SL8500 standalone libraries and complexes

■ SL3000 
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■ SL500 

■ SL150

Drive and Media Types 
■ StorageTek T10000A, T10000B, T10000C, and T10000D drives

■ StorageTek T10000T1 and T10000T2 media

■ StorageTek 9840C and 9840D

■ HP LTO-3, LTO-4, LTO-5, and LTO-6, full Automation Drive Interface (ADI) 
support 

■ IBM LTO-3 and LTO-4, full ADI support 

■ IBM LTO-5 and LTO-6, basic support—Library Drive Interface (LDI) mode—only 

STA Login Sessions 
Your STA administrator will provide you with an STA username and password for 
logging into STA. Once you are logged in, you have access to all STA screens and 
features. See "Log In to STA" on page 1-3 for instructions.

Password Requirements
User passwords have the following format requirements:

■ Must be 8–32 characters in length

■ Must have at least one special character

■ Must not have any of the following special characters:

< > & ? ( ) {}*'
You can change your password at any time. See "Change Your Password" on page 1-6 
for details.

User Account Lockout
After five unsuccessful login attempts within a five-minute period, you will be locked 
out of your user account for 30 minutes. For security reasons, your account cannot be 
reset during the lockout period, even by the STA administrator, so you must wait the 
full 30-minutes before attempting to log in again. 

User Roles
Each STA username is assigned a user role, which determines the screens and activities 
the user can access. Your user role is displayed in the Main Toolbar, next to your STA 
username.

Note: For LTO drives, the ADI protocol must be enabled on both the 
drives and the library for STA to receive rich data about these drives. 
LTO 2 and SDLT drives do not support ADI, and therefore STA 
receives only minimal data about them. 
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The user roles are as follows:

■ Viewer – Can access all screens from the Home, Tape System Hardware, and Tape 
System Activity menus. 

■ Operator – Has all privileges of the Viewer role. Also has editing privileges for 
some Setup & Administration screens and view-only privileges on Configuration 
screens. 

■ Administrator – Has all privileges of the Operator role, plus has full editing 
privileges for all Setup & Administration screens.

For a complete description of the screens and activities available to each role, see the 
STA Installation and Configuration Guide. 

The STA documentation identifies the user role required to access screens and perform 
activities. If no role is identified, then the activity can be performed by all users.

Screen Navigation 
Do not use your browser's Forward and Back (or Next and Previous) buttons for 
navigating through the STA screens. The use of these buttons could produce 
unpredictable results, as the data you see may be stale or out of sync with the data on 
the STA server. To navigate, you should always use the methods provided by STA: the 
Navigation Bar and text links. 

See the STA Screen Basics Guide for complete details about STA screen navigation. Also, 
see the STA Screen Basics Guide for information about troubleshooting screen display 
and navigation issues. 

Logging Out
When you are ready to finish a login session, it is recommended that you log out of 
STA rather than simply closing the browser window. Logging out releases the session 
memory on the STA server for other processes. If you simply close the browser 
window, the session memory is not freed until the defined session timeout period is 
exceeded, possibly impacting STA performance, especially if your session timeout 
period is long. See "Log Out of STA" on page 1-4 for instructions. 

Login Tasks
■ "Log In to STA" on page 1-3

■ "Log Out of STA" on page 1-4

■ "Display STA Software Version Information" on page 1-5

■ "Change Your Password" on page 1-6

Log In to STA
Use this procedure to start an STA session. Before using this procedure, you must 
verify that your computer and browser are configured correctly. See the STA 
Requirements Guide for minimum requirements.

In addition, you must get the following information from your STA administrator:

■ URL of the STA application 

■ Your STA username and password
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1. Start a supported Web browser on your computer. 

2. In the Location Bar or Address field, enter the URL of the STA application. The 
URL uses one of the following formats:

http://local_host_name:port_number/STA 

https://local_host_name:port_number/STA 

where local_host_name and port_number are the name and port number of the STA 
server given to you by your STA administrator. Typically, STA runs on port 7021. 

The Login screen appears. 

3. Enter the STA username and password you have been assigned, and then click 
Login.

Depending on the preference settings for your STA username, the Accessibility 
Settings dialog box may appear. 

4. Complete the Accessibility Settings dialog box, if applicable, and then click OK. 
See the STA Screen Basics Guide for details on completing this dialog box.

The Dashboard appears.

Log Out of STA
Use this procedure to terminate your STA session. You can terminate your session at 
any time. 
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1. From any STA screen, click Logout in the Main Toolbar. 

Your login session is terminated and the Logged Out dialog box appears.

2. Click Go to Login. 

The Login screen appears. See "Log In to STA" on page 1-3 for instructions on 
logging in. 

Display STA Software Version Information
Use this procedure to display version information about the STA application and 
supporting software. This information is useful whenever you contact your Oracle 
support representative. 

1. Click About in the status bar in the lower-right corner of the STA screen.

Note: It is recommended that you log out of STA rather than simply 
closing the browser window. Logging out releases the session memory 
on the STA server for other processes. It is especially important to log 
out if your defined login session timeout period is long. See the STA 
Screen Basics Guide for related information. 
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The version information dialog box is displayed.

2. Click OK to dismiss the dialog box. 

Change Your Password
Use this procedure to change the password for your STA username. See "Password 
Requirements" on page 1-2 for details on valid password assignments. 

1. Select Preferences > General from the Main Toolbar.

The General dialog box appears.
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2. In the Change Password field, enter the new password you want to assign. 

The entry is masked as you type.

3. Enter the password again in the Verify Password field.

4. Click OK.

Your password is updated, and the next time you log in, you must use the new 
one.

Help
STA provides context-sensitive Help for all screens. Help buttons are located on the 
following toolbars:

■ Main Toolbar 

■ Template Toolbar

■ Graphics Area Toolbar

■ List View Table Toolbar (Overview screens only)

■ Pivot Table Toolbar (Analysis screens only) 
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■ Dialog boxes

Help Window Layout

Item Name Description

A Title Displays the title of the help system. 

B Helpset Quick Search Allows you to perform a quick search throughout the helpset. 

C Help Toolbar Provides direct access to commands for interacting with the helpset. See "Help 
Toolbar" on page 1-9 for details. 

D Topic Quick Search Allows you to perform a quick search within the currently displayed topic. 

E Help Navigation Bar Provides three navigation tabs: Contents, Index, and Search. See the following 
topics for details:

■ "Help Contents Tab" on page 1-9 

■ "Help Index Tab" on page 1-10

■ "Help Search Tab" on page 1-11

F Browse Buttons Allows you to browse sequentially through the help topics, forward and 
backward. 

G Topic Breadcrumbs Shows the current topic within the topic hierarchy. Click a parent heading to 
display that topic. 

H Topic Area Displays the contents of the help topic. 
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Help Toolbar
The Help Toolbar provides direct access to frequently used commands for displaying 
and using the help system.

Help Contents Tab
The Contents tab displays the table of contents for the helpset. Topics are listed in a 
hierarchical tree, with higher-level headings shown as folders. You can expand or 
collapse folders to list or hide the headings within. Click a heading to display the topic 
in the Topic Area. 

Icon Name Description

View menu Provides the following selections: 

■ Maximize Reading Pane – Toggles the expansion or collapse of 
the navigator pane.

■ Restore Default Window Layout – Rearranges the panes 
according to the default layout.

■ Contents – Expands the Contents tab in the Help Navigation 
Bar.

■ Index – Expands the Index tab in the Help Navigation Bar.

■ Search – Expands the Search tab in the Help Navigation Bar. 

■ Show permanent link for this topic page – Allows you to save 
a link to the current topic in your browser bookmarks.

Go back/forward 
one page 

Allows you to retrace your steps backward and forward through 
previously displayed topics. 

Print this topic page Opens your computer's print dialog box so you can print the 
current topic. 

Email this topic page Opens your computer's default email application so you can email 
the link to the current topic. 

Link to this topic 
page

Allows you to save the link to the current topic in your browser 
bookmarks. 
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Context Menu
Right-click within the Contents Tab to bring up the Context menu. 

Help Index Tab
The Index tab displays a sorted index of keywords in a two-level hierarchy. A keyword 
can be associated with multiple topics. 

Menu Selection Action

Print This Page Opens your computer's print dialog box so you can print the current 
topic. Also available through the Help Toolbar.

Email This Page Opens your computer's default email application so you can email 
the link to this topic. Also available through the Help Toolbar. 

Link to This Page Allows you save a link to the current topic in your browser 
bookmarks. Also available through the Help Toolbar.

Expand Expands the selected heading. 

Collapse Collapses the table of contents to hide the headings within the 
selected heading.

Expand All Below Expands the selected heading and all sub-headings within it. 

Collapse All Below Collapses the selected heading and all sub-headings within it. 

Show As Top Displays the current heading at the top of the Contents tab.
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Help Search Tab 
The Search tab allows you to construct a full-text query that searches throughout the 
helpset. 

Item Name Description

A Jump to keyword Enter one or more words in the text field. As you type, the first keyword in the list 
that matches the typed letters is selected. As more letters are typed, a more 
accurate selection is made. 

B Keyword list Two-level list of keywords, sorted alphabetically. Select a keyword to display the 
associated topic in the Topic list. 

C Expand/Collapse Pane Click to expand or collapse the Topic list. 

D Topic list List of keywords. Click a keyword link to display the associated topic in the Topic 
Area. Click a column heading (Topic or Source) to sort by that column. 
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Item Name Description

A Search text Enter one or more words in the text field. As you type, the first keyword in the list 
that matches the typed letters is selected. As more letters are typed, a more 
accurate selection is made. 

B Selection criteria Allows you to specify selection criteria for the search. 

C Expand/Collapse Pane Click to expand or collapse the Topic list. 

D Topic list List of search results. Includes the topic title, score, and source of each. Click a 
topic link to display it in the Topic Area. 

The Score column indicates the ranking of the topics according to how well they 
match the search criteria. By default, all topics are sorted by Score. Click a column 
heading (Topic Title, Score, or Source) to sort by that column. 
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2Dashboard

The Dashboard is the first screen you see when you log in. It consists of multiple 
portlets, each showing a different view of your tape library system. 

This section describes the concepts and detailed procedures associated with this 
process. Sections are:

■ "Using the Dashboard" on page 2-1

■ "Dashboard Layout" on page 2-6

■ "Portlet Types" on page 2-8

■ "Mobile Dashboard Display" on page 2-11

■ "Dashboard Tasks" on page 2-13

Using the Dashboard
Following is an example of the default Dashboard delivered with STA. Your display 
may differ if another Dashboard template has been assigned as the default for your 
STA username.
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Customizing the Dashboard
The Dashboard is fully customizable. There are over 50 different portlets to display, 
each one showing a different set of analytic and summary data collected by STA. You 
can include a maximum of 30 portlets at one time. See "Portlet Types" on page 2-8 for 
descriptions of the available portlets.

You can rearrange portlets, change their sizes, and filter the data that is shown on each 
portlet. See "Dashboard Tasks" on page 2-13 for instructions.

Dashboard Templates
If you have Operator or Administrator privileges, once you have arranged a 
Dashboard the way you like, you can save the display as a customized Dashboard 
template. The order and size of the portlets and any applied filters are saved as part of 
the template. 

Dashboard templates are the basis of Executive Reports. See "Executive Reports" on 
page 6-1 for details.
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Default Dashboard
Your default Dashboard view is determined by your STA username, not your user 
role. There may be a different default Dashboard template for each STA username. 

Times Displayed on the Dashboard
Because the Dashboard reports high-level summaries for your entire tape library 
system, all data is reported in UTC time. In contrast, all other STA screens report times 
adjusted for your local time zone (as specified in the time zone preferences for your 
STA username; see theSTA User’s Guide for details). 

In the sample Maximum Mount Time (Hourly) graph below, the selected mount shows 
a date and time of 3/18/14 9:00 AM. However, if you were to view this mount on the 
Exchanges Overview screen, the date and time would be adjusted to your time zone 
preference. For example, if your preference setting were UTC-5, the selected mount 
would show a date and time of 3/18/14 4:00 AM.on the Exchanges Overview screen.

Dashboard line graph portlet titled Hourly Maximum Mount Time. The tooltip for the 
mount selected on the graph indicates Date and Time 3/10/14 9:00 AM, and Mount 
Time 68,762.

***********************************************************************************************

Linking to Detail Screens
Some Dashboard portlets provide links to other STA screens, allowing you to drill 
down to more detail about the selected resources. See "Filtering Using Dashboard 
Graphics" on page 4-9 and "Apply a Filter From the Dashboard" on page 4-18 for 
additional information.

Note: It may take some time for a complex Dashboard arrangement 
to load on your screen. Applying filters to Dashboard portlets can also 
impact the screen loading time. If you experience long load times, you 
may want to break up a complex Dashboard into multiple, smaller 
Dashboards. 
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Graph Links
Bar charts, pie charts, and area charts bring up the List View for the selected resource, 
with a filter applied to the screen display. The following screens show how clicking on 
a pie chart section brings up the Media – Overview screen List View, filtered to show 
only the selected media type. 

Some graph sections may not have associated Overview screen information to display. 
For example, in the Library Media Slots portlet below, there is no media detail 
available for the Unallocated category, which represents media slots that are empty or 
not activated. Therefore, clicking on this section of the pie has no effect.
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Text Links
Some table portlets include text links, which bring up the Detail View for the selected 
resource. The following screens show how the drive serial number link on a 
Dashboard portlet brings up the Drives – Overview screen Detail View for the selected 
drive. See the STA Screen Basics Guide for additional information on text links.
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Dashboard Layout
The Dashboard is divided into equal-sized portlets that are arranged in columns and 
rows. There can be from one to five columns, and any number of rows. Rows can be 
100 to 600 pixels in height.
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Dashboard Toolbar
The Dashboard Toolbar appears at the top of the Dashboard. It provides direct access 
to frequently used commands for controlling the overall display of the Dashboard.

Item Name Description 

A Template Toolbar Provides direct access to commands for applying and managing templates. This 
toolbar appears on most STA screens. See "Templates Toolbar" on page 3-5 for 
details.

B Dashboard Toolbar Provides direct access to commands for managing the Dashboard display. See 
"Dashboard Toolbar" on page 2-7 for descriptions of each icon. 

C Dashboard portlet Dashboard portlets are arranged in columns and rows. Each portlet shows a 
different high-level view of your tape library system. See "Dashboard Portlets" on 
page A-1 for details. 

D Dashboard portlet title Identifies the type of data in the portlet. See "Dashboard Portlets" on page A-1 for 
details.

E Dashboard portlet 
toolbar

Provides direct access to commands for manipulating the display of this 
Dashboard portlet. See "Dashboard Portlet Toolbar" on page 2-8 for details. 

F Dashboard portlet 
border

Shaded area at the top of the Dashboard portlet. Allows you to grab the portlet 
and move it. See the STA Screen Basics Guide for details.

G Vertical scrollbar Appears only if there are additional rows below the bottom of the screen.
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Dashboard Portlet Toolbar
The Dashboard Portlet toolbar appears at the top of each Dashboard portlet. It 
provides direct access to frequently used commands for modifying the portlet. 

Portlet Types
The following portlet types are available:

■ "Graph Portlets" on page 2-9

■ "Table Portlets" on page 2-10

■ "Report Portlets" on page 2-11

Icon Name Description 

Help Displays help for the Dashboard.

Related Topic: "Help" on page 1-7

Column Count Displays the number of columns in the Dashboard display and allows 
you to change it. 

Related Topic: "Change the Dashboard Column and Row Layout" on 
page 2-14

Row Height Displays the height of each Dashboard row, in pixels, and allows you to 
change it. 

Related Topic: "Change the Dashboard Column and Row Layout" on 
page 2-14

Add Portlet 
menu

Menu provides options for you to add selected graph, table, or report 
portlets to the Dashboard display. 

Related Topic: "Add a Dashboard Portlet" on page 2-15

Icon Name Description 

Panel Information Displays a description of the portlet and allows you to add an 
annotation, which appears on Executive Reports.

Related Task "Add or Change a Dashboard Portlet Annotation" 
on page 2-17

Detach Pane Detaches the portlet from the screen and displays it in a separate 
window in the browser foreground. 

Related Topic: the STA Screen Basics Guide

Filter Data Displays a dialog box that allows you to define, modify, or reset 
filter criteria and apply them to the portlet. The first icon 
indicates there is no filter in effect; the second icon indicates a 
filter has been applied. 

Related Topic: "Apply or Change a Dashboard Portlet Filter" on 
page 2-18 and "Clear a Dashboard Portlet Filter" on page 2-20

Remove Pane Deletes the portlet from the Dashboard display.

Related Topic: the STA Screen Basics Guide
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See "Dashboard Portlets" on page A-1 for descriptions of the available portlets.

Graph Portlets
The following types of graph portlets are available. See "Graph Portlets" on page A-1 
for descriptions of individual portlets. See the STA Screen Basics Guide for additional 
details about the display and uses of the various graph types.

■ Bar chart—Used for point-in-time data.

■ Pie charts—Used for point-in-time data.

■ Line graphs—Used for date and time range data.
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For line graphs where there is only a single point of data—for example, a monthly 
graph where only a single month's data exists—a bar graph is displayed instead. 
Following is an example.

Table Portlets
The following types of table portlets are available. See "Table Portlets" on page A-4 for 
descriptions of individual portlets.

■ List table—Displays data in a traditional list table.

■ Trend report—Includes an embedded spark chart showing start, end, high, and low 
values over the range. See the STA Screen Basics Guide for additional information 
about spark charts.
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Report Portlets
Report portlets are text-only windows showing current information. See "Report 
Portlets" on page A-5 for descriptions of individual portlets.

Mobile Dashboard Display
STA supports the Dashboard display on mobile devices. You can display any 
Dashboard template available to your STA username. Regardless of your user role, 
however, the mobile display is read-only. You cannot link to other screens from the 
Dashboard nor can you rearrange portlets and save templates. Therefore, Dashboard 
templates accessed from a mobile device must first be created through a desktop STA 
connection. 

The Dashboard display is automatically optimized for your mobile device. For 
example, a three-column template may display in single column on a mobile phone 
but two columns on a tablet. Device rotation is also supported. See Figure 2–1 and 
Figure 2–2 for sample Dashboard displays.
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Figure 2–1 Sample Mobile Dashboard Display on a Tablet

Figure 2–2 Sample Mobile Dashboard Display on a Mobile Phone

Mobile Display Requirements
The following table lists the device operating system requirements for mobile display. 
In addition, all devices must run the default browser version provided with the device 
operating system. 
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Accessing STA From Your Mobile Device
Your mobile device must have access to the network on which STA is running. 

■ If the network is publicly accessible, you can simply open a browser window on 
your mobile device, enter the URL of the STA application, and then log in with 
your STA username and password. See "Log In to STA" on page 1-3 for 
instructions.

■ If the network is protected by a firewall or virtual private network (VPN), see your 
system administrator for access instructions. 

Dashboard Tasks
These procedures allow you to modify the appearance and arrangement of the 
Dashboard. If you have Operator or Administrator privileges, once you have modified 
the Dashboard display, you can save the arrangement as a Dashboard template.

■ "Change the Dashboard Column and Row Layout" on page 2-14

■ "Add a Dashboard Portlet" on page 2-15

■ "Add or Change a Dashboard Portlet Annotation" on page 2-17

■ "Apply or Change a Dashboard Portlet Filter" on page 2-18

■ "Clear a Dashboard Portlet Filter" on page 2-20

■ "Display the Dashboard on a Mobile Device" on page 2-22

You can also perform the following procedures with the Dashboard, and the 
instructions are the same as for other STA display areas.

■ Detach a Dashboard portlet. See the STA Screen Basics Guide

■ Remove a Dashboard portlet. See the STA Screen Basics Guide. 

■ Save the current Dashboard display as a new or modified template (Operator and 
Administrator users only). See "Create a Template" on page 3-12 or "Modify a 
Template" on page 3-14 for detailed instructions.

Device Type Operating System

Apple iPhone and iPad iOS 5.0 and above

■ iPhone 4S runs iOS 5.0

■ iPhone 5 runs iOS 6.0

■ iPad3 supports iOS 5.1.1

■ iPads 4 and 5 support iOS 6.13

Google Android Android 2.3 and above

■ Samsung and Amazon tablets run Android 
version 4.0

■ Google tablets run Android version 4.1

Blackberry Blackberry 7 OS and above

Windows tablets Latest version
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Change the Dashboard Column and Row Layout
You can change the size of the individual Dashboard portlets by modifying the column 
count and row height.

1. In the Navigation Bar, select Home > Dashboard.

The default Dashboard for your STA username is displayed.

2. To change the number of portlet columns, and therefore the width of each portlet, 
enter a number in the Column Count field in the Dashboard toolbar. You can also 
use the spinbox control arrows to change the field value. Valid entries are 1 to 5.

The change takes effect as soon as you press Enter or move the cursor to another 
area of the screen. 

Note: If you increase the number of columns, the Dashboard Portlet 
toolbars may be truncated due to lack of space. Any hidden icons are 
available from the menu at the far-right of the toolbar. 
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3. To change the height of each portlet, enter a number in the Row Height field in the 
Dashboard toolbar. You can also use the spinbox control arrows to change the field 
value. Valid entries are 100 to 600.

The change takes effect as soon as you press Enter or move the cursor to another 
area of the screen.

Add a Dashboard Portlet
Use this procedure to add a portlet to the Dashboard display. You can include a 
maximum of 30 portlets.

You can add more than one instance of the same type of portlet, and you can filter each 
instance differently so you can focus on different data. For example, you may want to 
add two separate Media Health portlets: one for big libraries (SL3000 and SL8500) and 
one for small (SL150 and SL500). 

1. In the Navigation Bar, select Home > Dashboard.

The default Dashboard for your STA username is displayed.

2. In the Dashboard toolbar, select the Add Portlet menu.

Note: Adding a large number of Dashboard portlets may result in 
the portlet legends being truncated or not displayed at all. If this 
occurs, you may want to remove some portlets to restore the legends.
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Submenus are listed for the portlet types—Graphs, Tables, or Reports.

3. From the appropriate portlet submenu, select the specific portlet you want to add. 
Time-related portlets provide you with options for Monthly, Weekly, Daily, or 
Hourly time increments.

The portlet is added to the end of the Dashboard display. You may need to use the 
vertical scrollbar to view it. To move the portlet to a new position, see the STA 
Screen Basics Guide.
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Add or Change a Dashboard Portlet Annotation
Use this procedure to add or modify a user-defined text annotation for the current 
portlet. The annotation appears on Executive Reports and can be used for a variety of 
purposes, such as clarifying the information displayed or drawing attention to specific 
data. 

Annotations can be up to 1,000 ASCII characters in length. There are no formatting 
options, such as boldface or color. Also, spacing options, such as forced line feeds, are 
not preserved on the Executive Reports.

For an annotation to appear on an Executive Report, the current Dashboard view must 
be saved as a template. Additionally, if you modify a portlet annotation, any existing 
Dashboard templates using that portlet must be re-saved in order for the updated 
annotation to appear on Executive Reports. See "Create a Template" on page 3-12 and 
"Modify a Template" on page 3-14 for detailed instructions.

1. In the Navigation Bar, select Home > Dashboard.

The default Dashboard for your STA username is displayed.

2. Click Panel Information in the Portlet Toolbar of the Dashboard portlet you want 
to annotate.

The Annotate dialog box appears.

Note: The text you enter is specific to the current Dashboard 
template. For example, if the Drive Health portlet appears in several 
Dashboard templates, each instance of the Drive Health portlet can 
have a different annotation associated with it. 

Note: Annotation text is specific to your STA username. For 
example, annotations entered by one user on the Drive Health portlet 
do not appear to a user logged in with a different STA username.
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3. Enter the annotation text you want to appear in this instance of the portlet, and 
click Save Annotation to save the information. Annotations can be up to 1,000 
characters in length.

Once saved, the annotation is not visible on the Dashboard portlet itself, but can 
be viewed by clicking Panel Information again. To have the annotation appear on 
an Executive Report based on this Dashboard display, you must save the display 
as a new template or an update to an existing template. 

Apply or Change a Dashboard Portlet Filter
Use this procedure to change the data displayed on a Dashboard portlet by applying a 
new filter or modifying an existing one. 

If a filter has been applied to a portlet, the Applied Filter icon is displayed. Some 
portlets are filtered by default, so they include this icon already. Hover the mouse over 
the icon to display a description of the applied filter. 

The criteria for filtering Dashboard portlets varies by portlet type. For example, you 
can filter most line graphs by a date range, but you cannot do so for a pie chart. 

1. In the Navigation Bar, select Home > Dashboard.

Note: To better view the text, you can resize the dialog box by 
grabbing the lower-right corner of the text area and stretching it.

Caution: To retain this annotation for future login sessions, you must 
save the current display as a template or an update to an existing 
template. If you log out of this session without saving the template, 
the annotation will be lost for future login sessions and Executive 
Report runs. 

Note: To remove all filter criteria from a Dashboard portlet, see 
"Clear a Dashboard Portlet Filter" on page 2-20.
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The default Dashboard for your STA username is displayed.

2. On the Dashboard Portlet toolbar of the portlet you want to modify, click Filter. If 
the portlet already has a filter applied, click Applied Filter.

The Filter Data dialog box appears. If no filter has been applied, the dialog box 
displays the default settings. If a filter is already in effect, the criteria are displayed 
in the dialog box.

3. Specify the filter criteria in the dialog box, as follows: 

a. In the Filter Matching field, select one of the options to indicate whether you 
want to match any or all of the criteria you specify. See "Filter Data Dialog 
Box" on page 4-2 for details.
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b. Indicate the filter criteria for as many portlet attributes as you want. Click Add 
new filter criteria row to add more criteria. 

c. To remove filter criteria, click Remove this filter criteria row. 

4. Verify that your specifications are correct, and then click Apply. 

The following updates are made to the Dashboard portlet:

■ The portlet displays a summary or analysis of only the records that match the 
criteria you have specified. 

■ The Dashboard Portlet Toolbar displays the Applied Filter icon. 

Clear a Dashboard Portlet Filter
Use this procedure to remove all filter criteria from a Dashboard portlet. Unlike graph 
portlets on other screens, there is no Reset Filter icon available on Dashboard portlets.
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1. In the Navigation Bar, select Home > Dashboard.

The default Dashboard for your STA username is displayed.

2. Click Filter Data in the Dashboard Portlet Toolbar.

The Filter Data dialog box appears, and all selection criteria currently in effect are 
indicated.

3. Click Reset. 

Note: To remove selected (not all) filter criteria from a Dashboard 
portlet, see "Apply or Change a Dashboard Portlet Filter" on 
page 2-18.
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The following updates are made to the Dashboard Portlet:

– All filter criteria are removed from the portlet so it displays all available 
records. 

– The Dashboard Portlet Toolbar displays the Filter icon. 

Display the Dashboard on a Mobile Device
Use this procedure to display a read-only version of the Dashboard on a mobile 
device, such as a mobile phone or tablet. See "Mobile Display Requirements" on 
page 2-12 to verify that your device is supported. 

1. Start a browser window on your mobile device and log in to STA. See "Log In to 
STA" on page 1-3 for details.

The default Dashboard template for your STA username is displayed.

Note: Before performing this procedure, you must obtain access to 
the network on which STA is running. See "Accessing STA From Your 
Mobile Device" on page 2-13 for details.

Note: The examples in this procedure are from a mobile phone 
display.
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2. To change the display, select the template you want to view from the Templates 
menu. 

3. To log out, click the Logout link at the bottom of the screen.
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3Templates

Templates provide modified STA screen views that can be saved, reused, and shared 
with other users. This chapter describes the concepts and detailed procedures for 
creating, using, and managing templates. Sections are as follows:

■ "Using Templates" on page 3-1

■ "Defining and Managing Templates" on page 3-2

■ "Template Toolbars and Screens" on page 3-4

■ "Template Usage Tasks" on page 3-7

■ "Template Management Tasks" on page 3-12

Using Templates
Templates are available for the Dashboard and all screens on the Tape System 
Hardware and Tape System Activity tabs. They are not available for screens on the 
Setup & Administration tab. 

Templates are screen-specific; a template for the Drives – Overview screen can be 
applied to that screen only and cannot be applied to the Drives – Analysis screen, for 
example. Each screen has a default template, which is the one that is automatically 
applied when you first navigate to that screen in a login session. 

To apply a different template to a screen, you simply select the template you want to 
use from the Templates menu in the Templates toolbar. If you leave the screen and 
later return, the last-used template remains applied. 

Template Defaults
In any given login session, the first time you navigate to a screen, the screen is 
displayed using the default template. Each screen has its own default, which you can 
designate. The default templates for each screen are user-specific, so each STA 
username may have its own set of assigned defaults. Each screen can have only one 
default.

You can assign defaults for your current STA username only. See "Set the Default 
Template for a Screen" on page 3-10 and "Clear the Default Template for a Screen" on 
page 3-11 for instructions.

The predefined templates provided with STA include a set of initial screen defaults. 
These templates are all named "STA-Default," one for each screen.
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Predefined Templates
STA is delivered with a set of predefined templates that provide frequently used 
information about library resources (such as libraries, drives, media) and events (such 
as exchanges and cleaning activities). 

Predefined templates are available to all users, but only users with Operator or 
Administrator privileges can make changes to them. You cannot modify the 
predefined templates directly; instead, you must save any changes to a new, custom 
template. You can, however, delete predefined templates that you do not use and then 
later restore them. 

Custom Templates
Any number of custom templates can be created for each screen. Only users with 
Operator or Administrator privileges can create or modify custom templates.

You create a custom template by modifying the current screen—such as changing 
graphed attributes, re-ordering columns in a list view table, or applying filter 
criteria—and then saving the new display as a template. When you save a template 
you assign it a name and designate its visibility (public or private) setting. 

Once you have saved a custom template, it is immediately available for the current 
and future login sessions. 

User Roles for Template Usage Activities
Some template activities can be performed by all user roles, whereas others are 
available only to users with Administrator or Operator privileges. The following table 
provides a summary of activities available to each role.

Defining and Managing Templates
Templates include a variety of screen display characteristics, such as graph and table 
layouts and filter criteria. Applying a template to a screen updates the screen display 
so it matches the characteristics defined in the template. 

STA provides a default template for each screen, as well as a set of predefined 
templates, which are available to all STA usernames. You can also create your own 
custom templates tailored to your needs and optionally share them with other users.

Note: Regardless of user role, you have access to all public templates 
and private templates owned by your current STA username. You 
cannot use private templates owned by another STA username. 

User Roles Template Activity Screen or Toolbar

Viewer and above Apply a template to the current screen 

Set the current template as the screen default for your STA 
username

Template toolbar

Viewer and above Display a list of all templates available to your STA username

Navigate to a screen with the selected template applied

Home > Quick Links

Operator and above Display a list of all templates available to your STA username

Change the default screen template for your STA username

Setup & Administration > 
Templates Management
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STA templates exhibit sticky behavior, in that once a template is applied to a screen, 
that template continues to be displayed whenever you access that screen during the 
remainder of the current login session, until you explicitly apply a different template. 

Screen Characteristics Included in the Template Definition
Changes to the following screen characteristics are saved as part of the template 
definition:

■ Graph display details, such as:

– Wide versus narrow view

– Graphed attributes

– Percent versus actual value display

– Date range

– Whether the Graphics Area is visible or collapsed (See the STA Screen Basics 
Guide for details.)

■ Table display details, such as:

– Hidden and visible columns 

– Column order

– Column width

■ Filter criteria

Screen Characteristics Not Included in the Template Definition
Changes to the following screen characteristics are not saved as part of the template 
definition:

■ Table resource selections applied to graphs

■ Table sort criteria

■ Specific data content 

Template Ownership and Visibility
Ownership and visibility for available templates are displayed on the Templates 
Management screen, which is available to all users with Operator or Administrator 
privileges. The two concepts are explained below.

Ownership
A template is owned by the STA username that created it, and the ownership cannot 
be changed. In the case of STA predefined templates, the owner is always "STA". If you 
have Operator or Administrator privileges, you can use, modify, rename, delete, and 
assign default status to any templates you own. 

Visibility
A template's visibility determines who can see and use the template. A template's 
visibility can be changed only by the owner. Visibility is either public or private, as 
follows:

■ Public – The template is available to all STA usernames. STA predefined templates 
are always public. If you have Operator or Administrator privileges, you can use, 
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modify, and delete any templates that have public visibility, even if they are 
owned by another STA username.

■ Private – The template is available only to the STA username that owns it.

Sharing Templates
You can share custom templates with other users through the STA import and export 
functions. For example, you can save a custom template, export it as an XML file to 
your local computer, and then email the XML file to another user. The other user can 
then log in to STA with their STA username, import the XML file, and begin using the 
template immediately. 

See "Export a Template" on page 3-17 and "Import a Template" on page 3-18 for 
instructions. These activities require Operator or Administrator privileges.

User Roles for Template Management Activities
Template management template activities are available only to users with 
Administrator or Operator privileges. The following table provides a summary of 
activities available to each role.

Template Toolbars and Screens
This section describes the following toolbars and screens, which allow you to use and 
manage templates:

Note: When an STA username is deleted, all private templates 
owned by that username are automatically deleted or made public, 
according to the selection made by the Administrator user performing 
the deletion. See the STA Installation and Configuration Guide for details.

Note: You can manage public templates and private templates 
owned by your current STA username. You cannot manage private 
templates that are owned by another STA username. 

User Roles Template Activity Screen or Toolbar

Operator and above Create a template

Modify the appearance of a template—custom templates only

Save a template to a new name—custom templates only

Change the public or private visibility settings of a 
template—custom templates owned by your STA username 
only

Template toolbar

Operator and above Rename a template—custom templates only

Change the public or private visibility settings of a 
template—templates owned by your STA username only

Export a template—custom templates only

Import a template

Delete a template

Restore the STA predefined templates

Setup & Administration > 
Templates Management
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■ "Templates Toolbar" on page 3-5

■ "Template Quick Links Screen" on page 3-5

■ "Templates Management Screen" on page 3-7

Templates Toolbar
For screens that have templates, the Templates Toolbar appears at the top of the main 
window area. It provides direct access to frequently used commands for applying and 
managing templates.

Template Quick Links Screen
The Quick Lists screen provides links to templates available to your STA username. 
Following is a sample of the default Quick Links screen provided with STA. Because 
the list is specific to the current STA username, your display may differ if other 
templates are available to your STA username. 

Icon Name Description

Help Displays help for template functions. 

Related Topic: "Help" on page 1-7

Templates menu Menu lists all available templates for this screen. The first 
entry is always "STA-Default". The list includes all predefined 
and custom templates available to the current user. Select a 
template to apply it to the current screen. 

Related Topic: "Apply a Template" on page 3-7

Save Template Allows you to save the current screen configuration, either as 
a new template or as a modification of an existing template (if 
you are the owner). 

Note: This icon is available only for Operator and 
Administrator users.

Related Topic: "Create a Template" on page 3-12 and "Modify 
a Template" on page 3-14

Default Template Allows you to set the current template as the screen default 
for the current STA username.

Related Topic: "Set the Default Template for a Screen" on 
page 3-10
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As shown in the following screen sample, each template name is a hot link, which you 
can click to navigate to that screen with the selected template automatically applied.

The templates are grouped by screen, such as Libraries Overview Templates, Drive 
Analysis Templates, Exchanges Templates, and so on. Within each screen group, the 
templates are listed in alphabetical order. The list is automatically updated with new 
templates or template name changes.

Quick links are available for the following template types:

■ All predefined templates – These are identified with an asterisk (*) after the name

■ All custom public templates

■ All custom private templates owned by the current STA username

Note: The Quick Links screen does not include the templates named 
"STA-Default" for each screen group. Therefore, if the only template 
available to your STA username for a particular screen is the one 
named "STA-Default," that group is not listed. It is added to the screen 
as soon as an available custom template is added.
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Templates Management Screen
The Templates Management screen, which is found on the Setup & Administration 
tab, is available only to Operator and Administrator users. 

Following is a sample of the default Templates Management screen provided with 
STA. Because the list is specific to the current STA username, you may see different 
templates listed on your display. 

As shown in the following screen sample, each template name is a hot link, which you 
can click to navigate to that screen with the selected template automatically applied.

Template Usage Tasks
■ "Apply a Template" on page 3-7

■ "Set the Default Template for a Screen" on page 3-10

■ "Clear the Default Template for a Screen" on page 3-11

Apply a Template
Use this procedure to apply a template to the current screen. When you initially 
navigate to a screen in a login session, the default template for your STA username is 
applied automatically. 

You can perform this procedure with any of the following methods:

■ "Using the Templates Toolbar" on page 3-8

■ "From the Quick Links Screen" on page 3-9

■ "From the Templates Management Screen" on page 3-10
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Using the Templates Toolbar

1. In the current screen, select the Templates menu.

The menu displays all templates that are available to your STA username. The 
currently displayed template is identified in the dark area of the Templates field.

2. In the Templates menu, select the template you want to apply.

Note: This option can be performed by any user.
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The new template is applied.

From the Quick Links Screen

1. In the Navigation Bar, select Home > Quick Links.

The screen displays templates available to your STA username.

Note: You can always verify the currently applied template by 
viewing the name displayed in the Templates field. 

Note: This option can be performed by any user.

Note: The templates named "STA-Default" are not included in the 
list.
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2. Select the text link of the template you want to use.

3. You are taken to the screen with the selected template applied.

From the Templates Management Screen

1. In the Navigation Bar, select Setup & Administration > Templates Management.

The screen displays all templates available to your STA username.

2. Select the text link of the template you want to use.

3. You are taken to the screen with the selected template applied.

Set the Default Template for a Screen
Use this procedure to assign a template as the screen default for your STA username. 
You can set only one default per screen, although each STA username can have its own 
set of defaults. 

You can perform this procedure with either of the following methods:

■ "From the Templates Toolbar" on page 3-10

■ "From the Templates Management Screen" on page 3-11

From the Templates Toolbar
1. In the current screen, from the Templates menu select the template you want to be 

the default.

Note: This option requires Operator or Administrator privileges.

Note: The templates named "STA-Default" are not included in the 
list.

Note: You cannot assign default templates for other STA usernames.
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The template is applied.

2. In the Templates menu, click Default Template.

The template is updated to be your default for this screen.

From the Templates Management Screen

1. In the Navigation Bar, select Setup & Administration > Templates Management.

2. Select the template you want to be the default for the selected screen.

3. Click Set Default in the Templates Management toolbar. 

The template is updated to be your default for the selected screen. This update 
does not take effect until your next login session. 

Clear the Default Template for a Screen
Use this procedure to clear the default template setting for a screen and re-assign the 
"STA-Default" template as the screen default for your STA username. 

1. In the Navigation Bar, select Setup & Administration > Templates Management.

2. Select the template you want to be the default for the indicated screen type.

3. Click Clear Default in the Templates Management toolbar. 

The "STA-Default" template is re-assigned as your default template for the selected 
screen.

Note: This option requires Operator or Administrator privileges.

Note: You cannot clear default templates for other STA usernames.

Note: This procedure requires Operator or Administrator privileges.
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Template Management Tasks
■ "Create a Template" on page 3-12

■ "Modify a Template" on page 3-14

■ "Rename a Template" on page 3-17

■ "Change the Visibility (Public or Private) Settings for a Template" on page 3-17

■ "Export a Template" on page 3-17

■ "Import a Template" on page 3-18

■ "Delete a Template" on page 3-19

■ "Restore the STA Predefined Templates" on page 3-21

Create a Template
Use this procedure to create and save a new template for the current screen. You can 
designate whether the template will be available to your STA username only or to all. 

1. Apply the desired changes to the current screen.

In the following example, the Media – Overview screen has been modified by 
collapsing the graphics pane so that only the tables area is visible.

Note: This procedure requires Operator or Administrator privileges.

Note: See "Screen Characteristics Included in the Template 
Definition" on page 3-3 for the types of screen changes that can be 
included in a template. 
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2. When you have made all the modifications you want, click Save Template. 

The Save Template dialog box appears.

3. Complete the Save Template dialog box, as follows:

a. In the Template Name field, type a new, unique name.
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b. In the Shared field, select a visibility option. See "Template Ownership and 
Visibility" on page 3-3 for additional information.

* Private – The template will be available to the current STA username only.

* Public – The template will be available to all STA usernames. 

4. Click Save.

The template is saved and the name is displayed in the Templates menu.

Modify a Template
Use this procedure to modify an existing template for the current screen. You can 
modify any custom template owned by your STA username. 

You must be the owner of the template to modify it directly. To modify an STA 
predefined template or public template owned by another STA username, you must 
save the modifications to a new name. See "Create a Template" on page 3-12 for 
instructions.

1. In the Templates menu, select the template you want to modify. 

The template is applied to the screen. 

Note: If the name already exists, when you click Save, depending on 
your user Confirmations preferences, you may be asked to confirm 
whether you want to overwrite the existing template. See "Modify a 
Template" on page 3-14 for instructions.

Note: This procedure requires Operator or Administrator privileges.
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2. Make the screen changes you want to include in the template. 

In this example, the screen is modified by applying the filter, "Media Type=TCLNU". 

3. Verify your changes, and then click Save Template in the Templates Toolbar. 

Note: See "Screen Characteristics Included in the Template 
Definition" on page 3-3 for the types of screen changes that can be 
included in a template. 



Template Management Tasks

3-16 StorageTek Tape Analytics User's Guide

The Save Template dialog box appears, and the current template name is supplied 
in the Template Name field.

4. Complete the Save Template dialog box, as follows:

a. Leave the Template Name field as is. 

b. Depending on whether you want to modify the visibility of the template, 
either select an option in the Shared field or leave the field as is:

* Private – The template will be available to the current STA username only.

* Public – The template will be available to all STA usernames. 

5. Click Save.

The Template Overwrite Confirmation dialog box appears.

6. Click Yes to confirm the modification.

Note: This dialog box does not appear if it has been turned off. See 
the STA Screen Basics Guide for details. 
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The template is updated with the changes you have specified. 

Rename a Template
Use this procedure to rename an existing custom template. You can rename any 
custom template available to your STA username, even if you are not the owner. You 
cannot rename STA predefined templates.

1. In the Navigation Bar, select Setup & Administration > Templates Management.

2. Select the custom template you want to rename.

3. Click Rename in the Templates Management toolbar. 

The Rename Template dialog box appears.

4. In the New Name field, type the name you want to assign. Your entry must be 
unique; you cannot enter a name that has already been assigned. 

5. Click OK. 

The name is updated.

Change the Visibility (Public or Private) Settings for a Template
Use this procedure to assign public or private visibility to a template owned by your 
STA username. 

1. In the Navigation Bar, select Setup & Administration > Templates Management.

2. Select the template you want to modify.

If the template is currently private, the Make Template Public icon in the 
Templates Management toolbar becomes active. If the template is currently public, 
the Make Template Private icon becomes active.

3. Click Make Template public/ private. 

The template is updated to according to your selection.

Export a Template
Use this procedure to export a custom template from the STA application to your 
computer in XML format. This allows you to share custom templates with other users. 

Note: This procedure requires Operator or Administrator privileges.

Note: This procedure requires Operator or Administrator privileges. 
In addition, your STA username must be the owner of the template.
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You can export any custom template available to your STA username, even if you are 
not the owner. You cannot export STA predefined templates.

1. In the Navigation Bar, select Setup & Administration > Templates Management.

2. Select the custom template you want to export.

3. Click Export in the Templates Management toolbar. 

The file is downloaded to your computer according to your browser settings. See 
your browser documentation for details. Following is a sample dialog box you 
might see on a computer running Windows. Note that the file will be saved with a 
.xml extension. 

Import a Template
Use this procedure to import an STA template received from another source so it is 
available to your STA username. This allows another user to export and email a 
custom template to you for your use. See "Sharing Templates" on page 3-4 for 
additional information.

The template you want to import must be located on a drive accessible to your 
computer, such as a local drive, network drive to which you are connected, or a flash 
drive mounted on your computer. 

1. In the Navigation Bar, select Setup & Administration > Templates Management.

2. Click Import Template in the Templates Management Toolbar. 

Note: This procedure requires Operator or Administrator privileges.

Note: This procedure requires Operator or Administrator privileges.



Template Management Tasks

Templates 3-19

The Import Template dialog box appears. 

3. Click Browse and navigate to the location of the template file you want to import. 

A navigation dialog box appears according to your browser settings. See your 
browser documentation for details. 

4. Use the navigation dialog to locate the template file and upload it. The file must 
have a .xml extension. 

5. The template is added to the list. The assigned Owner is your STA username, and 
the Visibility is set to Private.

Delete a Template
Use this procedure to delete a template from the STA application. The template is 
deleted for all STA usernames.
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You can delete any custom template available to your STA username, even if you are 
not the owner. You can also delete STA predefined templates, except for the templates 
named "STA-Default." 

1. In the Navigation Bar, select Setup & Administration > Templates Management.

2. Select the template you want to delete.

3. Click Delete in the Templates Management toolbar.

The Delete Template confirmation dialog box appears.

4. Click Yes to confirm the deletion.

Note: This procedure requires Operator or Administrator privileges.

Note: If you delete STA predefined templates, you can later restore 
them. See "Restore the STA Predefined Templates" on page 3-21 for 
details. 

Note: If the deleted template was the screen default for any STA 
usernames, then the "STA-Default" template for that screen becomes 
their new default. 

Note: This dialog box does not appear if it has been turned off. See 
the STA Screen Basics Guide for details. 
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The template is deleted and the Templates Management list is updated. 

Restore the STA Predefined Templates
Use this procedure to restore the STA predefined templates after deleting them. 

1. In the Navigation Bar, select Setup & Administration > Templates Management. 

2. Select Restore Predefined Templates from the Templates Management toolbar.

The template Reset dialog box appears. 

3. Click Yes. 

Note: This procedure requires Operator or Administrator privileges.

Note: This procedure does not affect custom templates you have 
created. 
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The predefined templates are immediately restored to the STA application and 
available to all users. Any custom templates you have created are also still 
available. The Templates Management list is updated. 
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4Filtering Data

STA enables you to filter the records displayed in pivot and list view tables. Filters 
allow you to focus on a subset of information by displaying just the records that meet 
specific criteria.

This section describes the effects of filters and the ways you can apply them. The 
following topics are discussed: 

■ "About Filters" on page 4-1

– "Filter Application" on page 4-1

– "Filter Duration" on page 4-2

■ "Applying a Filter" on page 4-2

– "Filter Data Dialog Box" on page 4-2

– "Filtering Using Aggregate Count Links" on page 4-7

– "Filtering by Applying a Template" on page 4-8

– "Filtering Using Dashboard Graphics" on page 4-9

■ "Filtering Tasks" on page 4-10

About Filters 
You can filter table data by any table attribute, whether or not that attribute is 
currently displayed on the table. You can specify filter criteria for any number of 
attributes, and you can choose whether any or all of the criteria must be met. See 
"Applying a Filter" on page 4-2 for complete details.

Once you apply a filter, the criteria are displayed in the Applied Filter area of the table. 
This allows you to verify which filter criteria have been applied to the current table 
view. If no criteria have been applied, this area is blank.

Filter Application 
Some screens on the Drives and Media tabs are paired with one another. For these 
pairings, any filter applied on one screen is automatically applied to its partner. The 
screen pairings are as follows: 

Note: Filter descriptions longer than 250 characters are truncated. 
You can hover the cursor over the text to display a tooltip containing 
the full description. 
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■ Drives – Overview and Drives – Analysis 

■ Media – Overview and Media – Analysis

■ All Messages – Overview and All Messages – Analysis

With the exception of these pairings, a filter applies only to the screen on which you 
apply it. Following are examples: 

■ If you apply a filter to the Drives – Overview screen, the same filter is 
automatically applied to the Drives – Analysis screen, but not to Drives – Cleaning 
Activities nor any other STA screen.

■ If you apply a filter to the Libraries – Overview screen (a screen with no "partner"), 
the filter applies to that screen only.

Filter Duration 
Once you have applied a filter to a screen, it remains in effect for the duration of your 
login session. If you navigate away from the screen and then return to it later in the 
session, the filter will still be in effect. To change or remove a filter, you must take one 
of the following actions:

■ Apply a new filter. See "Applying a Filter" on page 4-2 for details.

■ Remove the filter. See "Clear the Current Filter" on page 4-14 for details.

■ Apply a template; the filter criteria in a template overrides any existing criteria. 
See "Apply a Template" on page 3-7 for details.

■ Log out of STA. See "Log Out of STA" on page 1-4 for details.

Applying a Filter 
You can apply a filter in any of the following ways: 

■ By completing the Filter Data dialog box for a pivot or list view table. See "Filter 
Data Dialog Box" for details.

■ By clicking an aggregate count link in a pivot table. See "Filtering Using Aggregate 
Count Links" on page 4-7 for details.

■ By applying a template. See "Filtering by Applying a Template" on page 4-8 for 
details.

■ By clicking a section of a bar chart or pie chart on the Dashboard. See "Filtering 
Using Dashboard Graphics" on page 4-9 for details.

Filter Data Dialog Box 
The Filter Data dialog box appears when you click the Filter Data icon.  A sample 
dialog box is shown below.
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Item Name Description 

A Filter Matching field Allows you to specify the type of match you want to perform. Select one of the 
following options:

■ Match ANY of the following – Selects table records that meet any of the 
criteria you specify. This is the default.

■ Match ALL of the following – Selects only records that meet all of the criteria 
you specify 

B Filter criteria rows Each row specifies filter criteria to apply to the table. You can add as many rows as 
you want. On each row, you specify the criteria through the following menu 
selections:

■ Table attribute – All available attributes for the table are listed in the menu. 

Note: If you know the name of the attribute you want to select, you can type 
the first few letters to quickly move the cursor to that item in the menu.

■ Filter operators – Filter operators vary by attribute type. 

■ Attribute value – Attribute values vary by attribute. 

See Table 4–1, " Filter Operators by Attribute Type" for descriptions of the filter 
operators and attribute values. 

C Filter criteria buttons Buttons allow you to add new filter criteria rows or remove the associated row.

D Buttons Click one of the following buttons:

■ Apply – Applies the specified filter criteria to the table. See "Use the Filter 
Data Dialog Box to Change a Table Filter" on page 4-10 for details.

■ Reset – Removes all filter criteria so the table displays all records. See "Clear 
the Current Filter" on page 4-14 for details. 

■ Cancel – Exits from the dialog box without applying any changes.
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Table 4–1 Filter Operators by Attribute Type

Attribute Type Filter Operators and Attribute Values

Text 

For example, Drive Health Indicator, 
Volume Serial Number and 
Drive WWNN.

■ Is – Selects records with attribute values that match the specified 
string.

■ Isn't – Selects records with attribute values that do not match the 
specified string.

■ Is Blank – Selects records with blank or null attribute values. This is 
useful for selecting records that have not had an particular attribute 
value set in STA. For example, the criteria "% Drive Utilization (30 
Days) Is Blank" would select all drives that have not been used in the 
last 30 days.

■ Starts With – Selects records with attribute values that start with the 
specified string.

■ Contains – Selects records that contain the specified string anywhere 
within the attribute value.

■ Doesn't Contain – Selects records that do not contain the specified 
string anywhere within the attribute value.

■ Ends With – Selects records with attribute values that end with the 
specified string.

Text entries are not case-sensitive. For example, "ABC" matches "abc" or 
"Abc".

Some text attributes are free-form, in which case, you enter the string in 
the associated text entry field. Your entry is not case-sensitive.

Other text attributes are predefined, in which case you select the value 
from a menu of possible values. The values listed do not necessarily 
reflect currently applied filters or the current removed drives and media 
display settings for your STA username. For example, the "Drive Health 
Indicator" drop-down menu may include health values that are not 
currently included in any monitored libraries.

Note: When filtering by logical group, it is usually appropriate to use the 
"Contains" and "Doesn't Contain" operators, rather than "Is" and "Isn't". 
See "Filtering by Logical Group" on page 7-4 for details.
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Date and time stamp

For example, STA Start Tracking 
(Dates) and Last Exchange Start 
(Dates).

■ Equals – Selects entries with attribute dates and times equal to the 
one you specify.

■ Isn't – Selects entries with attribute dates and times not equal to the 
one you specify.

■ Is Before – Selects entries with attribute dates and times before the 
one you specify.

■ Is After – Selects entries with attribute dates and times after the one 
you specify

Enter the date and time as of your time zone. You can type the date and 
time directly into the associated text entry field, or you can use the 
calendar selector tool to select a date and time. Date and time stamps are 
entered in yyyy-mm-dd hh:mm:ss format.

Table 4–1 (Cont.) Filter Operators by Attribute Type

Attribute Type Filter Operators and Attribute Values
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Filtering Using Aggregate Count Links 
The cells within pivot tables contain aggregate counts of resources or events that meet 
specific criteria. A filter is therefore intrinsic to each aggregate count and is based on 
selection criteria represented by the pivot table edges. See the STA Screen Basics Guide 
for details on pivot table layers and filters.

For example, in the following Drives – Analysis pivot table, the "5" in the MONITOR 
column indicates that there are a total of five drives with a health status of "Monitor".

Number of days

For example, STA Start Tracking (No. 
Days) and Last Exchange Start (No. 
Days) 

■ Less than # days ago – Selects entries that occurred less than (<) the 
specified number of days ago.

■ More than # days ago – Selects entries that occurred more than (>) 
the specified number of days ago.

Type the value in the associated text entry field.

This operator is especially useful if you want to include a time-related 
filter in a saved template. By selecting records based on age rather than a 
specific date and time stamp, the filter is useful now and in the future.

Numeric

For example, Media Length in Meters 
and Exchange Elapsed Time.

■ Is – Selects records with attribute values equal to the specified value. 

■ Isn't – Selects records with attribute values not equal to the specified 
value. 

■ Less Than – Selects records with attribute values less than (<) the 
specified value.

■ Greater Than – Selects records with attribute values greater than (>) 
the specified value.

Type the value in the associated text entry field. Do not include units of 
measure, such as MB, in your entry. Decimals are allowed. 

Boolean

For example, Cleaning Media and 
Exchange Write Inefficient

■ True – Selects records for which the condition is true.

■ False – Selects records for which the condition is not true.

Table 4–1 (Cont.) Filter Operators by Attribute Type

Attribute Type Filter Operators and Attribute Values
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Clicking on this link takes you to the Drives – Overview screen and applies an 
appropriate filter based on the table edges The filter criteria are indicated in the 
Applied Filter area of the table. 

See "Use an Aggregate Count Link to Apply a Filter" on page 4-15 for detailed 
instructions.

Filtering by Applying a Template
Applying a template automatically applies any filter criteria that are included in the 
template definition. These criteria override any filter that may already be in effect.

For example, the following Drives – Analysis pivot table has an applied filter, "Drive 
Health Indicator=USE".

Note: The filter based on the table edges overrides any filter already 
applied to the Analysis or Overview screens.

Note: Filter descriptions longer than 250 characters are truncated. 
You can hover the cursor over the text to display a tooltip containing 
the full description. 
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Applying a template that includes a different filter, in this case "Drive Health 
Indicator=MONITOR", changes the table display and causes the original filter to be 
overridden.

The new filter criteria are indicated in the Applied Filter area of the table.

Filtering Using Dashboard Graphics
Bar, pie, and area charts on the Dashboard display aggregate data for resources or 
events that meet specific criteria. A filter is therefore intrinsic to each section of these 
Dashboard charts.

For example, in the following "Health by Media Type" graph, the selected section of 
the LTO-4 bar represents 34 drives with a health status of "Monitor".
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Clicking this section of the bar takes you to the Media – Overview screen and applies 
the intrinsic filter. The filter criteria are indicated in the Applied Filter area of the table. 

Filtering Tasks 
■ "Use the Filter Data Dialog Box to Change a Table Filter" on page 4-10

■ "Clear the Current Filter" on page 4-14

■ "Use an Aggregate Count Link to Apply a Filter" on page 4-15

■ "Apply a Filter From the Dashboard" on page 4-18

Use the Filter Data Dialog Box to Change a Table Filter

Use this procedure to apply new filter criteria to the current table. You can filter by one 
or more record attributes, and you can remove selected filter criteria.

For screens that are paired with a "partner", the filter applied to one screen is 
automatically applied to its partner. See "Filter Application" on page 4-1 for details.

1. Click Filter Data in the Table Toolbar.

Note: This procedure applies to both pivot and list view tables.
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The Filter Data dialog box appears. If a filter has already been applied, the criteria 
are displayed in the dialog box, as in the example below.

2. Specify the filter criteria in the dialog box, as follows: 

a. In the Filter Matching field, select one of the options to indicate whether you 
want to match any or all of the criteria you specify. See "Filter Matching field" 
on page 4-3 for details.

b. Click Add New Filter Criteria to add a new, blank filter criteria row to the 
dialog box.

c. Specify the filter criteria using the menus and text field on the row. See 
Table 4–1, " Filter Operators by Attribute Type" for details on filling out each 
row. 

Note: When selecting an attribute for filtering, if you know the name 
of the attribute you want to select, you can type the first few letters to 
quickly move the cursor to that item in the menu.
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d. You can add as many rows of filter criteria as you want.

e. To remove filter criteria, click Remove This Filter Criteria Row for the 
associated row.

3. Verify that your specifications are correct, and then click Apply. 

The following updates are made to the table:

– The table displays only the records that match the criteria you have specified. 

– The Applied Filter area indicates the specified criteria.

– For list view tables, the Table Status Line indicates the number of records.
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4. If the screen is one of a Drives, Media, or All Messages screen pairing, the filter 
criteria are also applied to its partner. You can navigate to the partner screen to 
verify this.

The Applied Filter area of the tables on both screens indicate the same filter.
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Clear the Current Filter

Use this procedure to remove all filter criteria from a table.

1. Click Reset Filter in the Table Toolbar.

The following updates are made to the table:

– All filter criteria are removed from the table so it displays all available records. 

– The Applied Filter area is blank, indicating no filter criteria are currently 
applied. 

– For list view tables, the Table Status Line indicates the number of records 
displayed.

Note: This procedure applies to both pivot and list view tables.

Note: To remove selected filter criteria from a table, see "Use the 
Filter Data Dialog Box to Change a Table Filter" on page 4-10.
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Use an Aggregate Count Link to Apply a Filter 
Use this procedure to apply a filter to an Overview screen by clicking an aggregate 
count link in the "partner" Analysis screen pivot table. The resulting display shows 
detail for the aggregate count. 

The aggregate counts in each table cell are the result of the filter criteria intrinsic to 
each table layer, joined by "AND" statements. Clicking an aggregate count link in a 
pivot table cell applies the associated filter criteria to the Overview screen.

1. Use the Navigation Bar to bring up an Analysis screen.

The Media – Analysis screen is used in this example.

Note: The filter applied with this method overrides any filter already 
applied to the Overview screen.
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2. In the pivot table, click an aggregate count link.

You are taken to the "partner" Overview screen (Media – Overview in this 
example), and the following updates are made to the list view table:

– The table displays only the records included in the pivot table aggregate 
count.

– The Applied Filter area indicates the filter criteria from the aggregate count.

– The Table status line indicates the number of records displayed; this number is 
the same as the aggregate count in the pivot table.
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3. Use the Navigation Bar to return to the Analysis screen. 

The filter remains active; therefore, the Analysis screen displays only the records 
that meet the selection criteria intrinsic to the original aggregate count link. 
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Apply a Filter From the Dashboard 
Use this procedure to apply a filter by clicking a section of a bar or pie chart on the 
Dashboard. You are taken to the corresponding Overview screen, and the filter 
intrinsic to the bar or pie chart section is applied. This procedure allows you to display 
detail about data displayed on the Dashboard.

1. Use the Navigation Bar to go to the Dashboard.

2. Click a section in a Dashboard bar or pie chart.
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You are taken to the corresponding Overview screen (Media – Overview in this 
example), and the following updates are made to the list view table:

– The table displays only the records included in the selected Dashboard section.

– The Applied Filter area indicates the filter criteria from the selected section.

– The Table status line indicates the number of records displayed; this number is 
the same as the Value for the selected Dashboard section.
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3. Use the Navigation Bar to select the "partner" Analysis screen, if applicable.

Note: This step applies to Drive, Media, and All Messages screens 
only.
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The filter remains active; therefore, the Analysis screen displays only the records 
that meet the selection criteria intrinsic to the selected bar or pie chart section. 
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5STA Alerts

The STA alerts feature notifies you of events and conditions in your tape library 
system based on user-defined alert policies. You can create as many alert policies as 
you want. The alert policies identify the types of conditions and events to which you 
want to be alerted and the frequency at which alerts may be generated. Optionally, 
you can indicate that you want alerts sent to specified email addresses.

The following topics are discussed in this chapter:

■ "How Alerts Work" on page 5-1

■ "User Roles for Alerts Management" on page 5-2

■ "Details on Defining Alert Policies" on page 5-3

■ "Alert Emails" on page 5-9

■ "Alerts Workflow" on page 5-10

■ "Alert Management Tasks" on page 5-10

How Alerts Work
The STA alerts process consists of the following parts: 

■ "Defining Alert Policies" on page 5-1

■ "Alert Generation" on page 5-2

■ "Monitoring Generated Alerts" on page 5-2

Defining Alert Policies
Users with Administrator privileges perform this part of the process from the Alerts 
Policies screen on the Setup & Administration tab. 

When you create an alert policy, you can enable it immediately or leave it disabled for 
the time being. In addition, several sample alert policies are delivered with STA, and 
they are disabled by default (see "STA Sample Alert Policies" on page 5-9 for details). 
Only enabled alert policies are used to generate alerts. 

To define an alert policy you specify the following information:

■ Policy name – An alphanumeric identifier for the policy. Policy names must be 
unique. 

■ Policy description – Optional description of the policy.

■ Entity type – Entities are tape library system resources or events. You must 
designate the types of entities to be evaluated by the alert policy. Options include 
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libraries, drives, media, exchanges, and media validations. See "Alert Policy 
Entities" on page 5-3 for a complete list. 

■ Severity – Determines the frequency with which alerts may be generated 
whenever the criteria defined by this policy are met. See "Alert Policy Severities" 
on page 5-4 for details.

■ Alert criteria – User-defined criteria by which the appropriate library system 
resources are evaluated. Alert criteria work in much same way as the STA filtering 
feature. See "Filter Data Dialog Box" on page 4-2 for details.

■ Email recipients – Optional list of email addresses to receive emails whenever an 
alert is generated by the policy. See "Alert Emails" on page 5-9 for details. 

Alert Generation
This part of the process is done automatically by STA. 

STA continuously evaluates enabled alert policies in the background. Specifically, alert 
policies are evaluated whenever the following types of activities occur:

■ An enabled alert policy is created or modified in any way.

■ A drive/media exchange occurs.

■ A media validation exchange occurs.

■ An SNMP trap is received from a monitored library.

■ A library data collection occurs.

■ An STA application or server event occurs.

STA generates alerts based on the alert policy criteria and severity. If the policy criteria 
are matched and enough time has passed since the last alert for the same library 
resource and event, a new alert is generated. The time period is determined by the 
policy severity. See "Alert Policy Severities" on page 5-4 for details:

If the alert policy includes email addresses, an email containing details about the alert 
is sent to the designated addresses. See "Alert Emails" on page 5-9 for details.

For additional details about the alert policy evaluation process, see "Alert Policy 
Severity Examples" on page 5-4. 

Monitoring Generated Alerts
Any STA user can perform this part of the process from the Alerts Overview screen on 
the Tape System Activity tab. 

The screen displays a list of generated alerts, and you can sort, filter, export, and print 
this list according to your needs. Users with Operator privileges can also annotate 
selected alerts.

If you are using an alerts workflow at your site, you can update the state of selected 
alerts to reflect current progress. Alerts workflow management is an optional manual 
process. See "Alerts Workflow" on page 5-10 for details.

User Roles for Alerts Management
Table 5–1 summarizes the alert policy definition activities available to each STA user 
role.
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Table 5–2 summarizes the alert monitoring activities available to each STA user role.

Details on Defining Alert Policies
This section provides additional detail to help you in creating alert policies. The 
following information is included:

■ "Alert Policy Entities" on page 5-3

■ "Alert Policy Severities" on page 5-4

■ "Alert Policy Best Practices" on page 5-8

■ "STA Sample Alert Policies" on page 5-9

Alert Policy Entities
You can define alert policies for the following types of entities, or tape library system 
resources and events:

■ Library complex

■ Library

■ Drive

■ Media

■ Robot

■ CAP

■ PTP – Relevant only to SL8500 libraries.

Table 5–1 Alert Policy User Roles

User Role Alert Policy Activity Screen

Operator and above Display, filter, and print a list of defined alert policies. Setup & Administration > 
Alerts Policies

Administrator only Define an alert policy.

Copy an alert policy.

Rename a policy.

Change the policy criteria.

Change the list of email recipients.

Enable or disable an alert policy.

Delete an alert policy.

Setup & Administration > 
Alerts Policies

Table 5–2 Alert Monitoring User Roles

User Role Alert Monitoring Activity Screen

Viewer and above Display, filter, and print a list of all generated alerts.

Export the alerts list to a spreadsheet or document.View detail 
for a selected alert.

Change the state of a selected alert.

Show or hide dismissed alerts.

Tape System Activity > 
Alerts Overview

Operator and above Annotate an alert. Tape System Activity > 
Alerts Overview
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■ Elevator – Relevant only to SL8500 libraries.

■ Exchange – See "Alert Policy Severities" on page 5-4 for information about how 
Exchange alert policies are processed differently from other policy types. 

■ Media validation – Applies only if media validation is enabled in STA. Alerts are 
triggered by final validation results only, not intermediate results. See "STA Media 
Validation" on page 8-1 for details.

■ STA application itself – To be notified whenever the STA application restarts.

Alert Policy Severities
The policy severity determines the frequency with which alerts may be generated from 
the policy. The severity levels are as follows:

■ Severe – An alert may be generated once an hour.

■ Warning – An alert may be generated once every 24 hours.

■ Informative – Only one alert is generated; no additional alerts are generated, even 
if the policy criteria continue to be met.

See "Alert Policy Severity Examples" on page 5-4 for examples detailing the effects of 
the assigned severity levels. 

Exchange and Media Validation Activities Alert Policies and Severities
Because exchanges and media validations are discrete events, not persistent resources, 
exchange and media validation alert policies generate alerts whenever a new exchange 
or validation is processed and the policy criteria are matched, regardless of time 
frames. Therefore, the severity levels you assign to these alert policies are irrelevant. 
See Example 5 and Example 6 below for details. 

Additionally with exchange and media validation alert policies, you must take care 
not to create overlapping policies that might generate multiple alerts from the same 
exchange or validation. See "Avoiding Too Many Alerts" on page 5-8 for details.

Alert Policy Severity Examples
The following examples illustrate how and when alerts are generated based on specific 
policy criteria and severities. These examples show how a policy's severity level 
influences the frequency of alert generation. You can use this information to decide 
which severity levels to assign to your alert policies.

■ Example 1, ""Warning" Policy for Drives"

■ Example 2, ""Informative" Policy for Drives"

■ Example 3, ""Severe" Policy for Media"

■ Example 4, ""Severe" Policy for CAPs"

■ Example 5, "Policy for Exchanges Using "Media Health Indicator""

■ Example 6, ""Warning" Policy for Media Using "Media Health Indicator""

Example 1  "Warning" Policy for Drives
This policy generates alerts for drives that require attention because they have 
ACTION or EVALUATE health.

Policy entity: Drives

Policy severity: Warning – alerts may be generated every 24 hours. 
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Policy criteria: Drive Health Indicator is ACTION, or Drive Health Indicator is 
EVALUATE. 

Example 2  "Informative" Policy for Drives
This example presents the same policy criteria as Example 1 but with an "Informative" 
severity.

Policy criteria: Drive Health Indicator is ACTION, or Drive Health Indicator is 
EVALUATE. 

Policy entity: Drives

Policy severity: Informative – alerts are generated only once. 

Time Events Evaluation Result

05:00:17, Day 1 The policy is created 
and enabled.

Drive 1 health is 
EVALUATE.

Drive 2 health is 
MONITOR.

The policy is evaluated 
for all drives and 
matched for Drive 1 but 
not Drive 2.

An alert is generated for Drive 1 and emails 
sent to the defined recipients. 

No alert for Drive 2.

08:12:24, Day 1 Drive 1 health goes to 
ACTION.

Drive 2 health is still 
MONITOR.

The policy is evaluated 
for all drives and 
matched for Drive 1 but 
not Drive 2.

Since it has been less than 24 hours since 
the last alert for Drive 1, no new alert is 
generated.

No alert for Drive 2.

13:37:01, Day 1 Drive 1 health is still 
ACTION.

Drive 2 health goes to 
EVALUATE.

The policy is evaluated 
for all drives and 
matched for both 
Drive 1 and Drive 2.

No alert for Drive 1.

An alert is generated for Drive 2 and emails 
sent to the defined recipients.

05:01:03, Day 2 Drive 1 health is still 
ACTION.

Drive 2 health is still 
EVALUATE.

The policy is evaluated 
for all drives and 
matched for both 
Drive 1 and Drive 2.

Since it has been more than 24 hours since 
the previous alert for Drive 1, a new alert is 
generated and emails sent to the defined 
recipients.

No new alert for Drive 2 since it has been 
less than 24 hours since the last alert for 
Drive 2.

17:08:43, Day 2 A new email recipient is 
added to the policy.

Drive 1 health is still 
ACTION.

Drive 2 health is still 
EVALUATE.

The policy is evaluated 
for all drives and 
matched for both 
Drive 1 and Drive 2.

No new alert for Drive 1.

Since it has been more than 24 hours since 
the previous alert for Drive 2, a new alert is 
generated and emails sent to the defined 
recipients.

Time Events Evaluation Result

05:00:171 The policy is created 
and enabled.

Drive 1 health is 
EVALUATE.

Drive 2 health is 
MONITOR.

The policy is evaluated 
for all drives and 
matched for Drive 1 but 
not Drive 2.

An alert is generated for Drive 1 and emails 
sent to the defined recipients. No 
additional alerts will be generated by this 
policy for this drive.

No alert for Drive 2.
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Example 3  "Severe" Policy for Media
This policy generates alerts for exchanges resulting in a 5135 FSC. This FSC indicates 
issues with the tape leader, and the media should be ejected from the library and 
examined as soon as possible.

Policy entity: Media

Policy severity: Severe – Alerts may be generated every hour depending on exchange 
activity.

Policy criteria: Exchange FSC is 5135. 

Example 4  "Severe" Policy for CAPs
This policy generates alerts for CAPs that require attention.

Policy entity: CAPs

Policy severity: Severe – Alerts may be generated every hour. 

08:12:24 Drive 1 health goes to 
ACTION.

Drive 2 health is still 
MONITOR.

The policy is evaluated 
for all drives and 
matched for Drive 1 but 
not Drive 2.

No new alert for Drive 1.

No alert for Drive 2.

13:37:01 Drive 1 health is still 
ACTION.

Drive 2 health goes to 
EVALUATE.

The policy is evaluated 
for all drives and 
matched for both 
Drive 1 and Drive 2.

No new alert for Drive 1.

An alert is generated for Drive 2 and emails 
sent to the defined recipients. No 
additional alerts will be generated by this 
policy for this drive.

05:01:03 Drive 1 health is still 
ACTION.

Drive 2 health goes to 
USE. 

The policy is evaluated 
for all drives and 
matched for Drive 1 but 
not Drive 2.

No new alerts for Drive 1 nor Drive 2. 

Time Events Evaluation Result

08:00:53 The policy is created 
and enabled.

The policy is evaluated 
as new exchanges are 
processed and no match 
is found.

No alerts are generated.

08:05:09 A 5135 FSC occurs on an 
exchange for Media A.

The policy is evaluated 
as new exchanges are 
processed and matched 
for Media A.

An alert is generated for Media A and 
emails sent to the defined recipients.

No additional alerts will be generated by 
this policy for this exchange. Media A will 
have no more alerts from this policy until it 
is involved in a new exchange (assuming 
future exchanges also result in a 5135 FSC). 

09:13:17 A 5135 FSC occurs on an 
exchange for Media B.

The policy is evaluated 
for new exchanges and 
matched for Media B.

An alert is generated for Media B and 
emails sent to the defined recipients.

No additional alerts will be generated by 
this policy for this exchange.

10:35:22 A 5135 FSC occurs on a 
new exchange for 
Media A.

The policy is evaluated 
for new exchanges and 
matched for Media A.

An alert is generated for Media A and 
emails sent to the defined recipients.

No additional alerts will be generated by 
this policy for this exchange.

Time Events Evaluation Result
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Policy criteria: CAP Library Health is NOTOPERATIVE or CAP Library Health is 
DEGRADED. 

Example 5  Policy for Exchanges Using "Media Health Indicator"
Exchange alert policies differ from policies for other library system components in that 
the severity of the policy is irrelevant. Because exchanges are discrete events, exchange 
alert policies always generate alerts when the policy criteria are met, regardless of 
policy severity. This example illustrates this point. See Example 6 for a similar example 
that results in fewer alerts.

Policy entity: Exchanges

Policy severity: Because this is an exchange alert, the policy severity is irrelevant. In 
this case, the severity is "Informative," but the results would be the same for all 
severity levels: alerts are generated for all exchanges involving media with 
EVALUATE health.

Policy criteria: Media Health Indicator is EVALUATE. 

Time Events Evaluation Result

14:05:10 The policy is created 
and enabled.

CAP 1A is in a 
DEGRADED state.

The policy is evaluated 
for all CAPs and 
matched for CAP 1A.

An alert is generated for CAP 1A and 
emails sent to the defined recipients. 

15:01:12 CAP 2B goes into a 
NOTOPERATIVE state.

The policy is evaluated 
for all CAPs and 
matched for both 
CAP 1A and CAP 2B.

No new alert for CAP 1A.

An alert is generated for CAP 2B and 
emails sent to the defined recipients.

15:05:20 CAP 1A is still 
DEGRADED and 
CAP 2B is still 
NOTOPERATIVE.

The policy is evaluated 
for all CAPs and 
matched for both 
CAP 1A and CAP 2B. 

A new alert is generated for CAP 1A and 
emails sent to the defined recipients.

No new alert for CAP 2B. 

16:01:27 CAP 1A is still 
DEGRADED and 
CAP 2B is still 
NOTOPERATIVE.

The policy is evaluated 
for all CAPs and 
matched for both 
CAP 1A and CAP 2B.

No new alert for CAP 1A.

An new alert is generated for CAP 2B and 
emails sent to the defined recipients.

Time Events Evaluation Result

13:13:17, Day 1 The policy is created 
and enabled.

Media Z health is 
EVALUATE.

The policy is evaluated 
for all exchanges and no 
match is found.

No alert is generated.

14:43:09, Day 1 An exchange occurs for 
Media Z, whose health 
is EVALUATE.

The policy is evaluated 
for all exchanges and 
matched for Media Z.

An alert is generated for Media Z and 
emails sent to the defined recipients.

07:20:24, Day 1 Another exchange 
occurs for Media Z, 
whose health is still 
EVALUATE.

The policy is evaluated 
for all exchanges and 
matched for Media Z.

A new alert is generated for Media Z and 
emails sent to the defined recipients.

15:05:19, Day 2 Another exchange 
occurs for Media Z, 
whose health is still 
EVALUATE.

The policy is evaluated 
for all exchanges and 
matched for Media Z.

A new alert is generated for Media Z and 
emails sent to the defined recipients.
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Example 6  "Warning" Policy for Media Using "Media Health Indicator"
This policy generates alerts for media with EVALUATE health. This example is similar 
to Example 5, but because it is a Media alert policy, it results in fewer alerts.

Policy entity: Media

Policy severity: Warning – alerts may be generated every 24 hours.

Policy criteria: Media Health Indicator is EVALUATE. 

Alert Policy Criteria
You can define alerts based on any attribute available for the selected alert Entity. 
However, not all attributes create events that will actually trigger an alert. In addition, 
for Media Validation alert policies, alerts are triggered by final validation results only, 
not intermediate results.

Alert Policy Best Practices
This section includes some tips for creating alert policies.

Avoiding Too Many Alerts
It is recommended that you define alert policies using criteria specific to the policy 
entity type. And for exchange and media validation alert policies, it is recommended 
you use criteria unique to exchanges and validations and not available for drives and 
media. Otherwise, you may create overlapping alert policies that result in multiple 
alerts and emails for the same event or resource attribute. 

For example, you could create and enable all three of the following policies:

■ Warning policy for Media: Drive Health Indicator is MONITOR or Media Health 
Indicator is MONITOR

■ Warning policy for Drives: Drive Health Indicator is MONITOR or Media Health 
Indicator is MONITOR

■ Policy for Exchanges: Drive Health Indicator is MONITOR or Media Health 
Indicator is MONITOR

The Media and Drive alert policies would each generate an alert every 24 hours for 
each drive and media with MONITOR health. In addition, the Exchanges alert policy 

Time Events Evaluation Result

13:13:17, Day 1 The policy is created 
and enabled.

Media Z health is 
EVALUATE.

The policy is evaluated 
for all media and 
matched for Media Z.

An alert is generated for Media Z and 
emails sent to the defined recipients. 

14:43:09, Day 1 An exchange occurs for 
Media Z, whose health 
is still EVALUATE.

The policy is evaluated 
for all media and 
matched for Media Z.

Since it has been less than 24 hours since 
the last alert for Media Z, no new alert is 
generated.

07:20:24, Day 2 Another exchange 
occurs for Media Z, 
whose health is still 
EVALUATE.

The policy is evaluated 
for all media and 
matched for Media Z.

No new alert is generated for Media Z 
since is has still been less than 24 hours 
since the last one.

15:05:19, Day 2 Another exchange 
occurs for Media Z, 
whose health is still 
EVALUATE.

The policy is evaluated 
for all media and 
matched for Media Z.

Since it has been more than 24 hours since 
the previous alert for Media Z, a new alert 
is generated and emails sent to the defined 
recipients.
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would generate an alert every time a drive or media with MONITOR health is 
involved in an exchange. You could potentially get scores of alerts from a single drive 
or media with MONITOR health.

A better approach would be to create and enable the following policies:

■ Warning policy for Media: Media Health Indicator is MONITOR

■ Warning policy for Drives: Drive Health Indicator is MONITOR

■ Policy for Exchanges: Alert: Drive Dump Available Is True

Using Logical Groups to Define Alert Policies
When defining alert policies for Drives or Media, you can use logical groups in the 
selection criteria. Because drives and media can belong to more than one logical group 
at a time, it is usually appropriate to use the "Contains" and "Doesn't Contain" 
operators when specifying the criteria, rather than the "Is" and "Isn't" operators. See 
"Filtering by Logical Group" on page 7-4 for details.

STA Sample Alert Policies
Some sample alert policies are delivered with STA. These policies are meant to give 
you concrete examples for policy creation, and they are all disabled by default. You 
can enable as many of them as you want and use them as is, or you can use them as 
starting points for creating policies more specific to your needs. 

All STA sample alert policies have names with an "STA" prefix. It is recommended that 
you preserve this naming convention for the sample policies and not use the "STA" 
prefix when naming your own alert policies. The Date Created/Updated for STA 
sample alert policies is the date when the STA application was last installed.

Alert Emails
Alerts can be sent to any number of email addresses. Through emailed alerts, users are 
notified of significant events in the tape library system without having to log in to the 
STA application. Alerts can even be sent to employees who do not have STA 
usernames.

The available email addresses must have been previously defined to STA on the 
Configuration – Email screen. See the STA Installation and Configuration Guide for 
instructions.

Example 5–1 and Example 5–2 are examples of the text of alert emails you might 
receive. 

Caution: Unlike the predefined templates delivered with STA, the 
sample alert policies are not write-protected, and you can modify 
them directly. However, if you modify or delete the sample policies, 
you cannot restore them to their original state. For any modifications, 
it is recommended that you copy the sample policy and modify the 
copy while leaving the original unchanged. See "Copy an Alert Policy" 
on page 5-17 for details. 

It is also recommended that you print a record of the sample policies 
as delivered, so you can re-create them manually if necessary. See 
"Manage the List of Alert Policies" on page 5-11 for details.
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Example 5–1 Sample Exchange Alert Email

Exchange Started at December 13, 2013 5:52:05 AM MDT and Ended at December 13, 
2013 7:15:41 AM MDT
STA Drive Alert - 2013-12-13 07:20:46   (Drive HU1233210W)
Alert Summary:
   Policy Desc:    Generates an alert when the Drive Health Indicator is Evaluate 
and Drive Health Trend is Worse.
   Criteria Met:   Drive Health Indicator=EVALUATE and Drive Health Trend=WORSE
   STA Server:     sysbiz
 
DRIVE
   Serial Number:        HU1233210W
   Tray Serial Number:   UNKNOWN
   Model:                HpUltrium6
   Last Annotation:      
 
   Health Indicator:                  Evaluate
   Health Trend:                      Worse
   Suspicion Level:                   90.0
   Exchange Status:                   GOOD
   Exchange Tape Alerts - Warning:    0
   Exchange Tape Alerts - Critical:   0
   Alerts (30 days):                  3

Example 5–2 Sample STA Application Alert Email 

STA STA Server Alert 2013-12-15 22:39:21 (STA Server bizsys)
Alert Summary:
   Policy Desc:    This policy will match when the STA software is restarted.
   Criteria Met:   staEngine: Server in an UNKNOWN State - Restarting.
   STA Server:     bizsys

Alerts Workflow
The alerts workflow is an optional manual process that is based on predefined states 
you can assign to selected alerts on the Alerts Overview screen. You can implement the 
alerts workflow in whatever manner best works for your site, but a suggested 
progression of alert states is as follows:

1. New – STA assigns this state to all alerts when they are created.

2. Acknowledged – The alert has been noted.

3. In Progress – The alert has been assigned to a responsible party and is being 
evaluated.

4. Dismissed – The responsible party has completed all activity on the alert. By 
default, all dismissed alerts are hidden on the Alerts Overview screen, but you can 
optionally display them. See "Show or Hide Dismissed Alerts" on page 5-27 for 
details.

See "Change the State of an Alert" on page 5-26 for details on using alert states to 
implement a manual workflow.

Alert Management Tasks
Alert Policy Definition Tasks 

■ "Manage the List of Alert Policies" on page 5-11
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■ "Create an Alert Policy" on page 5-12

■ "Copy an Alert Policy" on page 5-17

■ "Modify an Alert Policy" on page 5-18

■ "Modify Email Recipients for an Alert Policy" on page 5-20

■ "Enable or Disable an Alert Policy" on page 5-21

■ "Delete an Alert Policy" on page 5-22

Alert Monitoring Tasks

■ "Manage the List of Generated Alerts" on page 5-24

■ "Display Detail For an Alert" on page 5-24

■ "Show or Hide Dismissed Alerts" on page 5-27

■ "Change the State of an Alert" on page 5-26

Manage the List of Alert Policies

1. In the Navigation Bar, select Setup & Administration > Alerts Policies.

The Alerts Policies screen appears, showing all sample and user-defined policies at 
your site.

2. You can manage the list of alert policies by performing the following tasks:

Note: This procedure requires Operator or Administrator privileges.
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■ Filter the table records; see "Use the Filter Data Dialog Box to Change a Table 
Filter" on page 4-10.

■ Reset a filter applied to the table; see "Clear the Current Filter" on page 4-14.

■ Refresh the table to display new policies; see the STA Screen Basics Guide.

■ Display a printable form of the table in a separate browser tab or window; see 
the STA Screen Basics Guide.

Create an Alert Policy
Use this procedure to create an alert policy. The Alert Policies wizard leads you 
through the steps to define all information for the policy.

1. In the Navigation Bar, select Setup & Administration > Alerts Policies.

The Alerts Policies screen appears.

2. Click New Alert Policy.

The Alert Policies wizard appears.

3. Complete the first screen of the wizard as follows:

a. In the Policy Name field, type a unique name.

Your entry can include any alphanumeric characters up to 250 characters in 
length.

Note: This procedure requires Administrator privileges.
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b. In the Policy Description field, enter an optional description of the policy. 
This information is included in alert emails. You may want to use this field to 
specify recommended corrective actions for alerts generated by this policy.

c. Click Next.

4. Complete the second screen of the wizard as follows:

a. In the Entity Type menu, select the type of library system component for 
which this policy may generate alerts. See "Alert Policy Entities" on page 5-3 
for information about the types.

b. In the Select Severity field, select the severity level of the alert policy. See 
"Alert Policy Severities" on page 5-4 for information about severity levels.

c. Click Next.

Note: All sample alert policies delivered with STA have names 
beginning with "STA," so it is recommended that the names you 
assign to your alert policies not start with this prefix.

Note: On any screen of the wizard, you can select the breadcrumb 
links at the top of the dialog box to go directly to the next immediate 
screen or any screen you have already visited. 
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5. On the third screen of the wizard, specify the alert policy criteria as follows:

a. In the Filter Matching field, indicate whether you want to match any or all of 
the criteria you specify. 

b. Click the Add New Filter Criteria Row button to add a new, blank selection 
criteria row to the dialog box.

c. Specify the selection criteria using the menus and text fields on the row. See 
Table 4–1, " Filter Operators by Attribute Type" for details on completing each 
row. 

d. You can add as many rows of selection criteria as you want.

Note: When selecting an attribute for filtering, if you know the name 
of the attribute you want to select, you can type the first few letters to 
quickly move the cursor to that item in the menu.
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e. To remove criteria, click the Remove This Filter Criteria Row button on the 
row you want to delete.

6. Verify that your criteria are correct and click Next.

7. Complete the fourth screen of the wizard as follows:

a. In the Email Recipients menu, select the email addresses to which you want 
emails to be sent whenever an alert is generated by this policy. 

b. Click Next.

Note: When basing selection criteria on logical groups, it is usually 
appropriate to use the "Contains" and "Doesn't Contain" operators, 
rather than the "Is" and "Isn't" operators. This is because drives and 
media can belong to more than one logical group at a time. See 
"Filtering by Logical Group" on page 7-4 for details.
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8. Complete the last screen of the wizard as follows:

a. Verify that all the policy information is correct. 

b. Use the Enable Alert Policy check box as follows:

– Select the check box to create the policy and enable it immediately.

– Deselect the check box to create the policy but leave it disabled for now. 
You can enable it at a later time. See "Enable or Disable an Alert Policy" on 
page 5-21 for details.

c. Click Save.
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The policy is created. If the policy is enabled, then the appropriate library system 
resources are immediately evaluated against the policy and alerts are generated as 
appropriate. If the policy is disabled, then the policy is not evaluated for now. 

Copy an Alert Policy
Use this procedure to copy a selected alert policy. You can copy any user-defined 
policy or STA sample policy, depending on your needs. Following are some uses for 
this procedure. 

■ Use an existing policy as the basis for a new policy. Copy an existing policy that is 
similar to one you want to create, and then modify the copy. See "Modify an Alert 
Policy" on page 5-18 for details. 

■ Copy the STA sample policies to preserve the original versions. The STA sample 
policies are not write-protected and there is no way to restore the original versions 
if they are modified, so it is recommended that you keep copies of the original 
versions even if you do not use them. 

1. In the Navigation Bar, select Setup & Administration > Alerts Policies.

The Alerts Policies screen appears.

2. Select the alert policy you want to copy and click Copy Alert Policy.

The first screen of the Alert Policies wizard appears. The copy of the policy has all 
the same information as the original, except for the following:

■ The word "Copy" is added to the end of the Policy Name. 

Note: This procedure requires Administrator privileges.
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■ No email recipients are defined.

■ The policy is disabled (the Enable Alert Policy check box is deselected). 

3. In the Policy Name field, type the name you want to assign.

4. Use the Next button or the wizard breadcrumbs at the top of the dialog box to 
navigate to the screens with the information you want to modify. See "Create an 
Alert Policy" on page 5-12 for details on completing these screens. You can also 
leave all information unchanged if you are simply copying the original policy to 
preserve it.

5. Click Save when done. 

The new policy is created, and the Alerts Policies screen is updated with the 
information. 

In the following example, the Drive-Diag-SL3000 policy was copied from the 
Drive-Diag-SL8500 policy, and the alert criteria were modified to evaluate drives 
in SL3000 libraries.

Modify an Alert Policy
Use this procedure to make any of the following modifications to a selected alert 
policy.

■ Change the policy name. 

■ Change the policy description.
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■ Change the tape library system resource or event to be evaluated by this policy.

■ Change the policy severity.

■ Add, delete, or modify the policy selection criteria.

■ Add or delete email recipients; for a more direct method, see "Modify Email 
Recipients for an Alert Policy" on page 5-20.

■ Enable or disable the policy; for a more direct method, see "Enable or Disable an 
Alert Policy" on page 5-21.

1. In the Navigation Bar, select Setup & Administration > Alerts Policies.

The Alerts Policies screen appears.

2. Select the alert policy you want to modify and click Edit Alert Policy.

The first screen of the Alerts Policy wizard appears, and the policy's current 
information is displayed.

Note: This procedure requires Administrator privileges.
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3. Use the Next button or the wizard breadcrumbs at the top of the dialog box to 
navigate to the screens with the information you want to modify. See "Create an 
Alert Policy" on page 5-12 for details on completing these screens.

4. Click Save when done. 

The policy is updated, and the changes are displayed on the Alerts Policies screen.

Modify Email Recipients for an Alert Policy
Use this procedure to add or delete email recipients for a selected alert policy. The 
recipients are notified of all alerts generated by the policy. You can choose any number 
of addresses that have been predefined to STA in the Configuration – Email screen. See 
"Alert Emails" on page 5-9 for details. 

1. In the Navigation Bar, select Setup & Administration > Alerts Policies.

Note: This procedure requires Administrator privileges.
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The Alerts Policies screen appears.

2. Select the policy you want to modify and click Email Recipients. 

The Email Recipients dialog box appears. 

3. In the Email Recipients menu, select the check boxes next to the addresses you 
want to receive alerts generated from this policy. Deselect the check boxes next to 
the addresses not to receive alerts.

4. Click OK. 

The policy is updated according to your modifications.

Enable or Disable an Alert Policy
Use this procedure to enable or disable a selected alert policy. Only enabled policies 
can generate alerts.
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To ensure email recipients are notified of all alerts generated by a particular policy, you 
should add the recipients to the policy before enabling it. See "Modify Email 
Recipients for an Alert Policy" on page 5-20 for instructions.

1. In the Navigation Bar, select Setup & Administration > Alerts Policies.

The Alerts Policies screen appears.

2. Select the policy you want to modify.

If the policy is currently enabled, the Disable Alert Policy icon in the Alerts 
Policies toolbar becomes active. If the policy is currently disabled, the Enable 
Alert Policy icon becomes active.

3. Click Enable/Disable Alert Policy. 

The policy is updated according to your selection.

■ If you have enabled the policy, the corresponding tape library resources or 
events are immediately evaluated against the policy criteria, and alerts are 
generated as appropriate.

■ If you have disabled the policy, alerts are no longer generated for the policy.

Delete an Alert Policy
Use this procedure to delete an alert policy. Deleting a policy does not delete alerts 
already generated from this policy; they are still available for viewing on the Alerts 
Overview screen. You do not have to disable an alert policy before deleting it. 

Note: This procedure requires Administrator privileges.
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1. In the Navigation Bar, select Setup & Administration > Alerts Policies.

The Alerts Policies screen appears.

2. Select the alert policy you want to delete and click Delete Alert Policy.

The Delete dialog box appears. 

3. Verify your selection and Click Yes to confirm the deletion.

The policy is deleted and the list on the Alerts Policies screen is updated. 

Note: This procedure requires Administrator privileges.

Caution: Be careful not to delete any of the STA sample alert policies 
because they cannot be restored except by manually re-creating them. 
All STA sample alert policies have names with an "STA" prefix.
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Manage the List of Generated Alerts

1. In the Navigation Bar, select Tape System Activity > Alerts Overview.

The Alerts Overview screen appears, showing all active (not dismissed) alerts that 
have been generated to-date.

2. You can manage the list of alerts by performing the following procedures:

■ Display a printable form of the table in a separate browser tab or window; see 
the STA Screen Basics Guide.

■ Annotate an alert, see the STA Screen Basics Guide.

■ Export the list of alerts; see the STA Screen Basics Guide. 

■ Filter the list of alerts; see "Use the Filter Data Dialog Box to Change a Table 
Filter" on page 4-10.

■ Reset a filter applied to the table; see "Clear the Current Filter" on page 4-14.

■ Refresh the table to display new alerts; see the STA Screen Basics Guide.

■ Detach the table from the screen and display it in a separate window in the 
browser foreground; see the STA Screen Basics Guide.

■ Go directly to a specific page on the screen; see the STA Screen Basics Guide 

Display Detail For an Alert
Use this procedure to display an alert and trace it to the tape library system event or 
condition that triggered it.

Note: With the exception of annotating an alert, this procedure can 
be done by any STA user. Annotating requires Operator privileges.
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1. In the Navigation Bar, select Tape System Activity > Alerts Overview.

The Alerts Overview screen appears.

2. Select the alerts you want to view and click Detail View. 

In the Detail View, each record you have selected includes several links to other 
screens containing related information.

3. Select the link in the Alert Event Type field (in this example, Exchange) to display 
detail for the event that triggered the alert. 

You can use the information that is displayed to trace the cause of the alert and 
determine whether you need to take any action.

Note: This procedure can be performed by any STA user with 
Viewer privileges or above.
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Change the State of an Alert
Use this procedure to change the state of selected alerts according to the alerts 
workflow process implemented at your site. See "Alerts Workflow" on page 5-10 for 
details on this process.

1. In the Navigation Bar, select Tape System Activity > Alerts Overview.

The Alerts Overview screen appears.

2. Select the alerts you want to modify and click Change Alert State. You can select 
multiple alerts.

Note: This procedure can be performed by any STA user with 
Viewer privileges or above.
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The Change Alert State dialog box appears.

3. In the menu, select the state you want to assign to the selected alerts. You can 
assign any available state, and then click OK. 

The alerts are updated, and their new state is displayed in the Alerts Overview 
screen. 

Show or Hide Dismissed Alerts
Use this procedure to toggle the display of dismissed alerts on the Alerts Overview 
screen. See "Change the State of an Alert" on page 5-26 for details on how alerts are 
dismissed.

1. In the Navigation Bar, select Tape System Activity > Alerts Overview.

Note: If you changed the selected alerts to "Dismissed," and the 
Alerts Overview screen is set to hide dismissed alerts, the alerts are 
removed from the display. See "Show or Hide Dismissed Alerts" on 
page 5-27 for details on displaying dismissed alerts.

Note: This procedure can be performed by any STA user with 
Viewer privileges or above.
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The Alerts Overview screen appears, and by default, all dismissed alerts are 
hidden from view.

2. Click the Show Dismissed Alerts button in the table toolbar.

Dismissed alerts are now visible on the screen, and the button label has changed to 
Hide Dismissed Alerts.

3. To hide the dismissed alerts again, click the Hide Dismissed Alerts button.
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6Executive Reports

STA Executive Reports provide high-level views of your tape library system. Executive 
Reports are based on defined Dashboard templates, and all the information in the 
template is included in each report. Dashboard portlet annotations are also included in 
the reports if they have been added to individual Dashboard portlets and saved as part 
of the Dashboard templates.

All users have privileges to view Executive Reports, but defining report policies 
requires Administrator privileges, and running reports requires Operator privileges. 
See "User Roles for Executive Report Policies" on page 6-6 for more information.

This section describes how to define, run, and use Executive Reports. The following 
topics are discussed: 

■ "Executive Report Creation Process" on page 6-1

■ "Using Executive Reports" on page 6-2

■ "Executive Report Policies" on page 6-4

■ "Executive Report File Tasks" on page 6-6

■ "Executive Report Policy Tasks" on page 6-10

Executive Report Creation Process
 The process for running an Executive Report is as follows. Report files are not 
available until all of these steps have been completed. 

1. An Operator or Administrator user defines and saves a custom Dashboard 
template. (This step is optional, as Executive Reports can also be based on the 
predefined templates delivered with STA.) See "Create a Template" on page 3-12 
for details.

2. An Administrator user creates an Executive Report policy based on the Dashboard 
template. See "Create or Modify an Executive Report Policy" on page 6-10 for 
details.

3. An Operator or Administrator user runs the report on demand, or the report runs 
automatically according to the schedule defined in the policy. See "Run an 
Executive Report On Demand" on page 6-6 for details.

4. If the report policy includes a list of email recipients, the report file is emailed to 
those users. See "Emailing Executive Reports" on page 6-5 for details.

5. Users view the report file. See "View an Executive Report" on page 6-7 for details.
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Using Executive Reports
Executive Reports are produced in PDF format and saved to the STA database. Reports 
can also be emailed automatically to designated recipients.

Displaying Executive Reports
Once an Executive Report has been run, you can view it from the Executive Reports 
screen on the Home tab. Figure 6–1 is an example. The screen lists all report files 
available to your STA username. If the list is empty or does not include report files you 
should be able to view, see an STA Administrator user for assistance.

A report policy can be run multiple times, so you may see several instances of the 
same report, each with a different date and time stamp. Report files are saved in the 
STA database and are therefore backed up with the regular database backups. You 
may want to periodically remove old report files you no longer need. See "Delete an 
Executive Report File" on page 6-8 for details. 

Figure 6–1 Sample Executive Reports Screen

Reports are created in PDF format, and you can either view them directly in your 
browser window or save them to your local computer for later viewing. See "View an 
Executive Report" on page 6-7 for instructions. Figure 6–2 is a sample page from an 
Executive Report.

You may also receive Executive Report output by email. This must be set up by a user 
with Administrator privileges. See "Emailing Executive Reports" on page 6-5 for 
details.
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Figure 6–2 Sample Executive Report

Running Executive Reports
Executive Reports can be run on a regular schedule and on demand. Report schedules 
can be defined only by users with Administrator privileges. Reports can be run on 
demand by users with Operator privileges and above. 

Report Schedule
Executive Reports can be run on a regular schedule at the following frequencies.

■ Daily (every 24 hours)

■ Weekly (every 7 days)

■ Monthly (every 30 days)

■ Quarterly (every 90 days)



Executive Report Policies

6-4 StorageTek Tape Analytics User's Guide

■ Yearly (every 365 days)

The user does not need to be logged in for a report to run. Reports always run 
automatically in the background shortly after 00:30 UTC time. The time displayed in 
the report header is in UTC time.

The report schedule is based on the Start Date of the report and is days-based, not 
calendar-based. Therefore, a monthly report runs on the specified Start Date and every 
30 days thereafter, not necessarily on the same date every month. Following are some 
examples to clarify. The Start Date for all is 10/15/2013.

On-demand Reports
When run on demand, Executive Reports are run at the next available opportunity. 
Depending on system activity, there may be a delay of up to two minutes before the 
start of execution. On-demand report runs do not affect the regular report schedule—a 
report will run at its regularly scheduled times regardless of how many times it is run 
on demand.

User Roles for Executive Report Files
Some Executive Report file tasks can be performed by all user roles, whereas others are 
available only to Administrator or Operator roles. 

Table 6–1 summarizes the Executive Report file activities available to each STA user 
role.

Executive Report Policies
This section provides information about Executive Report policies.

Frequency Report Schedule

Daily 10/15/2013, 10/16/2013, 10/17/2013, and so on

Weekly 10/15/2013, 10/22/2013, 10/29/2013, and so on

Monthly 10/15/2013, 11/14/2013, 12/14/2013, 01/13/2014, and so on

Quarterly 10/15/2013, 01/13/2014, 04/13/2014, 07/12/2014, and so on

Yearly 10/15/2014, 10/15/2015, 10/15/2016, 10/14/2017, and so on

Note: Regardless of user role, you can view reports run 
automatically or by any STA username. 

Table 6–1 Executive Report File User Roles

User Role Report Activity Screen

Operator and above Run a public report on demand. Setup & Administration > 
Executive Reports Policies

Operator and above Delete a public report file run automatically or on demand. Home > Executive Reports

Viewer and above Display a list of public report files run automatically or on 
demand, as follows:

■ Export and view a report file.

■ Filter the report file list.

■ Print the report file list.

Home > Executive Reports
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Defining Executive Report Policies
The Executive Reports Policies screen on the Setup & Administration tab displays all 
Executive Report policies. Figure 6–3 is an example.

Figure 6–3 Sample Executive Reports Policies Screen

Each Executive Report policy is based on a saved Dashboard template and includes 
the following elements:

■ Report name – An alphanumeric identifier for the report. Report names are not 
required to be unique. 

■ Source Dashboard template – Reports can be based on any Dashboard template 
available to your STA username, except the one named "STA-Default." To create a 
report based on the template named "STA-Default," you must first save the 
template to a different name, and then base the report on the new name.

■ Start Date – The first day that the report is scheduled to be run. See "Running 
Executive Reports" on page 6-3 for details. It will run automatically shortly after 
00:30 UTC on this day. 

■ Frequency – The frequency at which the report is scheduled to be run. See 
"Running Executive Reports" on page 6-3 for details.

■ Ownership – Reports can be Public or Private. Private report policies can be 
managed and viewed from the STA user interface only by the STA Administrator 
username that has defined them. Instances of public report policies can be viewed 
and managed by any user.

■ Email recipients – Reports can be sent to any number of email addresses. Email 
addresses must be defined in the Configuration – Email screen. A PDF of the 
report is emailed to the recipient after each report run has completed. 

Emailing Executive Reports
Emailing reports is one way you can provide reports to people who are not regular 
users of STA and who do not have an STA username. Each Executive Report can be 
sent to any number of email addresses, which have been previously defined to STA 

Note: When an STA username is deleted, all private report policies 
owned by that username are automatically deleted or made public, 
according to the selection made by the Administrator user performing 
the deletion. See the STA Installation and Configuration Guide for details.
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through the Configuration – Email screen. See the STA Installation and Configuration 
Guide for instructions.

The email recipient list for each report can be defined only by a user with 
Administrator privileges. A PDF of the report is emailed to the recipients as soon as it 
is run. See Figure 6–2 for a sample page from an Executive Report.

User Roles for Executive Report Policies
Table 6–2 summarizes the Executive Report policy activities available to the Operator 
and Administrator roles.

Executive Report File Tasks
These tasks involve viewing and managing Executive Report output files, and they 
can be performed by all user roles. These tasks are performed from the Executive 
Reports screen on the Home tab.

■ "View an Executive Report" on page 6-7

■ "Delete an Executive Report File" on page 6-8

■ "Manage the List of Executive Report Files" on page 6-9

Run an Executive Report On Demand
Use this procedure to run a selected Executive Report right away. The report is run at 
the first available opportunity, which could take up to two minutes. This does not 
affect the report's schedule—it will also be run at its regularly scheduled time.

Table 6–2 Executive Report Policy User Roles

User Role Report Activity Screen

Administrator only Create a public or private report policy.

Display a list of report policies, including public policies and 
private policies created by the current STA username.

Modify a report policy, including public policies or private 
policies created by the current STA username, as follows:

■ Define a regular schedule for the report.

■ Assign public or private ownership to the policy.

■ Designate email addresses to receive report files.

■ Change the Dashboard template on which the report is 
based.

■ Delete the policy.

Setup & Administration > 
Executive Reports Policies

Operator and above Display a list of public report policies only, as follows:

■ Filter the report policy list.

■ Print the report policy list.

Setup & Administration > 
Executive Reports Policies

Note: You only have access to public reports and private ones owned 
by your STA username. You cannot perform these tasks on reports 
privately owned by another STA username. See "Defining Executive 
Report Policies" on page 6-5 for additional information.
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1. In the Navigation Bar, select Setup & Administration > Executive Reports 
Policies.

The Executive Reports Policies screen appears.

2. Select the report policy you want to run and click Run.

A confirmation dialog box appears.

3. Verify the information and click OK to run the report.

The report is run. See "View an Executive Report" on page 6-7 for instructions on 
displaying the output.

View an Executive Report
Use this procedure to view an Executive Report after it has been run. Reports are 
created in Adobe PDF format. 

1. In the Navigation Bar, select Home > Executive Reports.

Note: This procedure requires Operator or Administrator privileges.
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The Executive Reports screen appears, showing all report files available to your 
STA username.

2. Select the report file you want to view and click Export.

The file is downloaded to your computer according to your browser settings. See 
your browser documentation for details. Following is a sample dialog box you 
might see on a computer running Mozilla Firefox on Windows. 

In this example, you would proceed as follows:

■ Click Save File and OK to save the report to your local computer. The report is 
saved in PDF format and can be viewed with Adobe Reader at a later time.

■ Click Open with and OK to view the report from your browser. This option 
requires the Adobe Acrobat add-on to be installed and enabled in your 
browser, and the exact functioning depends on your browser configuration. If 
you are not able to use this option, see your browser documentation for 
instructions.

Delete an Executive Report File
Use this procedure to delete a selected report file. This does not affect other report 
files, nor the report policy definition. You can select only one report file at a time to 
delete.
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1. In the Navigation Bar, select Home > Executive Reports.

The Executive Reports screen appears, showing all report files available to your 
STA username.

2. Select the report file you want to delete and click Delete.

A Delete confirmation dialog box appears. 

3. Verify your selection and Click Yes to confirm the deletion. 

The report file is deleted and is no longer available for viewing from the Executive 
Reports screen. 

Manage the List of Executive Report Files
The list of Executive Report files is a List View table, similar to those found on 
Overview screens, and you can perform the same functions as for any List View table. 
See the following procedures for instructions:

■ To filter the table records, see "Use the Filter Data Dialog Box to Change a Table 
Filter" on page 4-10.

■ To reset a filter applied to the table, see "Clear the Current Filter" on page 4-14.

■ To refresh the table to display any new report files, see the STA Screen Basics Guide.
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■ To display a printable form of the table in a separate browser tab or window, see 
the STA Screen Basics Guide.

■ To detach the table from the screen and display it in a separate window in the 
browser foreground, see the STA Screen Basics Guide.

Executive Report Policy Tasks
These tasks involve creating and managing the Executive Report policies, and they 
require Operator or Administrator privileges. These tasks are performed from the 
Executive Reports Policies screen on the Setup & Administration tab. 

■ "Create or Modify an Executive Report Policy" on page 6-10.

■ "Delete an Executive Report Policy" on page 6-13

■ "Run an Executive Report On Demand" on page 6-6

■ "Manage the List of Executive Report Policies" on page 6-14

Create or Modify an Executive Report Policy
Use this procedure to create an Executive Report policy or make any of the following 
modifications to an existing public policy or a private policy owned by your STA 
username. 

■ Change the name of the policy.

■ Designate a different Dashboard template on which the policy is based.

■ Change the regular schedule for when reports are generated from the policy.

■ Change public or private ownership of the policy and the reports generated from 
it.

■ Change the email recipients for reports generated by the policy.

Optionally, you can run the report on demand after making the changes.

1. In the Navigation Bar, select Setup & Administration > Executive Reports 
Policies.

Note: You only have access to public reports and those owned by 
your STA username. You cannot perform these tasks on reports 
privately owned by another STA username. See "Defining Executive 
Report Policies" on page 6-5 for additional information.

Note: You can make this modification only if the policy is based on a 
private template owned by your STA username or a public template.

Note: This procedure requires Administrator privileges. 
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The Executive Reports Policies screen appears.

2. Proceed as follows:

■ To create a report, click Add in the Executive Reports Policies table toolbar.

■ To modify an existing report policy, select the policy in the table and click Edit. 
You cannot modify a private Executive Report policy owned by another STA 
username.

The Add/Edit Executive Reports Policy dialog box appears.

3. Complete the Add/Edit Executive Reports Policy dialog box as follows:

a. In the Report Name field, type a unique name.

Your entry can include any alphanumeric characters up to 250 characters in 
length.

b. In the Source Dashboard Template menu, select the template you want to use 
as the basis of the Executive Report. The menu lists all Dashboard templates 
available to your STA username.

Note: This field is display-only if you are modifying a policy and the 
source template is owned privately by another STA username.
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c. In the Locale menu, select English; this is the only option available at this time.

d. In the Start Date field, specify the date when you want scheduled runs of the 
report to begin. Reports are run shortly after 00:30 UTC, starting on this date.

e. In the Run Frequency menu, select the frequency at which you want the 
report to run.

f. In the Shared field, select one of the following options:

– Public to make the report available to all users.

– Private to make the report available to the current STA username only. 
This does not affect the email recipients list—you can have copies of the 
report emailed to other users even if the report is private. 

g. In the Email Recipients menu, select the email addresses to which you want 
copies of the report emailed after each report run. The report is sent as a PDF 
attachment. The menu lists all email addresses that have been defined to STA.

4. Verify the information is correct, and then click one of the following buttons:

■ Save to save the report policy and have it run for the first time on the 
designated Start Date.

■ Save and Run to save the report policy and run it immediately. This does not 
affect the schedule you have defined; it will also run at its regularly scheduled 
time, starting on the designated Start Date.

The Executive Reports Policies screen is updated with the new policy information.
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If you selected Save and Run, the report is run in the background at the first 
available opportunity. It may take up to two minutes for the report to start 
running. 

As soon as the report run finishes, the output is available from the Executive 
Reports screen on the Home tab. See "View an Executive Report" on page 6-7 for 
instructions on displaying the output.

Delete an Executive Report Policy
Use this procedure to delete an Executive Report policy. You can only delete Public 
policies or Private policies that have been created by your STA username. 

Deleting a report policy does not delete previously run report files; they are still 
available for viewing on the Executive Reports screen. 

1. In the Navigation Bar, select Setup & Administration > Executive Reports 
Policies.

The Executive Reports Policies screen appears.

2. Select the report policy you want to delete and click Delete.

The Delete dialog box appears.

3. Verify your selection and Click Yes to confirm the deletion.

Note: This procedure requires Administrator privileges. 
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The report policy is deleted.

Manage the List of Executive Report Policies
The list of Executive Report policies is a List View table, similar to those found on 
Overview screens, and you can perform the same tasks as for any List View table. See 
the following procedures for instructions:

■ To filter the table records, see "Use the Filter Data Dialog Box to Change a Table 
Filter" on page 4-10.

■ To reset a filter applied to the table, see "Clear the Current Filter" on page 4-14.

■ To refresh the table to display any new report policies, see the STA Screen Basics 
Guide.

■ To display a printable form of the table in a separate browser tab or window, see 
the STA Screen Basics Guide.

■ To detach the table from the screen and display it in a separate window in the 
browser foreground, see the STA Screen Basics Guide.
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7Logical Groups

STA's logical group feature allows you to create any number of user-defined groups of 
drives and media. Logical groups are useful for filtering and reporting STA data. If 
your site has enabled the optional STA media validation feature, you can use logical 
groups when defining automated media validation policies. See "Validating Media by 
Logical Group" on page 8-21 for details. 

Logical groups can contain any combination of drives, media, or both. Individual 
drives and media can belong to more than one logical group at a time.

Anyone with Operator or Administrator privileges can perform the activities 
described in this chapter. The following topics are discussed:

■ "Using Logical Groups" on page 7-1

■ "Logical Group Creation Process" on page 7-2

■ "Types of Logical Groups" on page 7-3

■ "Filtering by Logical Group" on page 7-4

■ "Logical Group Creation and Management Tasks" on page 7-11

Using Logical Groups
Following are some ways logical groups can help you to organize and report your STA 
data:

■ Use logical groups to filter data on the following screens. See "Filtering by Logical 
Group" on page 7-4 for details.

■ Drives Overview and Drives Analysis

■ Media Overview and Media Analysis

■ Selected Dashboard portlets

■ Save screen layouts that have been filtered by logical group as templates. The 
filters are saved as part of the templates. See "Screen Characteristics Included in 
the Template Definition" on page 3-3 for details.

■ Create Executive Reports based on Dashboard templates that are filtered by logical 
group. See "Executive Reports" on page 6-1for details. 
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Logical Group Examples

Example 1  Logical Groups for Library Partitions
A library has eight partitions, and users would like to produce STA reports for drives 
and media in each partition. To do so, you could create one logical group for each 
library partition. 

Example 2  Logical Groups for Libraries in Different Geographic Locations
Two library operators manage libraries at one site and three other operators manage 
another site. The operators would like to see STA data that apply to drives and media 
at their site only. To do so, you could create one logical group for each site.

Example 3  Logical Groups for Archival Media
An archival site creates two copies of each archived media. To help manage the two 
sets of media, you could create one logical group for all copy #1 media and another 
logical group for copy #2 media. 

Example 4  Logical Group for Calibration Media
If you choose to enable drive calibration and qualification, which is part of the STA 
media validation feature, you must define a logical group of media to be used for this 
purpose. All drive calibration and qualification activities will be done exclusively with 
these media, and the media should not be used for production data. See "Calibration 
Media Logical Group" on page 8-16 for details.

Logical Group Creation Process
The process for creating a logical group is as follows. 

1. Create the logical group from the Logical Groups screen. You assign a name and 
designate whether it is a manual or dynamic group. See "Types of Logical Groups" 
on page 7-3 and for details.

2. Add drives and media to the group using either of the following methods:

■ If the group is manual, then you select individual drives and media to add to 
the group. This is done from the Drives Overview and Media Overview 
screens. See "Add Drives and Media to a Manual Logical Group" on page 7-13 
for details.

■ If the group is dynamic, then you define the selection criteria by which drives 
and media are assigned to the group. This is also done from the Logical 
Groups screen. STA then automatically builds the group. See "Create and 
Define a Dynamic Logical Group" on page 7-17 for details. 

Logical Group Ownership
A logical group is owned by the STA username that created it, and the ownership 
cannot be changed except when the owner is deleted. The logical group owner is 
displayed on the Logical Groups screen. 

Note: When an STA username is deleted, all logical groups owned 
by that username are automatically deleted or made public, according 
to the selection made by the Administrator user performing the 
deletion. See the STA Installation and Configuration Guide for details. 
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Types of Logical Groups
When you create a logical group, you designate whether it is manual or dynamic. 
Once you have created a group, you cannot change its type.

Manual Logical Groups
Manual logical groups are relatively static—membership does not change except 
through direct user intervention. You build manual logical groups by manually 
assigning selected drives and media to the group. You can add or delete drives and 
media from a group at any time. See "Create a Manual Logical Group" on page 7-11 for 
details.

Dynamic Logical Groups
Dynamic logical groups evolve over time as drive and media attributes change. 
Membership in a dynamic logical group is based on selection criteria that you define. 
Logical group selection criteria work in much same way as the STA filtering feature, 
and they can range from simple to very complex. See "Create and Define a Dynamic 
Logical Group" on page 7-17 for details.

Depending on the size of your tape library system, it may take some time to build a 
dynamic group for the first time. The group is built in the background, so you can 
proceed with other STA activities while the group is being built. 

Updates to Dynamic Group Membership 
Dynamic group membership is automatically updated as drives and media are added 
and removed from your library environment, and as the attributes of individual drives 
and media change. When drives and media meet the selection criteria for a group, they 
are automatically added to the group, and when they no longer meet the criteria, they 
are automatically removed. 

Group membership updates occur once per hour, but you can manually initiate a 
group update at any time. See "Force a Dynamic Logical Group Update" on page 7-21 
for details.

You cannot manually add or delete individual drives and media from a dynamic 
group. To change the membership of a dynamic group, you can revise the selection 
criteria. See "Change the Selection Criteria for a Dynamic Logical Group" on page 7-20.

Dynamic Group Selection Criteria
A variety of drive and media attributes are available for creating selection criteria. 
Some attributes apply only to drives, some only to media, and some to both. Following 
are some examples:

■ Matching on Library Name selects both drives and media.

■ Matching on Drive Type selects only drives.

■ Matching on Cleaning Media selects only media.

Table 7–1 identifies the available criteria and whether they apply to drives only, media 
only, or both.

Table 7–1 Dynamic Logical Group Selection Criteria

Attribute Drives Only Media Only Both

Cleaning Media X
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Filtering by Logical Group
While only users with Operator or Administrator privileges can create and manage 
logical groups, all users, including those with Viewer privileges, can use existing 
logical groups to filter STA data. Filtering screens by logical group allows you to focus 
on just the drives and media in that group.

The data on the following screens can be filtered by logical group:

■ Drives Overview and Drive Analysis

■ Media Overview and Media Analysis

■ Selected Dashboard portlets – See "Dashboard Portlets With Filtering by Logical 
Group" on page 7-10 for a list of the portlets. 

In addition, you can use logical groups in the selection criteria for the following types 
of policies: 

■ Alert policies – See "Using Logical Groups to Define Alert Policies" on page 5-9 for 
details.

Drive Firmware Version X

Drive Health Indicator X

Drive Serial Number X

Drive Type X

Drive Suspicion Level X

HLI Address X

Library Complex Name X

Library Model X

Library Name X

Library Number X

Library Serial Number X

Media Health Indicator X

Media Suspicion Level X

Media Type X

Partition Name X

Partition Number X

Partition Type X

Physical Address X

Rail Number X

SCSI Element ID X

STA Start Tracking (Number of Fays) X

STA Start Tracking (Date) X

Volume Serial Number X

Table 7–1 (Cont.) Dynamic Logical Group Selection Criteria

Attribute Drives Only Media Only Both
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■ Media validation policies – See "Calibration Media Logical Group" on page 8-16 
and "Validating Media by Logical Group" on page 8-21 for details.

Constructing Filters Using Logical Groups
Drives and media can belong to more than one logical group at a time. Therefore, 
when you construct selection criteria for filtering by logical group, it is usually 
appropriate to use the "Contains" and "Doesn't Contain" operators on the Filter Data 
dialog box, rather than the "Is" and "Isn't" operators. The "Is" and "Isn't" operators 
require an exact match and therefore may result in filters that select no records at all, 
or all records, rather than records belonging to the logical groups you specify. 

The examples below illustrate use of these operators. These examples use the 
"LTO6-Drives-Media" logical group, which includes three drives and 26 media.

Example 1  Using the "Is" Operator
On the Media – Overview screen, using the "Is" operator to filter for the 
LTO6-Drives-Media logical group selects no records. This is because all media in the 
LTO6-Drives-Media group also belong to at least one other group.

The "Is" operator selects only drives and media that belong exclusively to the specified 
logical groups. If the drives and media belong to any other groups as well, they are not 
selected by the filter. 
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Example 2  Using the "Contains" Operator
Changing the filter operator to "Contains" selects all 26 media records in the logical 
group. The "Contains" operator selects drives and media that belong to the specified 
logical groups, as well as any number of other groups.

How Changes to Logical Group Definitions Can Affect Filters
If a filter includes a logical group as part of its selection criteria, modifications to the 
definition of the logical group affect the behavior of the filter. The following example 
provides a step-by-step illustration of changes you might see.

Step 1  Define the Logical Group
On the Logical Groups screen, dynamic logical group "LG-Media-T10K-Clean," is 
created for all T10000 cleaning media. The group has the following definition.

There are 51 media included in the logical group.



Filtering by Logical Group

Logical Groups 7-7

Step 2  Use the Logical Group in a Filter
The Media – Overview screen is filtered by this logical group. The 51 records included 
in the group are displayed.

Step 3  Effects of Modifying the Logical Group Selection Criteria
On the Logical Groups screen, the logical group definition is modified to include 
T10000T2 cleaning media only. 
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There are now just 11 media in the logical group.

The Media – Overview screen is automatically updated to reflect the new logical group 
definition included in the applied filter. 



Filtering by Logical Group

Logical Groups 7-9

Step 4  Effects of Changing the Name of the Logical Group
On the Logical Groups screen, the name of the logical group is changed to 
"LG-Media-T10KT2-Clean." The logical group selection criteria remain the same, and 
the group still includes the same 11 media.

Because the old logical group name is still used in the filter applied to the Media – 
Overview screen, the screen now displays no records. The filter specifies a logical 
group name that no longer exists.

Step 5  Update the Filter
The filter must be updated, either to include the new logical group name in the 
selection criteria or to make the selection criteria more broad. In the example below, 
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the selection criteria are made more broad by specifying just a portion of the logical 
group name to match. If the filter were included in a template, the template would also 
need to be updated and re-saved.

Dashboard Portlets With Filtering by Logical Group
You can filter the following Dashboard portlets by logical group. See "Dashboard 
Portlets" on page A-1for descriptions.

Graph Portlets

■ Drive Health

■ Drive Utilization

■ I/O Throughput

■ Library Drive Bays

■ Library Media Slots

■ Maximum Mount Times

■ Media Health

■ Mounts

Table Portlets

■ Drives Requiring the Most Cleanings Per Meter

■ Drives Watch List

■ Media Watch List

■ Monitored Device Trends

Report Portlets

■ Data Read Report

■ Data Written Report

■ Drives Health Report
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■ Media Health Report

■ Monitored Device Counts

Logical Group Creation and Management Tasks
All tasks in this section require Operator or Administrator privileges. 

Manual Logical Groups Only

■ "Create a Manual Logical Group" on page 7-11

■ "Add Drives and Media to a Manual Logical Group" on page 7-13

■ "Remove Drives and Media From a Manual Logical Group" on page 7-15

Dynamic Logical Groups Only

■ "Create and Define a Dynamic Logical Group" on page 7-17

■ "Change the Selection Criteria for a Dynamic Logical Group" on page 7-20

■ "Force a Dynamic Logical Group Update" on page 7-21

All Logical Groups

■ "View Logical Group Assignments for Selected Drives or Media" on page 7-22

■ "List All Drives and Media Assigned to a Logical Group" on page 7-23

■ "Rename a Logical Group" on page 7-24

■ "Delete a Logical Group" on page 7-26

Create a Manual Logical Group
Use this procedure to create a manual logical group.

1. In the Navigation Bar, select Setup & Administration > Logical Groups.

The Logical Groups screen appears.
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2. Click Add Logical Group in the Defined Logical Groups toolbar.

3. Complete the Create Logical Group screen as follows:

a. In the Logical Group Name field, type a unique name.

Your entry can include a maximum of 249 alphanumeric characters.

b. In the Logical Group Type field, select Manual.

c. Click Save.
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The group is created and is added to the Defined Logical Groups table. For 
now the group is empty. See "Add Drives and Media to a Manual Logical 
Group" on page 7-13 for details on adding resources to the group.

Add Drives and Media to a Manual Logical Group
Use this procedure to add drives, media, or both to an existing manual logical group. 
You can add drives or media one at a time, or you can select multiple resources and 
add them all at once.

1. Go to the appropriate Overview screen, as follows:

■ To add drives to the logical group, select Tape System Hardware > Drives – 
Overview in the Navigation Bar.

■ To add media to the logical group, select Tape System Hardware > Media – 
Overview in the Navigation Bar.

2. On the selected screen (Drives – Overview in this example), select the drives or 
media you want to add to the logical group.

Optionally, you can apply a filter to the screen to narrow down the choices. The 
example below shows individual drives selected from a filtered list. 

Note: The logical group must already exist. See "Create a Manual 
Logical Group" on page 7-11 for instructions.

Note: Removing drives and media from a logical group is done on 
the Logical Groups screen. See "Remove Drives and Media From a 
Manual Logical Group" on page 7-15 for instructions.

Note: You cannot add drives or media to a dynamic logical group. To 
change the membership of a dynamic group, see "Change the 
Selection Criteria for a Dynamic Logical Group" on page 7-20.
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3. Click Logical Groups in the table toolbar.

The Logical Groups dialog box appears.

4. In the menu, select the logical group to which you want to add the selected drives 
or media, and then click OK.

The resources are added to the logical group. See "List All Drives and Media 
Assigned to a Logical Group" on page 7-23 to confirm the update.

5. Optionally, you can add additional resources to the group as follows:

■ To add additional resources of the same type (in this example, drives), stay on 
the current Overview screen and return to Step 2.

■ To add resources of the other type (in this example, media), return to Step 1 
and select the corresponding Overview screen.

Note: The menu displays manual logical groups only.
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Remove Drives and Media From a Manual Logical Group
Use this procedure to remove selected drives, media, or both from a manual logical 
group. 

1. In the Navigation Bar, select Setup & Administration > Logical Groups.

The Logical Groups screen appears.

2. In the Defined Logical Groups table, select the manual logical group you want to 
modify.

The drives and media assigned to the group are displayed in the Assigned Entities 
table.

Note: Adding drives and media to a logical group is done on the 
respective Overview screens. See "Add Drives and Media to a Manual 
Logical Group" on page 7-13 for instructions.

Note: You cannot delete drives or media from a dynamic logical 
group. To change the membership of a dynamic group, see "Change 
the Selection Criteria for a Dynamic Logical Group" on page 7-20.
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3. In the Drives or Media table, select the resources you want to remove from the 
group, and then click Unassign Entities. You can select multiple records at once, 
but they must all be from the same table. 

The Unassign Entities dialog box appears. 

4. Verify that you have specified the correct information and click Yes.

The selected resources are removed from the group, and the Assigned Entities 
table is updated.

Note: The Unassign Entities button does not activate for dynamic 
logical groups. If the button is not activated, check to be sure you have 
selected a manual logical group.
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5. To remove additional drives or media from the group, return to Step 3.

Create and Define a Dynamic Logical Group
Use this procedure to create a dynamic logical group and define the selection criteria 
that determine which drives and media are assigned to the group.

1. In the Navigation Bar, select Setup & Administration > Logical Groups.

The Logical Groups screen appears.

2. Click Add Logical Group in the Defined Logical Groups toolbar.

3. Complete the Create Logical Groups dialog box as follows:

a. In the Logical Group Name field, type a unique name.
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Your entry can include any alphanumeric characters up to 250 characters in 
length.

b. In the Logical Group Type field, select Dynamic.

The Entity Assignment Policies appear in the dialog box.

4. Specify the selection criteria as follows. 

a. In the Filter Matching field, indicate whether you want to match any or all of 
the criteria you specify. 

b. Click the Add New Filter Criteria Row button to add a new, blank selection 
criteria row to the dialog box.

c. Specify the selection criteria using the menus and text fields on the row. See 
Table 4–1, " Filter Operators by Attribute Type" for details on filling out each 
row. 

d. You can add as many rows of selection criteria as you want.

Note: When selecting an attribute for filtering, if you know the name 
of the attribute you want to select, you can type the first few letters to 
quickly move the cursor to that item in the menu.
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e. To remove criteria, click the Remove This Filter Criteria Row button on the 
row you want to delete.

5. Verify that your criteria are correct and click Save. 

The group is created and added to the Defined Logical Groups table, and STA 
begins building the group in the background. 

Initially, the media and drive counts for the group are displayed as zero. 
Depending on the size of your tape library system and the complexity of your 
selection criteria, it may take from a few seconds to many minutes for all 
qualifying drives and media to be added to the group. Leaving the Logical Groups 
screen does not interrupt this process.
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6. As the logical group is built, you can click the Refresh Table icon to update the 
screen display with the in-progress drive and media counts. 

The display is updated.

Change the Selection Criteria for a Dynamic Logical Group
Use this procedure to change the selection criteria for an existing dynamic logical 
group.

1. In the Navigation Bar, select Setup & Administration > Logical Groups.

The Logical Groups screen appears.

2. In the Defined Logical Groups table, select the dynamic logical group you want to 
modify and click Edit Logical Group.
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The Edit Logical Group dialog box appears, and the group's selection criteria are 
displayed.

3. You can add, delete, and modify selection criteria as necessary. See "Create and 
Define a Dynamic Logical Group" on page 7-17 for instructions. 

Force a Dynamic Logical Group Update
Use this procedure to initiate an immediate update of a dynamic logical group to 
reflect any changes in the qualifying drives or media. Dynamic groups are updated 
automatically every hour, but you can use this procedure to update groups between 
update cycles.

1. In the Navigation Bar, select Setup & Administration > Logical Groups.
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The Logical Groups screen appears.

2. In the Defined Logical Groups table, select the dynamic logical group you want to 
update and click Refresh Dynamic Group.

STA begins updating the group in the background. Depending on the size of your 
tape library system and the complexity of your selection criteria, it may take from 
a few seconds to many minutes for the update to complete. Leaving the Logical 
Groups screen does not interrupt this process.

3. As the group is updated, you can click the Refresh Table button to update the 
screen display with the in-progress drive and media counts. 

View Logical Group Assignments for Selected Drives or Media
Use this procedure to view the logical groups to which selected drives or media have 
been assigned. 

1. From the Drives – Overview or Media – Overview screen, select the records you 
want to display, and click Detail View.



Logical Group Creation and Management Tasks

Logical Groups 7-23

In the Detail View for each record you have selected, the logical group 
assignments are listed in the User-Provided Information section at the bottom of 
the display. All groups to which the resource is assigned are listed. 

List All Drives and Media Assigned to a Logical Group
Use this procedure to display a list of all drives and media assigned to a selected 
logical group.

1. In the Navigation Bar, select Setup & Administration > Logical Groups.
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The Logical Groups screen appears.

2. In the Defined Logical Groups table, select the logical group you want to display.

All assigned drives and media are displayed in the Assigned Entities table.

Rename a Logical Group
Use this procedure to change the name of an existing manual or dynamic logical 
group.

1. In the Navigation Bar, select Setup & Administration > Logical Groups.
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The Logical Groups screen appears.

2. In the Defined Logical Groups table, select the group you want to rename, and 
then click Edit Logical Group.

The Edit Logical Groups dialog box appears.

3. Type the new name in the Logical Group Name field, and then click Save. For 
dynamic logical groups, do not modify any other fields. For manual logical 
groups, this is the only field available.
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The Defined Logical Groups table is updated with the new name. 

4. To update the Assigned Entities table display, in the Defined Logical Groups table, 
deselect the logical group and then re-select it. The display is updated with the 
assigned drives and media.

Delete a Logical Group
Use this procedure to delete a selected manual or dynamic logical group. You can 
delete only one logical group at a time.

1. In the Navigation Bar, select Setup & Administration > Logical Groups.

Note: The Assigned Entities table indicates the group contains no 
drives nor media. This is just lag in the table display. 

Note: This procedure deletes the entire logical group. To delete just 
selected drives or media from a manual group, see "Remove Drives 
and Media From a Manual Logical Group" on page 7-15. 
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The Logical Groups screen appears.

2. In the Defined Logical Groups table, select the group you want to delete, and then 
click Delete Logical Group.

The Delete Logical Group dialog box appears.

3. Verify that you have selected the correct logical group, and then click Yes to delete.

The group is deleted and removed from the Logical Groups screen. 

Any screens, Dashboard portlets, or templates filtered by the group now show "No 
data to display" or "No data available."
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8STA Media Validation

STA media validation is an optional STA feature that helps to ensure long-term 
preservation of the data in your tape library system. It provides automated, 
policy-driven validation of production media in StorageTek SL8500 libraries, using the 
data integrity checking capabilities of Oracle's StorageTek T10000C and T10000D 
drives. STA analyzes the validation results and makes recommendations for 
preserving your data.

The following topics are included in this chapter:

■ "Overview of STA Media Validation" on page 8-1

■ "Configuring STA Media Validation" on page 8-5

■ "Drive Calibration and Qualification" on page 8-11

■ "Submitting Manual Validation Requests" on page 8-17

■ "Using Automated Media Validation" on page 8-20

■ "Managing the STA Media Validation Request Queue" on page 8-21

■ "User Roles for Media Validation" on page 8-25

■ "Media Validation Tasks" on page 8-26

Overview of STA Media Validation
This section includes the following topics: 

■ "Features and Benefits of STA Media Validation" on page 8-1

■ "Feature Comparison for STA and SL Console" on page 8-3

■ "Types of Verification Tests" on page 8-3

Features and Benefits of STA Media Validation
With STA, you can use one user interface to automate and manage media validation 
activities across all SL8500 libraries in your tape library system. This section 
summarizes the advantages of STA media validation.

Note:  STA media validation is supported only for tape library 
system configurations meeting the minimum requirements. See the 
STA Requirements Guide for a list of STA, library, drive, and media 
requirements. 
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Increased Security With Reduced Cost and Complexity
STA media validation is done internally by the T10000C and T10000D drives 
themselves, providing several advantages over validation methods offered by other 
vendors. Data in your tape library system is kept secure because there is no need to 
send it across a network to a separate application. Costs are reduced because there is 
no need for a dedicated host server or additional host software to read information 
from the media and drives, and there is no need for additional Fibre Channel data 
connections to the drives.

No Disruption to Library Production Operations
Validation drives are not available for use by host applications, but if a host requires 
media that is being validated, the host request takes priority. The library interrupts the 
validation, dismounts the media from the drive, and makes the media available to the 
application. This is done transparently to the application.

Assurance of Valid Test Results
To confirm the validity of all media validation tests, STA provides optional drive 
calibration and qualification features. Calibration ensures that validation drives are in 
good working order, and qualification ensures that the validation drives remain 
calibrated and failed validations are the result of problems with the media, not the 
drive. These features operate without user intervention once they are configured and 
enabled. See "Drive Calibration and Qualification" on page 8-11 for details.

Automated Validation Operations
With STA, you can define policies for automatically selecting media for validation. For 
example, you could define policies to initiate validations whenever media health falls 
to Action or whenever a drive detects a bad media information record (MIR). STA 
automatically queues the media for validation on a a compatible drive. 

STA can initiate and process multiple validations simultaneously, depending on the 
number of drives you have set aside for validation activities. See "Using Automated 
Media Validation" on page 8-20 for details.

User Management of Validation Requests
You can use STA to manage the validation request queue. You can reprioritize pending 
validation requests, cancel in-progress requests, and initiate validations manually. See 
"Managing the STA Media Validation Request Queue" on page 8-21 for details.

Limit to Validation Frequency
To prevent the overuse of data media, STA does not allow a piece of media to be 
validated more than once in a 24-hour period. This applies to both manual and 
automated validation requests.

Comprehensive Reporting of Validation Results
STA displays the results of all validation activities performed in your tape library 
system. This includes validations initiated by other applications, such as Oracle's 
StorageTek SL Console and Oracle's StorageTek Storage Archive Manager (SAM). STA 
analyzes validation results and makes recommendations for action you should take. 
See "Displaying the Status of Validation Requests" on page 8-22 for details.
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Feature Comparison for STA and SL Console
Table 8–1 compares the media validation features available through STA and 
SL Console. An "X" in the column indicates the feature is supported by that product.

Types of Verification Tests
The T10000C and T10000D drives perform the following media validation tests, all of 
which are available through STA. When you define a media validation policy or 
initiate a manual media validation, you indicate which type of test to perform. See 
"Submit Manual Media Validation Requests" on page 8-40 and "Create a Media 
Validation Policy" on page 8-54 for instructions.

Basic Verify
Verifies that the media is mountable and the media information record (MIR) is valid. 
The drive simply mounts the media and validates the MIR. This validation detects 
whether the MIR is unreadable or out of sync and updates the following data 
attributes for the media:

Table 8–1 Media Validation Feature Comparison for STA and SL Console

Feature STA SL Console

Configure the validation drive pool. X

Support all T10000C and T10000D verification test types. X X

Automatically mitigate false-positive validation results. X

Calibrate validation drives. X

Automatically perform ongoing qualification of validation 
drives.

X

Perform one validation at a time. X X

Perform multiple validations at a time. X

Perform validations in multiple libraries or complexes at once. X

Perform automated, policy-driven validations. X

Submit multiple validation requests to a user-managed request 
queue.

X

Reprioritize pending validation requests. X

Display progress indicators for in-progress validations. X X

Display validation results one at a time. X X

Display multiple validation results at one time. X

Display validation results in table and graph form. X

Display validation history over a selected date range. X

Display detailed validation failure and disposition information. X

Report indications of marginal tape quality (on selected drive 
firmware versions only).

X

Receive alerts about validation results X

Display Dashboard summaries of validation activity on a PC or 
mobile device

X

Receive emailed Executive Reports summaries of validation 
activity

X
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■ Exchange Recording Technique (recording format used by the drive to write to the 
media)

■ Media Suspicion Level

■ MB Written (total amount of data written to the media)

This method takes approximately two minutes.

Standard Verify
Verifies that the highest-priority areas of the media are readable. The drive verifies 
records at the beginning of tape (BOT), end of data (EOD), and the outer-most wraps 
of data written on the top and bottom edges of the tape. 

This method typically takes a maximum of 30 minutes, regardless of the amount of 
data and the compression ratio used. 

This test is not valid for blank tapes.

Complete Verify
Verifies that all data records on the media are readable. The drive does a 
record-by-record verification with no decompression nor decryption. 

By default, the validation starting point is the beginning of tape (BOT). For T10000T2 
media, you can optionally choose to resume validation from the last verified location, 
as indicated by the media RFID chip; validations of T10000T1 media must always start 
at the BOT. 

The drive validates data at maximum tape velocity, regardless of the compression ratio 
used on the media. This method may take approximately five to nine hours, 
depending on the starting point, the amount of data on the media, and the drive type.

This test is not valid for blank tapes.

Complete Verify Plus
Verifies that all data records on the media are readable, including StorageTek Data 
Integrity Validation (DIV) checking. If the data records on the media include DIV 
cyclic redundancy check (CRC) codes added by the host, the data is decompressed and 
decrypted. Consequently, this test requires the validation drive to be encryption 
capable and connected to an Oracle Key Manager (OKM). This test is not valid for 
drives configured with a FICON interface.

By default, the validation starting point is the beginning of tape (BOT). For T10000T2 
media, you can optionally choose to resume validation from the last verified location, 
as indicated by the media RFID chip; validations of T10000T1 media must always start 
at the BOT. 

This method may take approximately five to nine hours, depending on the starting 
point, the amount of data on the media, the drive type, and the compression ratio.

This test is not valid for blank tapes. 

Verify and Rebuild MIR
Verifies the MIR and rebuilds it if necessary. The drive first verifies the MIR. If there 
are errors, the drive finds the last known-good spot on the MIR, then does a 
high-speed locate to that point on the tape. The drive then does a record-by-record 

Note: To be used by STA for policy-driven validation, media must 
have this information at a minimum. See "Media Eligible for 
Automated Validation" on page 8-20 for details.
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verification with no decompression nor decryption. If the MIR is invalid or out of sync, 
the drive reads all records, starting from the beginning of tape (BOT), to gather the 
information necessary to rebuild the MIR, and then rebuilds it. Records are not 
decompressed nor decrypted.

You should use this method if there is a corrupt MIR on an exchange. 

The drive reads the data at maximum tape velocity. This method may take 
approximately five to nine hours, depending on the starting point, the amount of data 
on the media, and the drive type. This is significantly faster than rebuilding the MIR 
with the drive Virtual Operator Panel (VOP). 

Configuring STA Media Validation
This section includes the following topics:

■ "Preparing for STA Media Validation" on page 8-5

■ "Validation Drive Pools" on page 8-5

■ "Enabling Media Validation" on page 8-9

■ "Disabling Media Validation" on page 8-11

Preparing for STA Media Validation
Before enabling media validation on STA, you should perform the following 
preparation steps. 

1. Determine the library complexes and standalone libraries in which you want to 
implement media validation.

2. On the STA Drives – Overview screen, review and choose drives in these libraries 
that you want to use for media validation. See "Validation Drive Pools" on 
page 8-5 for details. 

3. Use SL Console to add the drives to the validation pools. You must log in to 
SL Console on the selected standalone library or a library that is part of the 
selected complex. See the SL8500 User's Guide for details. 

4. Decide whether you want to use drive calibration and qualification, and if so, 
create the calibration media logical group. See "Drive Calibration and 
Qualification" on page 8-11 for details.

Validation Drive Pools

Validation drives are drives that have been set aside exclusively for the time-being for 
media validation. These drives are not accessible to host applications. They must be 
assigned to a media validation drive pool through the SL Console.

Note: Some of these steps may require Administrator privileges. See 
"User Roles for Media Validation" on page 8-25 for details.

Note: The validation drive pools are maintained only through 
SL Console. See the SL8500 User's Guide for detailed instructions on 
maintaining the pools.
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Each SL8500 library complex and standalone SL8500 library has its own validation 
drive pool, and up to ten drives can be assigned to each pool. You must assign at least 
one drive per library complex or standalone library in which you want to validate 
media. If you will be validating encrypted media, in each applicable library you must 
assign at least one drive that has been enabled for encryption and connected to an 
Oracle Key Manager (OKM). 

You can add and remove drives from the validation drive pools according to your 
needs. STA detects any changes and uses new drives as necessary.

Validation Drives That Can be Used by STA
SL Console does not check for STA minimum requirements when drives are added to 
the validation drive pools. As a result, drives in the pools may not necessarily be valid 
for use by STA. However, the STA Media Validation Configuration screen displays the 
total number of validation drives that do meet the minimum requirements for STA 
media validation. From there, you can link to the Drives – Overview screen, where you 
can see detail for these drives, such as drive type, Drive Health Indicator, and the drive 
location. See "Display Validation Drives for STA Media Validation" on page 8-26 for 
instructions. Figure 8–1 is a sample display.

Note: You may have only one validation drive at your site, in which 
case any media to be validated must be moved to that library. 
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Figure 8–1 Validation Drives on the Drives – Overview Screen

Choosing Drives for the Validation Drive Pools
Although drives are assigned to the validation drive pools with the SL Console, you 
can use STA to review and select candidate drives.

You can assign any drives to the pools, but in order for STA to use them, they must 
meet the following minimum requirements: 

■ Drive Model is T10000C or T10000D.

■ Drive Firmware Version ends in 5.40 or higher – This indicates the firmware 
supports TTI5.4.

■ Drive Health Indicator is Use.

■ Drive Suspicion Level is 0.

Figure 8–7 is a sample filter you might use on the Drives – Overview screen.
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Figure 8–2 Filter for Reviewing Validation Drive Candidates

In addition to these minimum requirements, you should select drives that are of high 
quality, with some recent activity and few or no errors. Drives with the following 
characteristics may be good candidates for the validation pools: 

■ Activity in the last 30 days. See the Drive Dismounts (30 Days) attribute. 

■ No drive errors. See the Drive Errors (30 Days) attribute. 

■ No excessive drive cleans. See the Cleans (30 Days) attribute. 

■ No excessive alerts or SNMP traps. If there are alerts and traps, you may want to 
investigate to determine whether they indicate a potential problem with the drive. 
See the Drive SNMP Trap Count (30 Days) and Alert Count (30 Days) attributes.

■ Relatively fast. See the Mount R/W MB/sec (30 Days) attribute.

You may want to apply selected drives to the graphs to get a visual representation of 
the drive characteristics and confirm your selections. Figure 8–3 shows three candidate 
drives applied to the graphs on the Drives – Overview screen.
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Figure 8–3 Drives – Overview Screen Showing Validation Drive Candidates

Enabling Media Validation
STA media validation is disabled by default, so you must explicitly enable it. This is a 
global setting, so once enabled, STA media validation is available for all 
SL8500 libraries in your tape library system. See "Enable or Disable Media Validation 
on STA" on page 8-30 for detailed instructions. Enabling and disabling media 
validation requires Administrator privileges. 

Once media validation is enabled, you can begin using STA to perform the following 
activities:

■ Create manual media validation requests. See "Submitting Manual Validation 
Requests" on page 8-17 for complete details.

■ Display and manage the media validation request queue. See "Managing the STA 
Media Validation Request Queue" on page 8-21.

■ Use media validation policies to perform automated validations. See "Using 
Automated Media Validation" on page 8-20 for complete details.
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Media Validation Configuration Status Messages
The Media Validation Configuration screen displays the current configuration status of 
the STA media validation feature. 

The following messages may appear while media validation is being configured 
without drive calibration and qualification. Figure 8–4 is an example.

■ Media Validation is DISABLED.

■ Media Validation successfully enabled.

■ Media Validation Enabled; Opted-out of Drive Calibration.

Figure 8–4 Media Validation Configuration Success Message

The drive calibration and qualification feature may take some time to enable and 
configure. You may see the following messages while this process is underway. 
Figure 8–5 is an example. See "Drive Calibration and Qualification" on page 8-11 for 
information about these features.

■ Media Calibration Process in Progress.

■ Media Operation to Create History in Progress.

■ Drive Qualification Type Pool Pre-Calibration SUCCESS.

■ Calibration Success. Drive Qualification is Now Active.

Figure 8–5 Drive Calibration Configuration Success Message

The following messages indicate a problem with media validation configuration. 
Figure 8–6 is an example.

Note: You can create validation policies before enabling media 
validation on STA.
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■ No Available Drives, Not Suitable for Media Validation Use.

■ No Available Media, Not Suitable for Calibration Use.

■ Warning: Insufficient Media in MV Media Pool for Number Of Drives in MV 
Partition.

Figure 8–6 Drive Calibration Configuration Error Message

Disabling Media Validation
Once media validation has been enabled at your site, you may want to temporarily 
disable it on occasion for library maintenance. See "Enable or Disable Media Validation 
on STA" on page 8-30 for detailed instructions.

STA does not accept any new media validation requests while media validation is 
disabled. Any pending or in-progress requests are processed to completion unless you 
explicitly cancel them.

With media validation disabled, STA still displays requests initiated from other 
sources, such as SL Console and the library command-line interface (CLI). 

Drive Calibration and Qualification
Drive calibration and qualification are optional STA features that confirm the validity 
of all media validation tests. When these features are enabled, STA uses only calibrated 
and qualified drives to perform media validation activities.

Calibration, which is a one-time, setup process, ensures that validation drives are in 
good working order before they are used for media validation. Qualification is an 
ongoing, automated process performed on drives that have been calibrated. It verifies 
that failed validations are the result of problems with the media, not the drive.

Together these features ensure that the results of each and every media validation 
reflect the true quality of the tested media and are not confounded by unknown issues 
with the validation drives. 

This section includes the following topics:

■ "Drive Calibration and Qualification Terms" on page 8-12

■ "Benefits of Calibration and Qualification" on page 8-13

■ "How Calibration and Qualification Work" on page 8-14

■ "Preparing for Calibration and Qualification" on page 8-15
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Drive Calibration and Qualification Terms
These terms are useful in understanding the concepts of drive calibration and 
qualification and are used throughout this section.

Validation exchange
A media and drive exchange in which the drive performs a specified validation test on 
the media and its data.

Failed validation
A media validation exchange that ends with a "Degraded" or "Failed" status.

False positive result
A failed validation that is the result of problems with the validation drive, not the 
media. STA uses drive calibration and qualification processes to reduce the possibility 
of false positive results and ensure that failed validations are the result of problems 
with the media.

Drive calibration
Optional STA media validation feature whose purpose is to ensure that validation 
drives are performing optimally. If drive calibration is enabled, validation drives must 
be calibrated before STA can use them for media validation.

Calibrated drive
Validation drive that has successfully passed the STA drive calibration process. A 
drive that fails calibration is considered disqualified and is not used by STA. If the STA 
drive calibration feature is disabled, all validation drives are considered uncalibrated, 
but they are used by STA.

Uncalibrated drive
A drive that has not yet been calibrated; or a validation drive in a system in which the 
STA calibration feature has not been enabled.

Drive qualification
Optional STA media validation feature that ensures validation drives remain 
calibrated and helps to ensure failed validations are the result of problems with the 
media, not the drive. STA automatically initiates a drive qualification process 
whenever there is a failed validation. Drive qualification is enabled as part of drive 
calibration.

Drive calibration is essentially a one-time process, whereas drive qualification is 
ongoing.

Qualified drive
Calibrated drive that has successfully passed the STA drive qualification process.

Disqualified drive
A drive that has failed STA calibration or qualification.

Calibration media
Media that has been set aside specifically for drive calibration and qualification. You 
assign calibration media to a manual logical group through STA. It is highly 
recommended that you dedicate calibration media exclusively to drive calibration and 
not use them for production data. Calibration media should be of high quality.

Read Quality Index (RQI)
Measure of the amount of error correction left on the media. RQI applies to the 
exchange as a whole and includes contributions from both the media and the drive 
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involved in the exchange. This term is specific to media validation and differs from 
Read Margin.

RQI is reported as a percentage. A high value is desirable.

Data Quality Index (DQI)
Measure of the amount of error correction left on the media, similar to Read Quality 
Index (RQI), but targeted specifically to the media because it factors out the drive's 
contribution. During drive calibration and qualification, STA uses the DQI to 
determine whether the drive is qualified or disqualified. 

DQI is reported as a percentage. A high value is desirable.

Benefits of Calibration and Qualification
Although drive calibration and qualification are optional features, it is highly 
recommended that you enable them on STA, as they provide the following significant 
advantages:

■ Ensured Validity of Validation Results

■ Ensured Health of Validation Drives

■ Operational Efficiency

Ensured Validity of Validation Results
Because each exchange involves both a piece of media and a drive, when an exchange 
failure occurs, there is always uncertainty whether the problem is with the drive, the 
media, or both. For production media, STA uses sophisticated health and suspicion 
algorithms that reduce this uncertainty, in part by using available historical data for 
the media and the drive. The more data available, the more reliable the analysis.

Media validation failures carry the same inherent uncertainty. However, they are 
further complicated by the fact that validation exchanges tend to involve a 
higher-than-normal percentage of problem media and media that have little or no 
available history.

For example, an archive media that has not been used in over a year may have 
minimal STA data. If the media is validated on an uncalibrated drive and the 
validation fails, there is a possibility the failure is the result of problems with the 
validation drive, not the media being validated. With minimal historical data available 
for the media, there is increased uncertainty about the validation result. The STA drive 
calibration and qualification features directly address these uncertainties, providing 
you with assurance the failed validation has identified a problem with the media. 

Ensured Health of Validation Drives
Another advantage of calibration and qualification concerns drive quality. Because 
validation drives have a higher-than-normal number of exchanges with problem 
media, they may become degraded at a faster rate than production drives. Through 
drive qualification, STA continuously verifies the health of validation drives. Drive 
problems are identified early so the verification drives can be serviced or replaced 
before they, in turn, begin to cause problems with production media.

Operational Efficiency
When a media validation fails, some action must be taken to verify the result and 
confirm there is a problem with the media. If drive calibration and qualification is 
disabled, you must do this verification manually. For example, you could perform a 
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Complete Verify on the media using a different drive, and if this validation also fails, 
then you could be reasonably certain the problem is with the media, not the drive. 
Depending on the amount of data on the media, this could take several hours. 

If drive calibration and qualification is enabled, STA verifies all failed validations 
through the process of drive qualification. Qualification is done automatically with no 
user intervention. Because STA uses pre-qualified media, it is only necessary to do a 
Standard Verify for the qualification, which takes significantly less time than a 
Complete Verify. 

How Calibration and Qualification Work
Calibration and qualification are separate processes, but they are enabled and disabled 
together. Before using calibration and qualification, you must create a manual logical 
group for media that will be used for these activities. See "Preparing for Calibration 
and Qualification" on page 8-15 for details.

Drive Calibration Process
Drive calibration is a one-time setup process that begins as soon as drive calibration is 
enabled on the Media Validation screen. All drives in the validation pool are tested 
using a Standard Verify. This may take one to two hours per drive. 

Once drive calibration is configured and enabled, it proceeds automatically with no 
need for manual intervention. If a new drive is added to the media validation pool, 
STA detects this and automatically begins calibrating the drive. STA also automatically 
recalibrates drives after a firmware update. 

Calibration uses the following basic process for each validation drive:

1. STA performs two Standard Verify validations on the drive, each time using a 
different media from the calibration media logical group. 

2. STA analyzes the Data Quality Index (DQI) values from the validations. For a 
drive to be qualified, the following criteria must be met:

– One media must have DQI >=75. This is assigned to the drive as the primary 
calibration media.

– One media must have DQI >=50. This is assigned to the drive as the secondary 
calibration media.

3. Depending on the DQI results, STA proceeds as follows:

– If both criteria are met after two validations, the drive is calibrated. A third 
validation is not necessary for this drive.

– If only one of these criteria is met after two validations, a third validation is 
performed using a different media from the calibration media logical group.

– If both these criteria are not met after three validations, the drive is considered 
disqualified.

Results of Drive Calibration
If a drive passes calibration, two media are assigned to it as dedicated primary and 
secondary calibration media. During the calibration process, these media are confirmed to 
be of high quality. Each validation drive has its own primary and secondary 
calibration media, and these media are used for all drive qualification activities on the 
drive. 
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If a drive fails calibration, it is disqualified. Disqualified drives are assigned a 
Calibration State of "Not Suitable," and they are not used for any STA validation 
activities while drive calibration is enabled. They remain in the media validation drive 
pool until you explicitly remove them through the SL Console. 

Once all drives have been calibrated, the Media Validation Configuration screen 
displays, "Drive and Media Pool Setup Success--calibration has been successful." 
Detailed results about individual drives are displayed on the Drives – Overview 
screen, and you can review the results and take appropriate action. See "Display 
Validation Drives for STA Media Validation" on page 8-26 for instructions.

Validation Drive Qualification Process
Validation drives are qualified to assure the drives are still calibrated. Qualification is 
an ongoing process that runs automatically in the background and requires no user 
intervention. STA automatically initiates a qualification whenever a media validation 
results in a Degraded or Failed status. 

During qualification, the validation drive is tested using a Standard Verify. The test are 
performed using the primary and secondary calibration media assigned to the drive. 
Qualification follows a process similar to drive calibration. 

Results of Drive Qualification
Upon completion of qualification, STA makes one of the following recommendations 
about the quality of the drive and the media: 

■ The drive is disqualified.

■ The data media is bad. 

■ The data media is bad, and the secondary calibration media is disqualified.

Disqualified media are not used for drive calibration or qualification. They remain in 
the calibration media logical group until you explicitly remove them. See "Results of 
Drive Calibration" on page 8-14 for information about disqualified drives.

Qualification results are displayed on the Media Validation Overview screen in the 
Calibration and Qualification attributes. You can review the results and take 
appropriate action.

Preparing for Calibration and Qualification
Before enabling calibration and qualification, you must perform the following 
preparation tasks. 

1. On the Logical Groups screen, create a manual logical group for media that will be 
used for drive calibration. See "Calibration Media Logical Group" on page 8-16 for 
details. This task requires Operator or Administrator privileges.

2. On the Media – Overview screen, review and choose the media you want to use 
for drive calibration. See "Choosing Calibration Media" on page 8-16 for details.

Note: If drive calibration is disabled, STA ignores the "Not Suitable" 
Calibration State and uses the drives for validation. This may happen 
if calibration was enabled on STA at one point and has since been 
disabled.
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3. Assign the media to the logical group. This task requires Operator or 
Administrator privileges.

4. Enable drive calibration and qualification. See "Enable Drive Calibration and 
Qualification" on page 8-35 for instructions. This task requires Administrator 
privileges.

Calibration Media Logical Group
The media used for drive calibration and qualification must be assigned to a manual 
logical group dedicated exclusively for this purpose. This is the calibration media logical 
group. Once a logical group has been designated as the calibration media logical group, 
the media in it cannot be used for host operations, and STA will not allow them to be 
used in regular media validation operations. 

There is only one calibration media logical group for your entire tape library system. 
You must assign at least two media for each drive in the validation drive pool, and the 
media must reside in the same standalone libraries and library complexes as the 
validation drives. For example, if you have eight validation drives in complex 
SL8500 1 and one validation drive in standalone library SL8500-Seattle, the logical 
group must include at least 16 media from the libraries in complex SL8500 1 and two 
media from library SL8500-Seattle. There is no maximum number of media you can 
assign to the group. 

You can add and remove media from the logical group according to your needs. STA 
detects any changes and uses new media as necessary. 

Choosing Calibration Media 
It is highly recommended that you dedicate calibration media exclusively for drive 
calibration and qualification, and not use them for production data. This helps to 
ensure that the quality of the media is not compromised by production operations. The 
following may be good candidates for calibration media:

■ Media that has been in use but has data you no longer need; for example, expired 
backup media in good condition.

■ New or unused media in good condition to which you have written dummy data. 
The data may be encrypted or not, depending on your needs.

To be used for drive calibration and qualification, media must meet the following 
criteria:

■ Media Type is T10000T2 (indicating T100000T2 or T10000T2 Sport). Although 
T10000T1 media can be validated, they cannot be used for drive calibration and 
qualification.

■ Media Health Indicator is Use.

■ Media Suspicion Level is 0.

■ At least two wraps of data have been written to the media.

Note: STA does not check for these criteria when you add media to 
the calibration logical group, so it is possible to assign media that 
cannot be used for calibration and qualification.
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To find media that meet these requirements, you can apply a filter to the Media – 
Overview screen. Figure 8–7 is a sample filter you might use on the Media – Overview 
screen.

Figure 8–7 Filter for Reviewing Calibration Media Candidates

You can sort the filtered results by the "Media MB Avail Post" attribute to find media 
with at least two wraps of data. This varies by recording format and media type. 
Table 8–2 provides a summary of required amounts.

Submitting Manual Validation Requests
Once the validation drive pools have been created and media validation has been 
enabled on STA, you can use STA to submit manual validation requests and manage 
the validation request queue. See "Submit Manual Media Validation Requests" on 
page 8-40 for instructions.

Note: If any media you assign to the calibration logical group do not 
have the minimum required STA history, STA automatically initiates a 
Basic Verify on them before attempting to use them for drive 
calibration. A Basic Verify provides the minimum required history. See 
"Types of Verification Tests" on page 8-3 for details.

Table 8–2 T10000T2 Media, MB Written (Compressed) for Two Wraps of Data

Media Type MB Written

T10000D Standard 119,000 MB

T10000D Sport 23,800 MB

T10000TC Standard 97,000 MB

T10000TC Sport 19,400 MB
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You can submit manual validation requests from either of the following screens: 

■ Media Overview – You can select multiple media at once to be validated using the 
same verification test. Figure 8–8 is an example.

Figure 8–8 Initiating Media Validations From the Media – Overview Screen

■ Media Validation Overview – You can select only one media at a time for 
validation. Figure 8–9 is an example.

Figure 8–9 Initiating a Media Validation From the Media Validation Overview Screen

Note: If you have enabled drive calibration, the media included in 
the calibration media logical group cannot be included in manual or 
automated validation requests. STA will display an error message that 
the media are not eligible for media validation. See "Calibration Media 
Logical Group" on page 8-16 for details about these media.



Submitting Manual Validation Requests

STA Media Validation 8-19

To generate a manual request, you specify the following information. Figure 8–10 is a 
sample manual validation request.

Figure 8–10 Sample Manual Validation Request for Multiple Media

■ Media to be validated. STA allows you to generate requests for T10000 media only. 
If you select multiple media at once on the Media Overview screen and only some 
are T10000, then only the eligible media are confirmed for validation.

■ Validation test type. This is the type of verification test to be performed on the 
media. See "Types of Verification Tests" on page 8-3 for detailed descriptions.

■ Start from beginning of tape (BOT) or resume where the last interrupted validation 
left off. This option is available only if all of the following conditions are true. See 
"Resuming Interrupted "Complete Verify" Tests on T10000T2 Media" on page 8-24 
for details.

■ You have selected T10000T2 media for validation. (T10000T1 media 
validations always start at the beginning of tape.)

■ The validation test type is Complete Verify or Complete Verify Plus. (Other 
test types always start at the beginning of tape.)

■ The most recent validations for some or all of the selected media are not 100 
percent complete. (Media for which the most recent validation was complete 
are always validated from the beginning of tape.)

■ Validation drive – If your site has more than one validation drive, the 
recommended method of drive selection is to have STA select a compatible 
validation drive. However, if all selected media are in the same standalone library 
or library complex, you can manually specify the drive to use; STA provides a list 
of compatible drives from which to choose. If the media are distributed across 
multiple standalone libraries or complexes, then STA automatically selected the 
drives to use.

As soon as you submit the manual request, it is added to the STA media validation 
request queue. The validation is started when a compatible drive becomes available.
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Using Automated Media Validation
STA allows you to define any number of media validation policies, which 
automatically select media for validation based on a variety of user-defined criteria. 
For each selected media, STA generates a validation request, which is submitted to the 
STA validation queue. As soon as a compatible drive becomes available, the validation 
is started. This activity is all managed automatically by STA.

Depending on the number of media validation policies and how they are defined, a 
single piece of media could potentially be selected for validation several times a day. 
To prevent this from happening, STA limits automated validations to a maximum of 
one per day for each media. Once a validation request has been generated for a piece 
of media, STA will not generate any additional validation requests for it that day.

Media Eligible for Automated Validation

To be used by STA for policy-driven validation, media must have a minimum history. 
Media must have values for the following attributes:

■ Exchange Recording Technique (recording format used by the drive to write to the 
media)

■ Media Suspicion Level

■ MB Written (total amount of data written to the media)

If you want STA to validate media that does not have this history, you should 
manually initiate a Basic Verify to supply these attributes. See "Types of Verification 
Tests" on page 8-3 and "Submit Manual Media Validation Requests" on page 8-40 for 
details. 

Defining Validation Policies
Users with Administrator privileges perform this part of the process from the Media 
Validation screen on the Setup & Administration tab. Media validation does not need 
to be enabled on STA for you to create validation policies, so you can do this ahead of 
time if you want.

When you create a validation policy, you can enable it immediately or leave it disabled 
for the time being. STA uses only enabled policies to generate validation requests.

To define a validation policy, you specify the following information:

■ Policy name – Alphanumeric identifier for the policy. Policy names must be 
unique.

■ Policy description – Optional description of the policy.

■ Applicable media group – You can choose to apply the policy to media with 
specified recording formats in a specified library complex, or media in a specified 
logical group. See "Validating Media by Logical Group" on page 8-21 for details 
about logical groups.

Note: If you have enabled drive calibration, the media included in 
the calibration media logical group cannot be included in manual or 
automated validation requests. STA will automatically exclude these 
media from any validation policies. See "Calibration Media Logical 
Group" on page 8-16 for details about these media.
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■ Selection criteria – Predefined criteria by which media in the applicable media 
group are selected for validation. See "Selection Criteria for Validation Policies" on 
page 8-21 for detailed descriptions.

■ Validation test type – Type of verification test to be performed on the media. See 
"Types of Verification Tests" on page 8-3 for detailed descriptions.

See "Create a Media Validation Policy" on page 8-54 for detailed instructions.

Validating Media by Logical Group
You can apply a media validation policy to any existing logical group—one logical 
group per policy. STA generates validation requests only for media in the group that 
meet both of the following criteria:

■ T10000 media

■ Media that reside in standalone SL8500 libraries or library complexes that have 
validation drive pools with drives meeting the STA minimum requirements

Selection Criteria for Validation Policies
STA can select media for validation based on any of the following predefined criteria: 

■ Random Selection – Randomly selects media for validation whenever a validation 
drive in the standalone library or library complex is available. 

■ Media Health = Action – Selects media that have had a specified number of 
successive exchanges resulting in an Exchange Media Health of Action. You can 
specify from one to five exchanges. 

■ Media Health = Evaluate – Selects media that have had a specified number of 
successive exchanges resulting in an Exchange Media Health of Evaluate. You can 
specify from one to five exchanges.

■ Media Health = Monitor – Selects media that have had a specified number of 
successive exchanges resulting in an Exchange Media Health of Monitor. You can 
specify from one to five exchanges.

■ Extended Period of non-use – Selects media that have not had an exchange for a 
specified number of days. You can specify from 365 to 1,095 days (one to three 
years).

■ Newly Entered – Selects media that have recently been entered into the library.

■ Bad MIR Detected – Selects media with an exchange resulting in a Bad MIR 
Detected error. A bad media information record (MIR) indicates degraded 
high-speed access on the media. 

Managing the STA Media Validation Request Queue
The media validation request queue is displayed on the Media Validation Overview 
screen on the Tape System Activity tab. The queue lists all media validation activity 
that has occurred in your tape library system. This includes pending and completed 
validation requests initiated by STA or any other application. By default, requests are 
listed in reverse Priority Order, with the most recent requests at the top of the list.

From the Media Validation Overview screen, you can perform any of the following 
activities:

■ "Displaying the Status of Validation Requests" on page 8-22

■ "Canceling Pending or In-Progress Validation Requests" on page 8-24
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■ "Resuming Interrupted "Complete Verify" Tests on T10000T2 Media" on page 8-24

Displaying the Status of Validation Requests
The Media Validation Overview screen displays complete details about all validation 
requests. This section describes attributes of particular interest on this screen. 

Media Validation Request Priorities
The Priority Order attribute indicates the order of each validation request in the queue. 
When a new request is created, it is assigned the next available Priority Order value. 
STA processes requests in priority order, and you can reprioritize pending requests by 
moving them up or down in the queue. See "Reorder Pending Media Validation 
Requests" on page 8-47 for instructions.

Pending and in-process requests are listed in reverse Priority Order, so the most 
recently received requests are at the top of the list. Completed validations have a blank 
Priority Order value. 

Media Validation Request States
The Request State indicates the progress of each validation request. Requests are 
typically processed through the following sequence:

1. Pending – The request has been submitted and is waiting for a compatible 
validation drive to come available. The Request Status Information attribute may 
display additional details.

2. Starting – The drive has been reserved for the validation operation.

3. In-Progress – The validation is in progress. The Elapsed Time and Estimated Time 
Remaining attributes are continually updated as the operation proceeds.

4. Completed – The validation has completed. See "Media Validation Results" on 
page 8-23 for details about information STA may display.

In addition, the following Request States may occur at any time:

■ Error – An error has occurred with the request. The Request Status Information 
attribute may display additional details.

■ Stopping, or Stop Requested – The request has been stopped, either manually or 
by a media request from a host application. See "Canceling Pending or In-Progress 
Validation Requests" on page 8-24 for details.

Media Validation Initiators
STA reports all media validation information it receives from your tape library system. 
Consequently, you may see media validations not initiated through STA. Media 
validations can be done from a variety of applications, and the Initiator attribute 
indicates the source. Options are as follows:

■ Drive – Indicates the validation was initiated directly on the T10000C or T10000D 
drive.

Note: If drives, media, or library connections are removed from your 
tape library system, any associated pending STA validation requests 
remain in the request queue until you explicitly cancel them. See 
"Cancel Pending Media Validation Requests" on page 8-50 for 
instructions.
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■ Host – Indicates an external host application, such as Oracle's StorageTek Storage 
Archive Manager (SAM). These applications do not use the internal media 
validation capabilities of the T10000C and T10000D drives.

■ Library – Indicates the library command-line interface (CLI). Only Oracle support 
representatives are authorized to initiate media validations through the CLI. 
However, library administrators can use the CLI to cancel pending or in-progress 
validations. See the SL8500 User's Guide for details. 

■ SLC – Indicates the SL Console.

■ STA – Indicates STA.

Media Validation Results
When a validation completes, the media is returned to a media slot, and STA displays 
the results and recommendations for user action. Following are attributes on the 
Media Validation Overview screen that you may find useful for interpreting validation 
results, particularly for validations that result in errors.

Validation Result
STA assigns one of the following Validation Result values to each completed 
validation:

■ Use – The media passed validation.

■ Degraded – Migrate the data and scratch the media.

■ Failed – Migrate the data and disposition the media according to your site's 
policies.

■ Unknown – May occur in the following situations:

The validation was canceled by STA or interrupted by a host request for the 
media.
An error occurred during the validation.
Communication between STA and the library was interrupted during the 
validation.
The media information record (MIR) is corrupted.
The validation was initiated by an application other than STA and STA has not 
received sufficient information from the library to determine the result.

Data Quality Index (DQI)
The DQI is a measure of the amount of error correction left on the media, computed by 
STA based on the results of the validation. This value is expressed as a percentage, 
with a higher value indicating a better result. This attribute is blank in the following 
cases: 

■ The validation is a Basic Verify.

■ The validation resulted in an media validation Perm Status of True.

■ The validation resulted in an Invalid MIR error.

Recommendation
This attribute includes recommendations from STA for user action. Following are some 
messages you may see.

■ Media OK: continue using.

■ Media Degraded--Perform Qualification.

■ Permanent error encountered: Perform drive qualification.
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■ Not enough data to determine MV results. Rerun media validation.

■ Degraded Media: Rerun Media Validation Using a Different Drive.

■ Media Validation Interrupted.

Request Status Information
This attribute is usually blank but may contain information about issues that occurred 
with the validation request. It may explain the problem or suggest corrective action to 
take. Following are some messages you may see:

■ Drive Timeout; MDV manager cancel – Indicates STA requested the library to 
return the media to a media slot because the validation took more than nine hours 
to complete. This is usually the result of a library operational error. If the Read 
Percentage attribute for the validation exchange is less than 100 percent, then the 
validation did not complete. If this status recurs for the media, there is probably an 
issue with the media; if it recurs for the drive, there is probably an issue with the 
drive.

■ Library returned error code – Indicates an error code returned by the library while 
processing the validation request. The error code is also listed in the Library Error 
attribute.

Canceling Pending or In-Progress Validation Requests
You may need to cancel validation requests, especially Complete Verify or Complete 
Verify Plus validations, which may take many hours to complete. From STA, you can 
cancel STA-initiated pending or in-progress validation requests only. You can cancel 
these requests at any time, and you can cancel multiple requests at once. 

When a pending request is canceled, it is immediately removed from the validation 
request queue.

For in-progress validations, you can cancel Complete Verify or Complete Verify Plus 
tests only. When an in-progress request is canceled, the Request State changes to 
Stopped and STA sends a cancellation request to the drive. It may take several minutes 
for the drive to receive the request and unload and dismount the media. Once the 
media has been returned to a media slot, the validation request is removed from the 
validation request queue. You can later resume or repeat the validation. See "Resuming 
Interrupted "Complete Verify" Tests on T10000T2 Media" on page 8-24 for details. 

Resuming Interrupted "Complete Verify" Tests on T10000T2 Media

For T10000T2 media, Complete Verify and Complete Verify Plus validations that have 
been interrupted by host media requests or canceled manually can either be restarted 
from the beginning of tape (BOT) or resumed from the point where they left off. To 
resume a validation, the drive must be able to determine from the media RFID chip 
where the last validation left off. 

This option is available both for manually submitted requests and for requests 
initiated by an STA media validation policy. See "Submit Manual Media Validation 
Requests" on page 8-40 and "Create a Media Validation Policy" on page 8-54 for 
instructions.

Note: This option is available for T10000T2 media only; validations 
of T10000T1 media must always start at the beginning of tape (BOT).
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User Roles for Media Validation
Table 8–3 lists the user roles required for configuring STA media validation.

Table 8–4 lists the user roles required for managing the STA media validation request 
queue.

Table 8–5 lists the user roles required for managing STA media validation policies.

Note: Depending on the read/write operations that have occurred 
on the media since the most recent validation was interrupted, the 
validation may no longer be valid, and you may want to restart the 
operation from the beginning.

Table 8–3 Media Validation Configuration User Roles

User Role Media Validation Configuration Activity Screen

Viewer and above Display drives in the media validation drive pools. Tape System Hardware > 
Drives > Overview

Administrator only Display drives in the media validation drive pools.

Enable or disable media validation on STA.

Enable or disable drive calibration by selected the designated 
logical group of media.

Setup & Administration > 
Media Validation

Table 8–4 Media Validation Request Queue User Roles

User Role Media Validation Request Queue Activity Screen

Viewer and above Display, filter, and print a list of all media validation requests.

Export the media validation requests list to a spreadsheet or 
document.View detail for a selected media validation request.

Manually submit media validation requests one at a time.

Reorder pending media validation requests. 

Cancel selected pending or in-progress media validation 
requests.

Resume an interrupted validation of a T10000T2 media.

Tape System Activity > 
Media Validation 
Overview

Operator and above Manually submit multiple media validation requests.

Resume multiple interrupted validations of T10000T2 media.

Tape System Hardware > 
Media > Overview
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Media Validation Tasks
Media Validation Configuration Tasks

■ "Display Validation Drives for STA Media Validation" on page 8-26

■ "Enable or Disable Media Validation on STA" on page 8-30

■ "Enable Drive Calibration and Qualification" on page 8-35

■ "Disable Drive Calibration and Qualification" on page 8-37

Media Validation Request Management Tasks

■ "Display the Media Validation Request Queue" on page 8-38

■ "Submit Manual Media Validation Requests" on page 8-40

■ "Reorder Pending Media Validation Requests" on page 8-47

■ "Cancel Pending Media Validation Requests" on page 8-50

■ "Cancel In-Progress "Complete Verify" Validations" on page 8-52

Media Validation Policy Tasks

■ "Create a Media Validation Policy" on page 8-54

■ "Display the List of Media Validation Policies" on page 8-59

■ "Enable or Disable a Media Validation Policy" on page 8-60

■ "Copy a Media Validation Policy" on page 8-61

■ "Modify a Media Validation Policy" on page 8-63

■ "Delete a Media Validation Policy" on page 8-65

Display Validation Drives for STA Media Validation
Use this procedure to display information about validation drives that meet minimum 
requirements for STA media validation. See "Validation Drives That Can be Used by 
STA" on page 8-6 for details.

Table 8–5 Media Validation Policy User Roles

User Role Media Validation Policy Activity Screen

Operator and above Display and print the list of media validation policies. Setup & Administration > 
Media Validation

Administrator only Display the list of media validation policies.

Define a media validation policy.

Enable or disable a media validation policy.

Copy a media validation policy.

Modify a media validation policy as follows:

■ Rename a policy.

■ Change the policy criteria.

Delete a media validation policy.

Setup & Administration > 
Media Validation
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You can perform this procedure using either of the following methods:

■ "From the Media Validation Screen" on page 8-27

■ "From the Drives – Overview Screen" on page 8-28

From the Media Validation Screen

1. In the Navigation Bar, select Setup & Administration > Media Validation.

2. In the Media Validation Configuration section of the screen, the Number of Drives 
Reserved for Media Validation field displays the total number of drives assigned 
to the validation pools and that meet STA minimum requirements. Select the link.

You are taken to the Drives – Overview screen with a filter applied to show detail 
about these drives. 

Note: The validation drive pools are maintained only through 
SL Console. See the SL8500 User's Guide for detailed instructions on 
maintaining the pools.

Note: This procedure requires Administrator privileges.

Note: This method requires Operator or Administrator privileges.
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From the Drives – Overview Screen

1. In the Navigation Bar, select Tape System Hardware > Drives > Overview. 

Note: This method can be done by any user.
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The Drives – Overview screen appears, displaying all drives in your tape library 
system.

2. In the Table Toolbar, click Filter Data.

The Filter Data dialog box appears.

3. In the selection criteria menus, select MV Drive Capable and True. Then click 
Apply.
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The table is updated to display only drives that have been assigned to the 
validation drive pools and that meet minimum requirements for STA media 
validation.

Enable or Disable Media Validation on STA 
Use this procedure to review the current configuration of the media validation feature 
on STA and enable or disable it. By default, media validation is disabled when STA is 
installed. See "Enabling Media Validation" on page 8-9 and "Disabling Media 
Validation" on page 8-11 for details.

Note: If you disable media validation after it has already been 
enabled, STA does not accept new validation requests. However, any 
pending or in-progress requests remain in the validation queue and 
are processed to completion. If you want to cancel these requests, you 
can do so either before or after disabling media validation. See 
"Canceling Pending or In-Progress Validation Requests" on page 8-24 
for details. 
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1. In the Navigation Bar, select Setup & Administration > Media Validation.

The Media Validation screen appears.

2. In the Media Validation State field, select either Enable or Disable, as follows:

■ Enable – Enables STA media validation for all SL8500 libraries monitored by 
STA.

■ Disable – Disables STA media validation for all SL8500 libraries monitored by 
STA. You may want to temporarily disable media validation to perform library 
maintenance.

A confirmation dialog box appears.

3. Verify your selection, and click Yes to confirm. 

Note: This procedure requires Administrator privileges.
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The STA media validation state is updated according to your selection, and the 
new status is indicated on the screen. If media validation cannot be enabled at this 
time, the reason is indicated on the screen.

Create the Calibration Media Logical Group
Use this procedure to create the logical group of media you want to use for drive 
calibration and qualification. It is recommended that you set aside the media in this 
logical group exclusively for these purposes. See "Calibration Media Logical Group" 
on page 8-16 for details.

1. In the Navigation Bar, select Tape System Hardware > Media > Overview.

Note: This is an optional procedure that you need to use only if you 
plan to enable drive calibration and qualification. 

Note: Before using this procedure, you must create a manual logical 
group to be used exclusively for the calibration media. See "Choosing 
Calibration Media" on page 8-16 and "Create a Manual Logical Group" 
on page 7-11 for details.

Note: This procedure requires Operator or Administrator privileges.
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The Media – Overview screen appears, displaying all media in your tape library 
system.

2. In the Table Toolbar, click Filter Data.

The Filter Data dialog box appears.

3. In the selection criteria menus, enter the criteria specified in "Choosing Calibration 
Media" on page 8-16 Then click Apply.



Media Validation Tasks

8-34 StorageTek Tape Analytics User's Guide

The table is updated to display only media that meet the criteria.

4. Sort the results by the Media MB Avail Post attribute to locate media with at least 
two wraps of written data.

5. From the list, select the media you want to use for drive calibration and 
qualification. Then from the Table Toolbar, click Logical Groups.

The Logical Groups dialog box appears.

6. In the menu, select the logical group you have created for the calibration media, 
and click OK.

The media are added to the logical group. You can display them on the Logical 
Groups screen. See "List All Drives and Media Assigned to a Logical Group" on 
page 7-23 for instructions.
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Enable Drive Calibration and Qualification
Use this procedure to enable the optional drive calibration and qualification features 
on STA. These features are separate processes, but they are enabled and disabled 
together.

1. In the Navigation Bar, select Setup & Administration > Media Validation.

Note: It is highly recommended that you enable drive calibration 
and qualification if you are using STA media validation. See "Drive 
Calibration and Qualification" on page 8-11 for details on the benefits 
of these features.

Note: Before using this procedure, you must create the calibration 
media logical group. See "Create the Calibration Media Logical 
Group" on page 8-32 for instructions.

Note: This procedure requires Administrator privileges.



Media Validation Tasks

8-36 StorageTek Tape Analytics User's Guide

The Media Validation screen appears.

2. In the Use Media From the Following Manual Logical Group for Calibration 
menu, select the logical group that includes the media you want to use for 
calibration and qualification. The menu lists manual logical groups only.

3. Verify your selection, and click Save to confirm. 

Drive calibration and qualification are enabled, and STA begins calibrating drives 
in the media validation drive pool. 

The new status is indicated on the screen. If calibration is successful, the screen 
displays the message, "Drive and Media Pool Setup Success--calibration has been 
successful." If there are any issues, they are also indicated.
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Disable Drive Calibration and Qualification
Use this procedure to disable the optional drive calibration and qualification features 
on STA. These features are separate processes, but they are enabled and disabled 
together.

1. In the Navigation Bar, select Setup & Administration > Media Validation.

The Media Validation screen appears.

2. In the Use Media From the Following Manual Logical Group for Calibration 
menu, select None (Opt out of calibration; not recommended).

3. Verify your selection, and click Save to confirm. 

Note: It is highly recommended that you enable drive calibration 
and qualification if you are using STA media validation. See "Drive 
Calibration and Qualification" on page 8-11 for details on the benefits 
of these features.

Note: This procedure requires Administrator privileges.
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The Media Validation Configuration dialog box appears.

4. Review the selection and click Yes to confirm that want to disable drive calibration 
and qualification.

Drive calibration is disabled, and STA does not begin any new calibration or 
qualification operations. Any in-progress calibration or qualification activities are 
processed to completion. 

The new status is indicated on the screen. If there are any issues, they are also 
indicated.

Display the Media Validation Request Queue 
Use this procedure to display information about pending, in-progress, and completed 
media validation requests. See "Displaying the Status of Validation Requests" on 
page 8-22 for details.

1. From the Navigation Bar, select Tape System Activity > Media Validation 
Overview.

Note: You can use this procedure even if media validation is 
disabled on STA.

Note: This procedure can be done by any user.
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The Media Validation Overview screen appears, displaying all validation requests 
for which STA has received information.

2. By default, the requests are sorted in Priority Order, starting with "1," which 
means the oldest requests are at the top of the screen. To view more recent 
requests, you can either scroll to the bottom of the screen or select the Descending 
Sort arrow on the Priority Order column.

3. From this screen, you can manage the validation request queue by performing any 
of the following tasks:

■ "Submit Manual Media Validation Requests" on page 8-40

■ "Reorder Pending Media Validation Requests" on page 8-47

■ "Cancel Pending Media Validation Requests" on page 8-50

■ "Cancel In-Progress "Complete Verify" Validations" on page 8-52

In addition, you can perform most of the same tasks as for any List View table. See 
the following procedures for instructions:

■ To display a printable form of the table in a separate browser tab or window, 
see the STA Screen Basics Guide. "

■ To export the list of media validation requests, see the STA Screen Basics Guide."

■ To filter the table records, see "Use the Filter Data Dialog Box to Change a 
Table Filter" on page 4-10.

■ To reset a filter applied to the table, see "Clear the Current Filter" on page 4-14.

■ To refresh the table to display any new requests, see the STA Screen Basics 
Guide"
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■ To detach the table from the screen and display it in a separate window in the 
browser foreground, see the STA Screen Basics Guide."

Submit Manual Media Validation Requests
Use this procedure to manually submit media validation requests to the validation 
request queue. You can use this procedure as soon as media validation is enabled on 
STA. See "Submitting Manual Validation Requests" on page 8-17 for details.

You can use this procedure to start new validations or to resume validations that were 
previously interrupted. The option to resume interrupted validations is available only 
if all of the following conditions are true:

■ You have selected T10000T2 media for validation. (T10000T1 media validations 
always start at the beginning of tape.)

■ The validation test type is Complete Verify or Complete Verify Plus. (Other test 
types always start at the beginning of tape.)

■ The most recent validations for some or all of the selected media are not 100 
percent complete. (Media for which the most recent validation was complete are 
always validated from the beginning of tape.)

You can perform this procedure using either of the following methods:

■ "From the Media – Overview Screen" on page 8-40. Using this method, you can 
submit multiple requests at once.

■ "From the Media Validation Overview Screen" on page 8-44. Using this method, 
you can submit only one request at a time.

From the Media – Overview Screen

1. From the Navigation Bar, select Tape System Hardware > Media > Overview.

The Media – Overview screen appears, displaying all media in your tape library 
system.

Note: This method can be done by any user.
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2. Apply appropriate filter criteria to narrow down the list of media. In the following 
example, the screen is filtered to show media with "Library Complex Name Is 
SL8500_14, and Media Health Indicator Isn't USE." 

3. Select the media you want to validate. You can use multi-select to select as many 
media as you want. Then click Media Validation in the Table Toolbar.

The Validation Activities dialog box appears. A message indicates the total 
number of media eligible for validation, and the eligible media are listed. Media 
may be ineligible for any of the following reasons: 

■ The media are not T10000 type.

Note: You may want to use the STA-Media-MV predefined template 
because it filters the screen to show only T10000-type media in SL8500 
libraries. 
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■ The media are cleaning media.

■ The media are not in an SL8500 standalone library or complex.

■ Drives in the library or complex validation drive pool are not compatible with 
the media.

■ Drives in the validation drive pool do not meet minimum requirements for 
STA media validation.

4. In the Validation test to run menu, select the type of verification test you want to 
perform. See "Types of Verification Tests" on page 8-3 for details about the options.

If you select Complete Verify or Complete Verify Plus, you may also be required 
to select one of the following options. These options are available only if you are 
performing Complete Verify or Complete Verify Plus validations on T10000T2 
media, and the most recent validations for these media were interrupted prior to 
completion.

– Perform validations from beginning of tape – Indicates you want T10000T2 
media to be validated from the beginning of tape (BOT).

– Continue validations from last known validated data point – Indicates you 
want testing of T10000T2 media that has been partially validated to resume 
where the previous validation left off, if the drive can determine this from the 
media RFID chip. If the drive cannot determine where the previous validation 
left off, it will start from the beginning of tape.

See "Resuming Interrupted "Complete Verify" Tests on T10000T2 Media" on 
page 8-24 for details on these options.

5. In the Drive menu, select the drive you want to use for the validations. This option 
is available only if the media you have selected all reside within the same library 

Note: If none of the selected media are eligible for validation, the 
message, "No valid media selected for validation" is displayed.
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complex or standalone library. The menu lists the validation drives in the complex 
or standalone library. 

6. Click Create.

Note: You select just one drive, which means all media will be 
validated by the same drive, if possible. If the drive is not compatible 
with some media—for example, you have selected to perform a 
Complete Verify Plus, and some of the media are encrypted but the 
drive is not encryption capable—the validation requests will be added 
to the request queue, but they will remain in a pending state.

Consequently, it is recommended that you choose Autoselect, which 
causes STA to automatically select a compatible validation drive for 
each media.
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The validation requests are generated and added to the validation request queue. 

7. You can view the requests on the Media Validation Overview screen. See "Display 
the Media Validation Request Queue" on page 8-38 for instructions. 

By default, each request is assigned the next available Priority Order as it is 
generated. See "Reorder Pending Media Validation Requests" on page 8-47 for 
instructions on reprioritizing them.

From the Media Validation Overview Screen
Using this method, you can submit only one request at a time. To submit multiple 
requests at once, see "From the Media – Overview Screen" on page 8-40.



Media Validation Tasks

STA Media Validation 8-45

1. From the Navigation Bar, select Tape System Activity > Media Validation 
Overview.

The Media Validation Overview screen appears. By default, the screen is displayed 
in ascending Priority Order.

2. If you want to sort the screen by Volume Serial Number, select the Ascending Sort 
or Descending Sort arrow in that column.

3. Select the media you want to validate by selecting the request record. Then click 
Media Validation in the Table Toolbar.

Note: This method requires Operator or Administrator privileges.

Note: You can select only one record at a time, and you cannot select 
media with pending or in-progress validation requests. 
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The Resubmit Media dialog box appears. 

4. In the Validation test to run menu, select the type of verification test you want to 
perform. By default, this field is set to Basic Verify, but you can choose any 
appropriate verification test for this media. See "Types of Verification Tests" on 
page 8-3 for details about the options.

If you select Complete Verify or Complete Verify Plus, you may also be required 
to select one of the following options. These options are available only if you are 
performing a Complete Verify or Complete Verify Plus validation on a T10000T2 
media, and the most recent validation for the media was interrupted prior to 
completion.

– Perform validations from beginning of tape – Indicates you want T10000T2 
media to be validated from the beginning of tape (BOT).

– Continue validations from last known validated data point – Indicates you 
want testing of T10000T2 media that has been partially validated to resume 
where the previous validation left off, if the drive can determine this from the 
media RFID chip. If the drive cannot determine where the previous validation 
left off, it will start from the beginning of tape.

See "Resuming Interrupted "Complete Verify" Tests on T10000T2 Media" on 
page 8-24 for details on these options.

5. In the Drive menu, select the drive you want to use for the validation. The menu 
lists the validation drives in the complex or standalone library where the selected 
media currently resides.

6. Click OK.

Note: If the drive you select is not compatible with the media—for 
example, you have selected to perform a Complete Verify Plus, and 
the media is encrypted but the drive is not encryption capable—the 
validation request will be added to the request queue, but it will 
remain in a pending state.

Consequently, it is recommended that you choose Autoselect, which 
causes STA to automatically select a compatible validation drive for 
the media.
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The request is generated and added to the validation request queue. By default, it 
is assigned the next available Priority Order. See "Reorder Pending Media 
Validation Requests" on page 8-47 for instructions on reprioritizing the request.

Reorder Pending Media Validation Requests
Use this procedure to reprioritize pending requests in the media validation request 
queue. See "Media Validation Request Priorities" on page 8-22 for details.

1. From the Navigation Bar, select Tape System Activity > Media Validation 
Overview.

Note: You can use this procedure even if media validation is 
disabled on STA. For example, you may disable media validation for 
library maintenance and then reprioritize the pending requests left in 
the validation queue so they will be processed in a different order 
when media validation is reenabled.

Note: This procedure can be done by any user.
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The Media Validation Overview screen appears.

2. By default, the requests are sorted in ascending Priority Order. To see more recent 
requests, scroll to the bottom of the screen. Note the pending requests.

3. Click Reorder Pending Requests in the Table Toolbar.

The Reorder Pending Requests dialog box appears, with all pending requests 
listed in their current priority order. The requests are identified by the media 
Volume Serial Number and the current Priority Order.
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4. Select the requests you want to reprioritize, and click the appropriate arrows to 
move them in the list. This dialog box supports multi-select.

5. When the requests are in the order you want, click OK.

Arrows Description

Move the selected item(s) up or down, one place at a time.

Move the selected item(s) to the top or bottom of the list.
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The requests are reordered according to your selections, and the Priority Order 
values are updated on the Media Validation Overview screen to reflect the new 
order.

Cancel Pending Media Validation Requests
Use this procedure to cancel one or more pending media validation requests. Canceled 
pending requests are immediately removed from the validation request queue, and 
they cannot be resubmitted. See "Canceling Pending or In-Progress Validation 
Requests" on page 8-24 for details.

Note: You can use this procedure even if media validation is 
disabled on STA. For example, you may disable media validation for 
library maintenance and then cancel the pending requests left in the 
validation queue.

Note: This procedure can be done by any user.
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1. From the Navigation Bar, select Tape System Activity > Media Validation 
Overview.

The Media Validation Overview screen appears.

2. By default, the requests are sorted in ascending Priority Order. To see more recent 
requests, select the Descending Sort arrow on the Priority Order column. Note the 
pending requests.

3. Select the requests you want to cancel, and click Cancel in the Table Toolbar. You 
can select any number of pending requests.

Note: The Cancel button does not activate if you select any 
completed validations. 
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The Cancel dialog box appears, listing the volume serial numbers of the requests 
you have selected.

4. Verify the list of volume serial numbers and click Yes to confirm the cancellations.

The requests are canceled and removed from the Media Validation Overview 
screen.

Cancel In-Progress "Complete Verify" Validations
Use this procedure to cancel one or more in-progress Complete Verify or Complete 
Verify Plus media validations. You cannot cancel other in-progress validation types. 
See "Canceling Pending or In-Progress Validation Requests" on page 8-24 for details.

1. From the Navigation Bar, select Tape System Activity > Media Validation 
Overview.

Note: You can use this procedure even if media validation is 
disabled on STA. For example, you may disable media validation for 
library maintenance and then cancel the in-progress Complete Verify 
requests left in the validation queue.

Note: This procedure can be done by any user.
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The Media Validation Overview screen appears.

2. By default, the requests are sorted in ascending Priority Order. To see more recent 
requests, select the Descending Sort arrow on the Priority Order column. Note the 
in-progress validations. 

3. Select the validations you want to stop, and click Cancel in the Table Toolbar. You 
can select any number of in-progress Complete Verify or Complete Verify Plus 
validations.

Note: The Cancel button does not activate if you select any 
completed validations. 
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The Cancel dialog box appears, listing the volume serial numbers of the 
validations you have selected. 

4. Review the information displayed and click Yes to confirm the cancellation.

STA issues cancellation requests to the drives. This process may take several 
minutes to complete. Once each media has been dismounted from the drive and 
returned to a media slot, the associated validation request is removed from Media 
Validation Overview screen.

Create a Media Validation Policy
Use this procedure to create a media validation policy. Media validation policies allow 
you to automate media validation in your tape library system. See "Using Automated 
Media Validation" on page 8-20 for details.

The Media Validation Policies wizard leads you through the steps to define all 
information for the policy.

1. In the Navigation Bar, select Setup & Administration > Media Validation.

Note: This procedure requires Administrator privileges.
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The Media Validation Policies screen appears.

2. Click New Media Validation Policy.

The Media Validation Policies wizard appears.

3. Complete the first screen of the wizard as follows:

a. In the Policy Name field, type a unique name.

Your entry can include any alphanumeric characters up to 250 characters in 
length.

b. In the Policy Description field, enter an optional description of the policy.

c. Click Next.



Media Validation Tasks

8-56 StorageTek Tape Analytics User's Guide

4. On the second screen of the wizard, you indicate the group of media you want this 
policy to validate, as follows:

■ If you want this policy to validate media using a specific recording format, 
optionally within a specific library complex, select the Select media format 
and optional library complex option, and complete the associated fields as 
follows: 

– In the Media Format menu, select the media recording formats you want 
this policy to validate. You can select as many formats as you want. 
Options are: T10000A and T10000B, which are available for T10000T1 
media; T10000C and T10000D, which are available for T10000T2 media.

– In the Library Complex (Optional) menu, select the library complex you 
want this policy to validate. If you select None, the policy will validate the 
specified media types across all complexes. If you select a library complex, 
the policy will validate media within that complex only.

■ If you want this policy to validate media in a specific predefined logical group, 
select the Select logical group option. In the Logical Group menu, select the 
logical group. The menu lists all logical groups that have been defined.

Note: On any screen of the wizard, you can select the breadcrumb 
links at the top of the screen to go directly to the immediate-next 
screen or any screen you have already visited. 
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5. Click Next.

6. Complete the third screen of the wizard as follows:

a. In the Policy Criteria menu, select the criteria by which media will be selected 
for validation. See "Selection Criteria for Validation Policies" on page 8-21 for 
descriptions of the options.

Depending on your selection, you may need to complete additional fields, as 
follows:

– If you select Media Health = Action, Evaluate, or Monitor, you must also 
specify the successive Number of exchanges that must occur before a 
media is selected for validation. Options are 1–5. For example, if you 
specify "2", media are selected for validation as soon as two successive 
exchanges occur with the indicated media health.

– If you select Extended period of non-use, you must also specify the 
Number of days. Options are 365–1095 (one to three years). For example, 
if you specify "730", media are selected for validation if 730 days or more 
have passed since their last exchange.

b. In the Validation Test Type menu, select the type of verification test you want 
the drive to perform. See "Types of Verification Tests" on page 8-3 for 
descriptions of the options. 

If you select Complete Verify or Complete Verify Plus, you must also select 
one of the following options. 

Note: Be sure to select a logical group that includes T10000 media in 
SL8500 complexes or standalone libraries with validation drives, as 
STA does not verify this for you.



Media Validation Tasks

8-58 StorageTek Tape Analytics User's Guide

– Perform validations from beginning of tape – Indicates you want testing 
of all T10000T2 media to start from the beginning of tape (BOT), even if 
the media has already been partially validated.

– Continue validations from last known validated data point – Indicates you 
want testing of T10000T2 media that has been partially validated to 
resume where the previous validation left off, if the drive can determine 
this from the media RFID chip. If the drive cannot determine where the 
previous validation left off, it will start from the beginning of tape (BOT).

See "Resuming Interrupted "Complete Verify" Tests on T10000T2 Media" on 
page 8-24 for details on these options.

c. Click Next.

7. Complete the last screen of the wizard as follows:

a. Verify that all the policy information is correct. 

b. Complete the Enable Policy check box as follows:

– Select the check box to create the policy and enable it immediately.

– De-select the check box to create the policy but leave it disabled for now. 
You can enable it at a later time. See "Enable or Disable a Media Validation 
Policy" on page 8-60 for instructions.

c. Click Save.

Note: These options apply only to T10000T2 media; validations of 
T10000T1 media must always start at the beginning of tape (BOT).
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The policy is created. If the policy is enabled, then STA immediately begins 
evaluating media against the policy and generating media validation requests as 
appropriate. 

If the policy is disabled, then the policy is not evaluated for now. 

Display the List of Media Validation Policies 
Use this procedure to display information about all STA media validation policies.

1. In the Navigation Bar, select Setup & Administration > Media Validation.

The Media Validation Policies screen appears. The defined policies are listed in the 
Media Validation Policies section.

Note: These procedures require Operator or Administrator 
privileges.
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2. From this screen, you can manage validation policies by performing any of the 
following tasks:

■ "Enable or Disable a Media Validation Policy" on page 8-60

■ "Copy a Media Validation Policy" on page 8-61

■ "Modify a Media Validation Policy" on page 8-63

■ "Delete a Media Validation Policy" on page 8-65

In addition, you can perform most of the same tasks as for any List View table. See 
the following procedures for instructions:

■ To display a printable form of the table in a separate browser tab or window, 
see the STA Screen Basics Guide. "

■ To export the list of media validation policies, see the STA Screen Basics Guide."

■ To filter the table records, see "Use the Filter Data Dialog Box to Change a 
Table Filter" on page 4-10.

■ To reset a filter applied to the table, see "Clear the Current Filter" on page 4-14.

■ To refresh the table to display any new policies, see the STA Screen Basics 
Guide"

■ To detach the table from the screen and display it in a separate window in the 
browser foreground, see the STA Screen Basics Guide."

Enable or Disable a Media Validation Policy 
Use this procedure to enable or disable a selected media validation policy. STA uses 
only enabled policies to generate automated media validation requests. See "Using 
Automated Media Validation" on page 8-20 for details.

Disabling a policy does not affect any pending or in-progress media validation 
requests generated from the policy; they are processed to completion unless you cancel 
them. 
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1. In the Navigation Bar, select Setup & Administration > Media Validation.

The Media Validation Policies screen appears.

2. Select the policy you want to modify.

If the policy is currently enabled, the Disable Media Validation Policy icon in the 
Media Validation Policies toolbar becomes active. If the policy is currently 
disabled, the Enable Media Validation Policy icon becomes active.

3. Click Enable Media Validation Policy or Disable Media Validation Policy, as 
applicable. 

The policy is updated to according to your selection.

■ If you have enabled the policy, STA immediately begins evaluating media 
against the policy criteria and generating media validation requests, as 
appropriate.

■ If you have disabled the policy, STA no longer generates media validation 
requests for the policy. Any pending or in-progress media validation requests 
are processed to completion unless you cancel them. See "Canceling Pending 
or In-Progress Validation Requests" on page 8-24 for details.

Copy a Media Validation Policy 
Use this procedure to copy a selected media validation policy. To use a policy as the 
basis for a new one, you can copy an existing policy that is similar to one you want to 
create, and then modify the copy. See "Modify a Media Validation Policy" on page 8-63 
for instructions.

Note: This procedure requires Administrator privileges.
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1. In the Navigation Bar, select Setup & Administration > Media Validation.

The Media Validation screen appears.

2. Select the media validation policy you want to copy and click Copy Media 
Validation Policy.

The first screen of the Media Validation Policies wizard appears. The copy of the 
policy has all the same information as the original, except for the following:

■ The word "Copy" is added to the end of the Policy Name. 

■ The policy is enabled (the Enable Validation Policy check box is selected).

Note: This procedure requires Administrator privileges.
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3. In the Policy Name field, type the name you want to assign, and modify the 
Policy Description as necessary.

4. Use the Next button or the wizard breadcrumbs at the top of the dialog box to 
navigate to the screens with the information you want to modify. See "Create a 
Media Validation Policy" on page 8-54 for instructions on completing these 
screens.

5. Click Save when you have finished. 

The new policy is created, and the Media Validation Policies screen is updated 
with the information. 

In the following example, the "STA-T10000B non-used" policy was copied from the 
"STA-T10000A non-used" policy, and the policy criteria were modified for T10000B 
media.

Modify a Media Validation Policy 
Use this procedure to modify a selected media validation policy. You can change any 
attributes of a policy. 

Note: For a more direct method of enabling or disabling a policy, see 
"Enable or Disable a Media Validation Policy" on page 8-60. 
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1. In the Navigation Bar, select Setup & Administration > Media Validation.

The Media Validation Overview screen appears.

2. Select the media validation policy you want to modify and click Edit Media 
Validation Policy.

The first screen of the Media Validation Policies wizard appears, and the policy's 
current information is displayed.

Note: This procedure requires Administrator privileges.
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3. Use the Next button or the wizard breadcrumbs at the top of the dialog box to 
navigate to the screens with the information you want to modify. See "Create a 
Media Validation Policy" on page 8-54 for instructions on completing these 
screens.

4. Click Save when done. 

The policy is updated, and the changes are displayed on the Media Validation 
Policies screen.

Delete a Media Validation Policy
Use this procedure to delete a media validation policy. Deleting a policy does not 
delete media validation requests already generated from the policy; they are still 
available for viewing on the Media Validation Overview screen. Pending and 
in-progress requests generated from the policy are processed to completion. 

You do not need to disable a media validation policy before deleting it. 

1. In the Navigation Bar, select Setup & Administration > Media Validation.

Note: This procedure requires Administrator privileges.
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The Media Validation Policies screen appears.

2. Select the media validation policy you want to delete and click Delete Media 
Validation Policy.

The Delete dialog box appears. 

3. Verify your selection and Click Yes to confirm the deletion.

The policy is deleted and the list on the Media Validation Policies screen is 
updated. 
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9Understanding STA Analytics

This section provides concepts and tasks to help you interpret and use the data 
provided by STA. It assumes a basic understanding of STA features and functions. The 
following topics are included:

■ "STA Data Store" on page 9-1

■ "Dimmed Values on STA Screens" on page 9-2

■ "Removed Drives and Media" on page 9-2

■ "Removed Libraries" on page 9-8

■ ""Missing" Media" on page 9-8

■ "Duplicate Volume Serial Numbers" on page 9-9

■ "Mapping Host and STA Drive Identifiers" on page 9-10

STA Data Store
Following is a summary of the types of data included in the data store.

■ Library configuration model – A hierarchical view of the library and device 
configurations, properties, and statuses. To retrieve this information, STA initiates 
data collections through a series of SNMP requests sent to the library.

■ Exchange records – Detailed information about all drive and media exchanges, 
including cleaning activities. The library sends this data to STA through 
asynchronous SNMP traps.

■ Errors and events – Records of significant library errors and events. The library 
sends this data to STA through asynchronous SNMP traps.

See the STA Administration Guide for details on how STA receives this data from the 
libraries.

Data Retention
Data in the STA data store is retained indefinitely as a historical record and never 
deleted. However, data for removed resources — libraries, drives, and media — may 
be hidden from the STA data screens, depending on the Data Handling settings for 
your username. See "Removed Drives and Media" on page 9-2 and "Removed 
Libraries" on page 9-8 for details.

When STA first begins tracking a library, drive, or media, that resource is assigned an 
STA Start Tracking timestamp. If the resource is later removed from the library 
environment, an STA Stop Tracking timestamp is assigned. And then if the resource is 
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later re-added, the STA Start Tracking attribute reflects the original timestamp 
assigned when STA first began tracking the resource.

Dimmed Values on STA Screens
At times you may see data elements or resource identifiers that are dimmed—or grayed 
out—on the screen. While these data elements are usually active links leading to 
additional detail, the dimmed values are not links. Following are elements that may be 
dimmed:

■ Removed drives; see "Removed Drives and Media" on page 9-2 for details.

■ Removed media; see "Removed Drives and Media" on page 9-2 for details.

■ Exchanges not yet complete; once the exchange completes, the identifier is no 
longer dimmed, and the link is active. 

■ Alert Event types for which a corresponding element does not exist

Dimmed data elements may also be the result of an upgrade in progress. They 
gradually become active links as they are processed. 

Removed Drives and Media
By default, drives and media that have been removed from your tape library 
environment do not appear on the STA screens. The Data Handling preferences for 
your STA username allow you to turn on the display of removed drives, removed 
media, or both. Your selections take effect immediately, so depending on your needs, 
you can selectively show or hide removed drives and media throughout your login 
session. See the following sections for additional detail:

■ The STA Screen Basics Guide for instructions on changing these display settings.

■ "Identifying Removed Drives and Media" on page 9-2 for how removed drives and 
media are displayed on Overview screens.

■ "Impact of Removed Drives and Media on Calculated Totals" on page 9-3 for how 
calculated values are affected by these display settings.

Identifying Removed Drives and Media
If you choose to display removed drives or media, they are identified by the following 
attribute values on the Drives – Overview and Media – Overview screens:

■ The STA Stop Tracking date indicates the date and time when STA determined the 
drive or media no longer exists in any of the monitored libraries. Because there 
may be a lag between the time when a drive or media is removed and when the 
library notifies STA of the change, this value may differ slightly from the time 
when the item was physically removed.

■ The following attributes are set to "REMOVED":

– Library Complex Name

– Drive Library Name or Media Library Name

– Library Model

Note: Data for removed drives and media is never removed from the 
STA data store. See "Data Retention" on page 9-1 for details.
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– Partition Type

– Partition Name

– Physical Address

On activity screens, such as Exchanges – Overview and Media Validation 
Overview, the identifiers for removed drives and media are dimmed. See 
"Dimmed Values on STA Screens" on page 9-2 for details.

Impact of Removed Drives and Media on Calculated Totals
STA provides both current information about your tape library system and historical 
information collected over time. As drives and media are added and removed from 
your system, the total number of drives and media used for STA calculations also 
varies. These variations can result in differences between a historical summary value, 
such as a 30-day rolling average, and a corresponding value calculated using only 
currently displayed records.

■ Historical summaries—Rolling 30-day and daily summaries and averages are 
always calculated based on the number of drives and media in the system during 
the reporting period; therefore, they are not affected by the removed drives and 
media settings for your STA username. For example, a drive removed on day 10 of 
a 30-day period will be included in calculating summaries and averages for the 
first 10 days of the period, but not for the remaining 20 days. See "How Removed 
Drives and Media Affect Calculated Summaries" on page 9-3 for examples.

■ Currently Displayed Values—Totals and aggregations displayed on Overview and 
Analysis screens are calculated based on the number of records currently 
displayed; therefore, they are affected by the removed drives and media settings 
for your STA username. For example, if your removed drives display setting is 
turned off, removed drives will not be listed on the Drives – Overview screen, nor 
will they be included in the total record count on that screen, nor in the 
aggregations on the Drives – Analysis screen. See "How Removed Drives and 
Media Affect Overview and Analysis Screens" on page 9-4 for examples.

How Removed Drives and Media Affect Calculated Summaries
STA calculates a wide variety of daily and 30-day summary attributes, such as 
megabytes read, written, sent, and received; number of drive errors and cleans; and 
percent drive utilization. Drives and media are included in calculating these values up 
until the time they are removed from the tape library system. 

For example, removing a drive from a monitored library at 17:00 on April 15 has the 
following impacts to these summary values:

■ Daily summaries — The drive's activity for April 15 before 17:00 is included in the 
day's daily summaries. Because the drive has been removed, it will not have any 
activity to include in daily summaries for April 16 and beyond.

■ 30-day summaries — The drive's activity is included in all 30-day summaries for 
April 15 and the next 30 days, although the number of days' activity included will 
be reduced with each succeeding day, as the 30-day window moves forward. The 
30-day summary on May 15 will be the first one that does not include any activity 
for the drive.
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How Removed Drives and Media Affect Overview and Analysis Screens
This section provides examples illustrating the effects of your removed drives and 
media display settings on the following screens.

■ "Drives – Overview Screen" on page 9-4

■ "Drives – Analysis Screen" on page 9-5

■ "Exchanges and Cleaning Activities Screens" on page 9-6

■ "Alerts Overview Screen" on page 9-7

■ "Media Validation Overview Screen" on page 9-7

Drives – Overview Screen
Figure 9–1 shows the Drives – Overview screen after the "Show Removed Drives" 
setting has been selected. Removed drives are listed on the Drives – Overview screen, 
and the total number of records includes the removed drives. In this example, there are 
a total of 1,024 drives, and drive HU180214PT is highlighted to show that the Library 
Complex Name and Drive Library Name both indicate "REMOVED," and the date the 
drive was removed is displayed in the STA Stop Tracking column. 

Figure 9–1 Drives – Overview Screen, Show Removed Drives Setting "On"

Figure 9–2 and Figure 9–3 show the Drives – Overview screen after the "Show 
Removed Drives" setting has been deselected. Removed drives are not listed on the 
Drives – Overview screen, and the total number of records does not include removed 
drives. In Figure 9–2, there are a total of 936 drives, and the STA Stop Tracking date is 
blank for all drives displayed.

Note: While these examples focus on removed drives, the same 
principles and screen display characteristics apply to removed media 
and the "Show Removed Media" settings.



Removed Drives and Media

Understanding STA Analytics 9-5

Figure 9–2 Drives – Overview Screen, Show Removed Drives Setting "Off"

In Figure 9–3, the Drives – Overview screen has been filtered to show all drives with 
serial numbers starting with "HU180214." The removed drive HU180214PT does not 
appear in the list.

Figure 9–3 Drives – Overview Screen, Show Removed Drives Setting "Off" and Filtered for a Known 
Removed Drive

Drives – Analysis Screen
Figure 9–4 shows the Drives – Analysis screen after the "Show Removed Drives" 
setting has been selected. Aggregated data for removed drives are included under the 
headings Library Complex Name "REMOVED" and Drive Library Number "-1". The 
total number of drives is 1024, and the total removed drives is 88. 
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Figure 9–4 Drives – Analysis Screen, Show Removed Drives Setting "On"

Figure 9–4, shows the Drives – Analysis screen after the "Show Removed Drives" 
setting has been deselected. Aggregated data for removed drives are not included in 
the table. There are no headings for Library Complex Name "REMOVED" and Drive 
Library Name "-1". The total number of drives is 936.

Figure 9–5 Drives – Analysis Screen, Show Removed Drives Setting "Off"

Exchanges and Cleaning Activities Screens
The Exchanges Overview and Drive Cleanings Overview screens always show 
exchanges involving removed drives and media, regardless of your display settings. 
All screen attributes indicate the values at the time of the exchange.
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In Figure 9–6, the "Show Removed Drives" setting is selected. The "Drive Serial 
Number" entries for removed drives are active links to the Drives – Overview, Detail 
View screen.

Figure 9–6 Exchanges Overview Screen, Show Removed Drives Setting "On"

In Figure 9–7, the "Show Removed Drives" setting is deselected. The "Drive Serial 
Number" entries for removed drives are dimmed and are not active links.

Figure 9–7 Exchanges Overview Screen, Removed Drives Setting "Off"

Alerts Overview Screen
The Alerts Overview screen always shows alerts involving removed drives and media, 
regardless of your display settings. Alerts are always retained, even after the 
associated drive or media has been removed.

In the following example, your "Show Removed Drives" setting has been deselected. 
STA is monitoring LibraryABC, which has 60 drives, and two drives are responsible 
for all 27 drive alerts seen in the last 30-day period. The two drives are subsequently 
removed from the library. 

On the Drives – Overview screen, the value of the Drive Alerts (30 Days) attribute is 
"0" for all drives in LibraryABC. This is because the drives responsible for all 27 alerts 
have been removed from the library.

On the Alerts Overview screen filtered by "Alert Type Is Drive", 27 alerts are shown.

Media Validation Overview Screen
Pending STA media validation requests for removed drives and media remain in the 
validation request queue until you explicitly cancel them. See "Cancel Pending Media 
Validation Requests" on page 8-50 for details
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Removed Libraries
If you remove a library from the tape library environment, the following updates are 
made immediately to the STA screens:

■ STA no longer collects data from the library, and you can delete the STA server 
trap recipient from the library SNMP configuration.

■ The library is removed from the Libraries Overview and Complexes Overview 
screens.

■ The drives and media included in the library are removed from the Drives and 
Media screens.

■ All exchanges and cleaning activities that have occurred in the library are removed 
from Exchanges Overview and Drive Cleanings Overview screens.

■ All messages for the library and its drives and media are removed from the Drives 
Messages, Media Messages, and All Messages Overview screens.

■ Pending STA media validation requests remain in the validation request queue 
until you explicitly cancel them. See "Cancel Pending Media Validation Requests" 
on page 8-50 for details

See the STA Administration Guide for detailed instructions on removing a library 
connection.

Although the library data is removed from the user interface screens, it is never 
removed from the STA data store. If you later reestablish a connection to the library, all 
existing library data is made available on the STA screens again. See "Data Retention" 
on page 9-1,.

"Missing" Media
Media must be in a library storage cell or drive at the time of a data collection in order 
for it to be detected (see the STA Administration Guide for a description of the data 
collection process). Media in a "transient" location is not detected by a data collection. 
Transient locations are defined as any of the following:

■ Robot hand

■ Elevator — SL8500 libraries only

■ Pass-thru port (PTP) — SL8500 complexes only

■ Drive, at the time of library initialization; that is, the library was re-initialized 
while the media was left in the drive.

The STA application includes logic to handle these transient movements — media that 
has unexpectedly "disappeared" is kept on the STA screens in anticipation of detecting 
it again within a specific short period of time. STA removes the media from the screens 
only if it still does not detect the media within that time period. Although this is a rare 
occurrence, you are most likely to observe it in an SL8500 complex, where media 
cartridges are frequently transferred from one library to another through pass-thru 
ports (PTPs).

If you cannot find a volume serial number (VSN or volser) that you expect to see on 
the Media – Overview screen, it is recommended that you do the following:

1. Verify that you have the correct volser.

2. Filter the Media – Overview screen for that volser, to be sure it is really missing 
from the list.
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3. If the volser appears on the Media – Overview screen, check the Start Tracking, 
End Tracking, and Ejected Date attributes. The Ejected Date indicates the media 
was ejected through a cartridge access port (CAP) or access expansion module 
(AEM) (SL3000 libraries), or mailslot (SL150 libraries). 

4. If the media has an End Tracking date but no Ejected Date, the media may have 
been removed from the library environment by an unsupported method, such as 
through an open library door. On the Dashboard, check the Media Exception 
Report portlet. This report lists media that has left the library through a means 
other than a CAP, AEM, or mailslot.

5. Initiate a manual data collection on the library in which you expect the media to 
be located. See the STA Installation and Configuration Guide.

Duplicate Volume Serial Numbers
In the STA data store, media history is retained by volume serial number (VSN or 
volser). That is, all history for a particular piece of media is tied to its volser. For this 
reason, it is recommended that you avoid duplicate volume serial numbers (VSNs or 
volsers) in the tape environment monitored by STA. Volsers should be unique across 
all monitored libraries. Duplicate volsers will result in co-mingling of data for different 
pieces of media.

Volsers are considered to be duplicates only if the media with the same volser also 
have the same domain and type. Domain identifies the media format, and type 
identifies the version, as illustrated in the following examples:

■ LTO6 – "LTO" is the domain and "6" is the type.

■ T10000T1 – "T10000" is the domain and "T1" is the type.

The same volser used on two different LTO4 cartridges would be considered duplicate, 
while the same volser on an LTO4 cartridge and an LTO5 or T10000T1 cartridge would 
not. 

True duplicate volsers may occur for a variety of reasons, such as:

■ In the case of cleaning media, there are only 999 globally available volsers. Large 
tape environments with 1,000 or more cleaning media will of necessity have 
duplicate volsers.

■ Various tape management applications may allow duplicate volsers. This is the 
case only for libraries with SCSI host connections —SL150, SL500, and some 
SL3000 libraries. Libraries with Host Library Interface (HLI) host connections — 
SL8500 and some SL3000 libraries — use Oracle's StorageTek Enterprise Library 
Software (ELS) or Oracle's StorageTek Automated Cartridge System Library 
Software (ACSLS), which do not allow duplicates.

Following are situations in which there may appear to be duplicate volsers, but in fact 
there is just one media and the volser is unique:

■ A media is moved from one library to another.

■ A media is ejected from a library, taken off site for some time, and then re-entered 
into a library.

"Duplicate Detected" Flag on Exchanges
The Duplicate Detected flag appears on the Exchanges Overview screen and indicates 
that the volser involved in the exchange is a duplicate — the media has the same 
volser as another media of the same domain and type but with a different media serial 



Mapping Host and STA Drive Identifiers

9-10 StorageTek Tape Analytics User's Guide

number (MSN). If you find exchanges with this flag, you should investigate and 
determine whether to assign a different volser to one of the media, as the data for the 
two will be co-mingled. See the STA Data Reference Guide for additional information.

Mapping Host and STA Drive Identifiers
In STA, tape drives can be identified by drive serial number, World Wide Name 
(WWN), or physical location within the library. However STA does not know, and 
cannot display, the logical device ID that a host uses to identify a drive. If you want to 
map the host drive identifiers to the STA identifiers, you must do this manually.

Mainframe Identifiers
Mainframe hosts use a four-digit hexadecimal drive ID (0000–FFFF) to identify a drive. 
To map the host identifiers to the STA identifiers, you can use Oracle's Enterprise 
Library Software (ELS) Display DRives command on the mainframe host. The IDEntity 
option lists the mainframe hexadecimal ID, serial number, and WWN for each drive. 
Following is an example of the command output.

Example 9–1 Sample ELS Display DRives Command Output

DISPLAY DRIVES IDENTITY
.SLS4633I Display Drives Command 994
 DRIVE LOCATION MODEL WORLD WIDE NAME SERIAL NUMBER
 0A10 00:02:01:08 T9840D 50:01:04:F0:00:79:18:CD 5700GU008737
 0A11 00:02:01:09 T9840D 50:01:04:F0:00:79:18:C1 5700GU006080
 0B04 01:01:01:14 T9940B 50:01:04:F0:00:89:A7:74 479000025047
 0B05 01:02:01:14 T9940B 50:01:04:F0:00:89:A7:44 479000026693
 0B06 01:02:01:15 T1B35 50:01:04:F0:00:89:A7:68 572004003720
 0B07 01:02:01:11 T1B35 50:01:04:F0:00:89:A7:68 572004003720

You can issue this command from a variety of locations on the mainframe host, 
including the operator console or an SMCUUUI utility batch job. Optionally, you can 
save the output of the command to a.csv or .xml file. See the ELS Command, Control 
Statement, and Utility Reference manual for complete details about usage, syntax, and 
options.

Open Systems Identifiers
On open systems hosts (Linux and Solaris), logical device names for tape drives are 
found in the /dev/rmt directory. To map the host logical names to the STA identifiers, 
you can do a long listing (ls -l) of this directory. The command output shows the logical 
device name and the pointer to the raw device file, which includes the WWN for the 
drive. Following is an example of the output on Linux; the logical device name and 
WWN for each drive are highlighted in bold type.

Example 9–2 Sample Linux /dev/rmt Directory Listing

# ls -l /dev/rmt
lrwxrwxrwx 1 root root 86 Jan 31 16:31 /dev/rmt/0cbn 
->../../devices/pci@79,0/pci10de,377@a/pci1077,171@0/fp@0,0/tape@w500104f000b8050e
,0:cbn

Note: Only some drive types and firmware levels report MSNs; 
therefore, with some drive types, STA may not receive all the 
information necessary to detect duplicate volsers.
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lrwxrwxrwx 1 root root 86 Jan 31 16:31 /dev/rmt/1cbn 
->../../devices/pci@79,0/pci10de,377@a/pci1077,171@0/fp@0,0/tape@w500104f000b80511
,0:cbn
#
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10Using STA to Answer
Tape Environment Questions

This chapter combines elements and procedures described in the previous chapters to 
address common questions about tape storage operations and health. The methods 
described are not exhaustive, but are meant as examples of some ways you can use 
STA to answer these and similar questions, and in the process build your expertise in 
using the STA product.

Each procedure includes a "Referenced Tasks" section, which refers to the elements 
and procedures from previous chapters. 

The questions are organized into the following categories:

■ "Drive and Media Health Questions" on page 10-1

■ "Capacity and Resource Management Questions" on page 10-28

Drive and Media Health Questions 

Report the Media and Drive With the Most Errors
These procedures address the questions, "Which drives and media have had the most 
errors in the last 30 days? Are there any correlations between the two?" 

The following methods are described:

Question Task

Which drives and media have had the most errors in the 
last 30 days? Are there any correlations between the 
two?

"Report the Media and Drive With the Most Errors" on 
page 10-1

Which drives have had the most errors this week? Have 
their error rates gone up?

"Report Trends in Drive Error Rates" on page 10-8

Which drives have had significantly declining efficiency 
over time?

"Report Drive Efficiency Trends" on page 10-14

Is the drive that failed twice today the same one that 
caused problems two months ago?

"Report Trends in Drive Failures" on page 10-17

At 9:00 am today, one of our tape jobs experienced an 
error. Which drive and media were involved? Have they 
also experienced other errors?

"Report Information to Help Troubleshoot Tape Job 
Errors" on page 10-19

What critical errors were reported to STA last month? Is 
the total number trending up, down, or staying stable?

"Report Trends in Critical Errors" on page 10-23
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■ "Report Drives With the Most Errors", below

■ "Report Media With the Most Errors" on page 10-4

■ "Display Correlations Between the Two" on page 10-6

Referenced Tasks
■ "Apply a Template" on page 3-7

■ STA Screen Basics Guide

■ STA Screen Basics Guide

■ "Use the Filter Data Dialog Box to Change a Table Filter" on page 4-10

Report Drives With the Most Errors 
1. In the Navigation Bar, select Tape System Hardware > Drives > Overview. 

2. In the Templates menu, apply the "STA-Drive-Health" template. 

3. In the Drive Errors (30 Days) column, click the Sort Descending arrow. 
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The drives with the most errors are brought to the top of the list.

4. Use the following steps to add selected drives to the graphs.

Adding the drives to the graphs allows you to compare their attribute values 
against the system average. By default, graphs always include the system average.

a. In the List View table, select the drives you want to add to the graphs. 

b. Click Apply Selection on the Table Toolbar. 

The graphs are updated with the drive data. In the example below, one of the 
drives shows a high level of errors when compared with the system average. 
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Report Media With the Most Errors 
1. In the Navigation Bar, select Tape System Hardware > Media > Overview. 

2. In the Templates menu, apply the "STA-Media-Health" template. 
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3. In the Dismounts With Errors (30 Days) column, click the Sort Descending arrow. 

The media with the most errors are brought to the top of the list.

4. Use the following steps to add selected media to the graphs.

Adding the media to the graphs allows you to easily compare their attribute 
values against the system average. By default, graphs always include the system 
average.

a. In the List View table, select the media you want to add to the graphs. 

b. Click Apply Selection on the Table Toolbar. 
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The graphs are updated with the media data. In the example below, both 
media show high numbers of errors when compared with the system average. 

Display Correlations Between the Two
This procedure helps you to determine whether there are correlations between the 
drives and media with most errors. The Exchanges Overview screen is the most useful 
for this activity because each exchange involves exactly one drive and one piece of 
media. 

1. In the Navigation Bar, select Tape System Activity > Exchanges Overview. 

2. Use the following steps to display only those exchanges that took place within the 
last 30 days and that involve the drive with the most errors.
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The drive with the most errors was identified in "Report Drives With the Most 
Errors" on page 10-2. 

a. Click Filter Data.

b. In the Filter Matching field, select Match ALL entered criteria. 

c. Add the following filter criteria:

* Exchange Start (Dates) is after a date 30 days ago 

* Drive Serial Number is the serial number of the drive with the most 
errors

d. Click Apply. 

The table is updated according to your selection criteria. 

3. To focus on the media involved in the errors, sort the table by a related column. 

Suggested columns are Media Exchange Status, Exchange FSC, or Media Health 
Indicator. 

4. Visually scan the Volume Serial Number field to see if there are any correlations 
between drive errors and specific media. 
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5. If you do find a potential correlation, use the following steps to filter the data 
further to display just the exchanges that involve both the faulty drive and the 
suspect media. 

a. Click Filter Data.

The selection criteria already in effect are displayed in the Filter Data dialog 
box.

b. Leave the current criteria rows as is, and add the following row:

* Volume Serial Number is the volser of the suspect media identified in 
Step 4. 

c. Click Apply. 

The table is updated according to your selection criteria. 

Report Trends in Drive Error Rates
This procedure addresses the questions, "Which drives have had the most errors this 
week? Have their error rates gone up?"

Although STA screens show 30 days worth of data by default, you can use filter and 
selection criteria to narrow down to just the current week. The following methods are 
described:

■ "Using the Drives – Overview Screen", below

■ "Using the Exchanges Overview Screen" on page 10-11 

■ "Using the Drives – Messages Screen" on page 10-13

Referenced Tasks
■ "Apply a Template" on page 3-7

■ STA Screen Basics Guide

■ STA Screen Basics Guide
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■ STA Screen Basics Guide

■ STA Screen Basics Guide

■ STA Screen Basics Guide

■ "Use the Filter Data Dialog Box to Change a Table Filter" on page 4-10

Using the Drives – Overview Screen 
1. In the Navigation Bar, select Tape System Hardware > Drives > Overview. 

2. In the Templates menu, apply the "STA-Drive-Health" template. 

running 30-day sum of drive errors is shown in the table and one of the graph 
panes. 

3. In the Drive Errors (30 Days) column, click the Sort Descending arrow. 

The drives with the most errors are brought to the top of the list.

4. Use the following steps to add the top five drives to the screen graphs.
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a. In the List View table, select the top five drives. 

b. Click Apply Selection on the List View Toolbar. 

All graphs, including Drive Errors, are updated to show these drives over a 
30-day period. 

5. Use the following steps to narrow down the date range on the Drive Errors graph 
pane. 

a. Click Choose Date Range on the Drive Errors Graph Pane Toolbar. 
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b. Complete the Choose Date Range dialog box as follows:

* Select Time Range. 

* In the Starting Date and Ending Date fields, enter the start and end dates 
of the current week. 

c. Click OK. 

The graph is updated according to your selection criteria. The variations in the 
graph lines show increases and decreases in error rates during the week.

Using the Exchanges Overview Screen
1. In the Navigation Bar, select Tape System Activity > Exchanges Overview. 



Drive and Media Health Questions

10-12 StorageTek Tape Analytics User's Guide

2. In the Templates menu, apply the "STA-Exchange-Alerts-Errors" template. 

This template applies a filter to show only exchanges with errors. 

3. In the Drive Serial Number column, click the Sort Ascending or Sort Descending 
arrow. 

Errors are grouped by drive, allowing you to bring focus to faulty drives. 

4. To focus on specific errors, use the following tasks to move columns around and 
remove empty columns, as applicable. 

– STA Screen Basics Guide

– STA Screen Basics Guide

5. Use the following steps to display just this week's data.

a. Click Filter Data.

b. In the Filter Matching field, select Match ALL entered criteria. 

c. Add the following selection criteria:

* Exchange Start (No. Days) is less than 7 days ago
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d. Click Apply. 

The table is updated according to your selection criteria. 

Using the Drives – Messages Screen 
Since most messages do not contain a specific drive reference, the information from 
this method is not as comprehensive as from the others. However, this method does 
provide a quick snapshot of drives whose health state has changed. 

1. In the Navigation Bar, select Tape System Hardware > Drives > Messages. 

2. In the Device Serial Number column, click the Sort Ascending or Sort 
Descending arrow. 

Errors and statuses are grouped by drive. 
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3. Visually scan the list for changes in the device state of individual drives. 

Report Drive Efficiency Trends
This procedure addresses the question, "Which drives have had significantly declining 
efficiency over time?"

STA records and displays many measures of data transfer rate efficiency, including 
read, write, and read/write combined rates. STA collects the rates per exchange and 
then summarizes them into daily and 30-day time periods. In addition, some drive 
types also provide their own efficiency calculations. Following are some efficiency 
attributes reported by STA. 

Referenced Tasks
■ "Apply a Template" on page 3-7

■ STA Screen Basics Guide

■ STA Screen Basics Guide

■ STA Screen Basics Guide

1. In the Navigation Bar, select Tape System Hardware > Drives > Overview. 

2. In the Templates menu, apply the "STA-Drive-Performance-30-Days" template. 
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This template includes attributes related to drive performance. It does not include 
any graph panes. 

3. Use the following steps to add graphs of interest to the Graph Area. 

By graphing selected attributes, you can see increases or decreases in efficiency 
over time, and compare individual drive efficiency numbers to the system 
average. 

a. Click Restore Pane at the top of the screen to display the Graphics Area. 

The Graphics Area is blank. 

b. Click Add Graph in the Graphics Area Toolbar. 

A new graph pane, with the attribute MB Read, is added to the Graphics Area 
display. 

c. Click Change Graphed Attribute in the Graph Pane Toolbar, and select an 
attribute of interest. 

Note: Some measures are null or zero if STA has not been monitoring 
a drive long enough to gather data and calculate accurate numeric 
values. 
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d. Repeat the previous two steps for any additional attributes you want to graph. 

The graphs are updated to display the system average for the attributes you 
have selected. The examples below show Mount Read MB/sec, Mount Write 
MB/sec, and Mount R/W MB/sec. 

4. Use the following steps to add the top five drives to the graphs.

Adding the drives to the graphs allows you to compare their attribute values 
against the system average. By default, graphs always include the system average.

a. In the List View table, select the top five drives. 

b. Click Apply Selection on the Table Toolbar. 
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The drives are added to all the screen graphs. 

Report Trends in Drive Failures
This procedure addresses the question, "Is the drive that failed twice today the same 
one that caused problems two months ago?"

If the drive errors appear in the Messages or Exchanges tables, you can filter the tables 
by drive ID and then look at current and historical data. The Exchanges table, in 
particular, allows you to select data for a specific time period. 

Referenced Tasks
■ STA Screen Basics Guide

■ "Use the Filter Data Dialog Box to Change a Table Filter" on page 4-10

1. In the Navigation Bar, select Tape System Activity > Exchanges Overview.
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2. To view more of the table data at once, click the Collapse Pane icon in the middle 
of the screen to expand the table vertically. 

3. Use the following steps to narrow down the data to exchanges that occurred 
between four and five months ago involving the suspect drive. 

a. Click Filter Data.

b. In the Filter Matching field, select Match ALL entered criteria. 

c. Add the following selection criteria:

* Exchange Start (Dates) is after a date three months ago

* Exchange End (Dates) is before a date two months ago

* Drive Serial Number is the serial number of the drive with errors

d. Click Apply. 

Note: If your site has exchanges that last more than a day, you may 
need to adjust your date settings to encompass complete exchanges 
involving the drive in question. 
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The table is updated according to your selection criteria. 

4. Visually scan the data to determine whether the drive experienced exchanges with 
errors during this period. 

Report Information to Help Troubleshoot Tape Job Errors
This procedure addresses the questions, "At 9:00 am today, one of our tape jobs 
experienced an error. Which drive and media were involved? Have they also 
experienced other errors?"

The following methods are described:

■ "Using the Exchanges Overview Screen"

■ "Using the All Messages – Overview Screen"

Referenced Tasks
■ STA Screen Basics Guide

■ "Use the Filter Data Dialog Box to Change a Table Filter" on page 4-10

■ STA Screen Basics Guide
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Using the Exchanges Overview Screen
In cases where each "job" is an independent exchange (that is, mount, read/write data, 
dismount), you can use this method to access information about tape job failures. 

1. In the Navigation Bar, select Tape System Activity > Exchanges Overview. 

2. So you can view more of the table data at once, click the Collapse Pane icon in the 
middle of the screen to expand the table vertically. 

3. Use the following steps to narrow down the data to just exchanges that 
experienced errors. 

a. Click Filter Data.

b. In the Filter Matching field, select Match ANY entered criteria. 

c. Add the following selection criteria:

* Drive Exchange Status contains "ERROR" 

* Media Exchange Status contains "ERROR"

d. Click Apply. 

Note: Entries are not case-sensitive, so "ERROR" will match "error" 
or "Error". 



Drive and Media Health Questions

Using STA to Answer Tape Environment Questions 10-21

The table is updated according to your selection criteria. 

4. Scroll to exchanges that occurred around 9:00 am today, and review the 
information in the Drive Exchange Status, Media Exchange Status, and Exchange 
FSC columns for details about the errors.

By default, the rows of the table are sorted by Exchange Start time. 

Note: The Drive Health Indicator and Media Health Indicator 
columns may indicate Use even after an error. This is because the 
values of these attributes are aggregated over time. The specific values 
depend on the frequency and severity of errors, and whether there 
have been subsequent exchanges with no problems. Recent exchanges 
with no problems move the aggregated value toward a "Use" status.
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5. Optionally, to display detail about a drive or media involved in an error, select the 
text link in either the Drive Serial Number or Volume Serial Number column. 

Using the All Messages – Overview Screen
In cases where you know the time of a job failure, you can use this method to check for 
related STA error messages. 

1. In the Navigation Bar, select Tape System Activity > All Messages > Overview. 

2. Use the following steps to narrow down the data to just traps that involved errors. 

a. Click Filter Data.

* Severity is error

b. Click Apply. 
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The table is updated according to your selection criteria. 

3. Scroll to traps that were received around 9:00 am today, and review the entries. 

By default, the rows of the table are sorted by Date SNMP trap recv'd time. 

Report Trends in Critical Errors
This procedure addresses the questions, "What critical errors were reported to STA last 
month? Is the total number trending up, down, or staying stable?"

STA reports instances of a wide variety of error types. This procedure provides 
instructions for exporting the error data to a spreadsheet application, which can then 
be used to summarize error trends over time. 

The following methods are described:

■ "Using the All Messages – Overview Screen"

■ "Using the Exchanges Overview Screen" on page 10-25

Referenced Tasks
■ "Use the Filter Data Dialog Box to Change a Table Filter" on page 4-10

■ STA Screen Basics Guide

■ STA Screen Basics Guide

■ STA Screen Basics Guide
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■ STA Screen Basics Guide

■ "Apply a Template" on page 3-7

■ STA Screen Basics Guide

■ STA Screen Basics Guide

■ STA Screen Basics Guide

Using the All Messages – Overview Screen
1. In the Navigation Bar, select Tape System Activity > All Messages > Overview. 

2. Use the following steps to narrow down the data to traps sent within the last 
month. 

a. Click Filter Data.

b. In the Filter Matching field, select Match ALL entered criteria. 

c. Add the following selection criteria:

* Date SNMP trap recv'd (Dates) is after a date one month ago

* Severity is error

d. Click Apply. 
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The table is updated according to your selection criteria. The Severity and Text 
columns are adjacent, allowing you to review them together. You may need to 
scroll to the right to see the columns. 

3. You can use any of the following methods to see the full error message text. 

– Move the mouse over the bottom border of the cell; the full text is displayed in 
a tooltip. 

– Widen the Text column. 

– Export the table to a file. Then use a compatible spreadsheet application to 
open the file and format the error message text so it wraps within the table 
column.

Using the Exchanges Overview Screen 
Drive and media errors are reported as a result of exchanges. Therefore, it is more 
efficient to look for errors on the Exchanges Overview screen, where drive and media 
data is consolidated, rather than on the Drives or Media screens.
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1. In the Navigation Bar, select Tape System Activity > Exchanges Overview. 

2. In the Templates menu, apply the "STA-Exchanges-Alerts-All" template 
(alternatively, apply the "STA-Exchanges-Alerts-Errors" template for a smaller 
subset). 

This template includes several columns that indicate different types of errors. The 
exchanges are sorted in reverse chronological order, — most recent exchanges 
first — allowing you to see at a glance which error types have predominated at 
your site over the last month. 

3. If there are enough errors to indicate possible trends, use the following steps to 
add graphs of interest to the Graph Area. 

Attributes that may correlate to errors include Write Efficiency, Read Margin, and 
R/W Rate MB/sec.

a. Click the Restore Pane icon at the top of the screen to display the Graphics 
Area. 
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The Graphics Area is blank. 

b. Click the Add Graph icon in the Graphics Area Toolbar. 

A new graph pane, with the attribute Mount Read MB, is added to the 
Graphics Area display. 

c. Click the Change Graphed Attribute icon in the Graph Pane Toolbar, and 
select an attribute you want to graph. 

d. Repeat the previous two steps for any additional attributes you want to graph. 

The graphs are updated to display the system average for the attributes you 
have selected. The samples below show Write Efficiency, Read Margin, and 
R/W Rate MB/sec. 



Capacity and Resource Management Questions

10-28 StorageTek Tape Analytics User's Guide

4. To calculate total errors by error type, you must use an external spreadsheet 
application. Use the following steps to export the data displayed in the table to an 
HTML-based Excel-compatible file. 

a. Click the Export icon in the Table Toolbar and select Exchange.xls.

b. Save the file to a location on your local computer. 

c. Use a compatible spreadsheet application to open the file and summarize the 
data. 

Capacity and Resource Management Questions

Question Task

How many libraries, drives, or media are in my tape 
system environment?

"Report Total Libraries, Drives, or Media" on page 10-29

How many drives or media of a particular type are in 
my tape system environment?

"Report Drive and Media Types" on page 10-31

Which are the top three drives in terms of utilization? "Report Drives With the Highest Utilization" on 
page 10-33

Which types of media are in short supply? Do I have an 
oversupply of any type?

"Report Shortages or Surpluses of Media" on page 10-36

Am I likely to need more media, drives, or storage cells 
next year? If so, how many?

"Project Future Media, Drive, or Storage Cell 
Requirements" on page 10-40

Which types of drives or media are used the most in my 
tape system?

"Report Resources With the Highest Utilization" on 
page 10-45

Which library in my tape environment is the busiest? 
Which is the least busy?

"Report Library Relative Activity Levels" on page 10-51
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Report Total Libraries, Drives, or Media
These procedures address the question, "How many libraries, drives, or media are in 
my tape system environment?"

The following methods are described:

■ "Using the Dashboard"

■ "Using Overview Screens" on page 10-30

■ "Using Analysis Screens" on page 10-31

Related Topics
■ STA Screen Basics Guide

■ "Clear the Current Filter" on page 4-14

Using the Dashboard
1. In the Navigation Bar, select Home > Dashboard.

2. If the number of resources (libraries, drives, or media) is small, you can do a quick 
visual count just by reading the graph. 

In the sample below, you can estimate from the graph that there are ten libraries 
total: (8 +2). 

3. If the number of resources is high, you can move the mouse over each slice in the 
pie chart to display tooltips of descriptive information, including totals. 

In the sample below, the pie chart tooltips yield the count: 13 + 9 +23 =45 total.

Which media are over 90 percent full? How do I 
generate a list that can be used to create a script to eject 
them from the library?

"Report Media Approaching Capacity" on page 10-54

Have all my drives been upgraded to the latest 
firmware?

"Report Drive Firmware Levels" on page 10-56

Question Task
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Using Overview Screens 
In Overview screens, the total number of records displayed is listed at the lower-right 
corner of the List View table. As long as there are no filters applied, this number is the 
total of that type of resource (libraries, drives, or media) monitored by STA. 

1. In the Navigation Bar, select an Overview screen. 

2. Check the Applied Filter area of the table, and verify that there is no filter in effect. 
If one has been applied, see "Clear the Current Filter" on page 4-14 for instructions 
on clearing it. 

In the sample below, no filter has been applied, and the Drives – Overview screen 
indicates there are 232 total drives monitored by STA. 
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Using Analysis Screens 
Analysis screens aggregate data according to a variety of criteria. 

1. In the Navigation Bar, select an Analysis screen. 

2. Check the Applied Filter area of the table, and verify that there is no filter in effect. 
If one has been applied, see "Clear the Current Filter" on page 4-14 for instructions 
on clearing it. 

In the sample Drives – Analysis screen below, no filter has been applied, and the 
pivot table breaks down the 232 total drives by library complex and state. 

Report Drive and Media Types
These procedures address the question, "How many drives or media of a particular 
type are in my tape system environment?" 

The following methods are described:

■ "Using the Dashboard"

■ "Using Analysis Screens" on page 10-32

Referenced Tasks
■ STA Screen Basics Guide

■ STA Screen Basics Guide

Using the Dashboard
1. In the Navigation Bar, select Dashboard.
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2. Move the mouse over the relevant section of a pie or bar chart to display a tooltip 
with descriptive information and totals. 

In the following sample, moving the mouse over the T10000C bar reveals there are 
four T10000C drives with an "Evaluate" health. 

3. If you select a section of a bar or pie chart, you are taken to the associated 
Overview screen, filtered for that type of drive or media. 

In the sample below, the Drives – Overview screen is displayed, filtered to display 
only T10000C drives with an "Evaluate" health. 

Using Analysis Screens 
This method is especially useful if you want data aggregated by a series of criteria, 
such as by library and media state. The pivot table on Analysis screens presents this 
information in a concise format. 
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1. In the Navigation Bar, select an Analysis screen (Drives – Analysis or Media – 
Analysis).

In the sample Media – Analysis screen below, subtotals and totals are provided at 
the bottom of each column and to the right of each row. 

Report Drives With the Highest Utilization 
These procedures address the question, "Which are the top three drives in terms of 
utilization?" 

Utilization can be defined in several ways, including lifetime hours in use, amount of 
data passed, and total number of mounts. The following methods are described:

■ "Using Total Time in Motion"

■ "Using Time in Use Over the Last 30 Days" on page 10-35 

Referenced Tasks
■ "Apply a Template" on page 3-7

■ STA Screen Basics Guide
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Using Total Time in Motion

1. In the Navigation Bar, select Tape System Hardware > Drives > Overview. 

2. In the Templates menu, apply the "STA-Drive-Utilization" template. 

3. In the Drive Lifetime Hours in Motion column, click the Sort Descending arrow. 

The top three drives in terms of time in motion are displayed at the top of the list.

Note: This information is provided only by StorageTek enterprise 
drives. 
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Using Time in Use Over the Last 30 Days
1. In the Navigation Bar, select Tape System Hardware > Drives > Overview. 

2. In the Templates menu, apply the "STA-Drive-Utilization" template. 

3. In the % Drive Utilization (30 Days) column, click the Sort Descending arrow. 
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The top three drives in terms of percentage time in use are displayed at the top of 
the list.

Report Shortages or Surpluses of Media
This procedure addresses the questions, "Which type of media am I the shortest on? 
Do I have an oversupply of any type?" 

The definition of media available for writing varies by site. For example, a site that does 
not reuse media may simply compare total versus available capacity for each type of 
media; another site that does reuse media may look at some media life measure instead. 
Both of these measures, and others, are available within STA. This procedure uses total 
versus available capacity. 

Referenced Tasks
■ "Apply a Template" on page 3-7

■ "Use the Filter Data Dialog Box to Change a Table Filter" on page 4-10

■ STA Screen Basics Guide

■ STA Screen Basics Guide

■ STA Screen Basics Guide

1. In the Navigation Bar, select Tape System Hardware > Media > Overview. 
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2. In the Templates menu, select the "STA-Media-Utilization" template. 

This template includes all the attributes related to utilization, such as Media 
Dismounts (30 Days), MB Read (30 Days), and Media Life Indicator. 

Note: Depending on the number of templates available to your STA 
username, you may need to scroll down in the menu to see the 
selection.
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3. Use the following steps to eliminate any media for which capacity or availability 
information is not available. 

The longer STA monitors the libraries, the more exchange data it receives, and the 
lower the overall uncertainty level.

a. Click Filter Data.

b. Add the following selection criteria:

* Media MB Capacity is greater than 0 

c. Click Apply. 

4. Note the number of records eliminated, since it reflects the level of uncertainty. 

In the sample below, the number of records goes from 647 to 431, indicating a high 
uncertainty level. This library has been monitored for only a few days. 

5. For the media in the resulting list, use the following steps to display the capacity 
and space available for each piece of media displayed. 

a. Select View > Sort > Advanced.

b. Complete the Advanced Sort dialog box as follows:

* In the Sort By menu, select Media Type.
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* In the first Then By menu, select Media MB Avail Pre. 

* In the next Then By menu, select Media MB Avail Post. 

c. Click OK. 

The table is sorted according to your criteria. 

6. To better view the capacity data together on the screen, use the following steps to 
reorder the table columns. 

a. Select View > Reorder Columns.

b. In the Reorder Columns dialog box, arrange the following attributes so they 
are listed together.

* Media Type

* Media MB Capacity

* Media MB Avail Pre 

* Media MB Avail Post

c. Click OK. 

Note: LTO drives report the Media MB Avail Pre attribute, and 
StorageTek enterprise drives report Media MB Avail Post. Including 
both attributes in the sort criteria ensures you will include all media 
types. 
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The table columns are reordered according to your criteria. 

7. To calculate the total capacity and space available for each media type, you must 
use an external spreadsheet application. Use the following steps to export the data 
displayed in the table to an HTML-based Excel-compatible file. 

a. Click the Export icon in the Table Toolbar and select the Media.xls option. 

b. Save the file to a location on your local computer. 

8. Use a compatible spreadsheet application to open the file and summarize the data. 
For example, you may want to calculate totals, percentages used, or averages by 
media type. 

Project Future Media, Drive, or Storage Cell Requirements
These procedures address the questions, "Am I likely to need more media, drives, or 
storage cells next year? If so, how many?"

The criteria for determining whether drives or media need replacement varies by site. 

For drives, STA tracks many applicable criteria — in particular, several drive lifetime 
measures, such as Drive Lifetime Loads, Drive Lifetime Meters, and Drive Lifetime 
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Power Hours. See "Report Percent Drive Utilization", below, for one example. 

For media, STA provides data that is useful in a variety of scenarios, including the 
following: 

■ Your site is migrating off one type of media and you need to replace it with 
another; see "Report Data Related to Media Migration" on page 10-43 for details. 

■ Existing media are ageing or showing errors beyond your site-defined reasonable 
threshold; see "Report Data Related to Media Ageing" on page 10-44 for details. 

■ Existing media are filling up; see "Report Shortages or Surpluses of Media" on 
page 10-36 for details. 

Referenced Tasks
■ "Apply a Template" on page 3-7

■ STA Screen Basics Guide

■ "Use the Filter Data Dialog Box to Change a Table Filter" on page 4-10

■ STA Screen Basics Guide

■ "Create a Template" on page 3-12

Report Percent Drive Utilization 
1. In the Navigation Bar, select Tape System Hardware > Drives > Overview. 

2. In the Templates menu, select the "STA-Drive-Utilization" template. 
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The first graph on the screen is % Drive Utilization, which displays the system 
average of percent drive utilization over time. This provides a high-level measure 
of activity for all drives in your environment.

3. To differentiate and compare the activity levels of individual drives, and to 
identify potential hot spots, you can sort or filter the drives in the table by various 
criteria, such as drive type or library. 

In the sample below, the table is sorted in descending order of % Drive Utilization 
(30 Days) — highest percentage utilization first. 

4. Use the following steps to add the top five drives to the screen graphs.

Adding the drives to the graphs allows you to compare their attribute values 
against the system average.

a. In the List View table, select the top five drives. 

b. Click the Apply Selection icon on the List View Toolbar. 
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The drives are added to the graphs. 

Report Data Related to Media Migration
1. In the Navigation Bar, select Home > Dashboard. 
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The screen provides a high-level view of the number of media, aggregated by 
type.

2. Move the mouse over the Library Media Cells graph to display detail for each type 
of media stored in the library system. 

The sample below illustrates a site planning to migrate off older generation LTO2 
and LTO3 tapes. Moving the mouse over these two sections of the pie chart reveals 
there are a total of 27 LTO2 and 64 LTO3 media that must be replaced.

3. Select a section of the pie chart to go to the Media – Overview screen filtered for 
that type of media. 

The sample below shows the screen filtered for LTO2 media. On this screen, you 
can organize the media records by remaining capacity, physical location, or other 
attributes pertinent to the migration process.

4. Alternative approaches for gathering this information are to use either of the 
following screens, which can summarize, filter, or aggregate media totals by type. 

– Media – Overview 

– Media – Analysis 

Report Data Related to Media Ageing
1. In the Navigation bar, select Tape System Hardware > Media > Overview. 
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2. In the Templates menu, select "STA-Media-Expired". 

This template includes a filter and attributes related to media that have expired 
and should be retired from service. 

Report Resources With the Highest Utilization
This procedure addresses the question, "Which types of drives or media are used the 
most in my tape system?" 
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The drives and media that make up the majority of the system are not necessarily 
subject to the most use. Utilization is affected by your client configuration and the 
types of drives and media requested by these clients. This procedure addresses some 
of the most common ways of defining most used. 

The following methods are described:

■ "Report Drive Utilization"

■ "Report Media Utilization" on page 10-48 

Referenced Tasks
■ "Apply a Template" on page 3-7

■ "Use the Filter Data Dialog Box to Change a Table Filter" on page 4-10

■ STA Screen Basics Guide

■ STA Screen Basics Guide

Report Drive Utilization
1. In the Navigation Bar, select Tape System Hardware > Drives > Overview. 

2. In the Templates menu, apply the "STA-Drive-Utilization" template. 

This template displays utilization statistics for all drive types.

3. Use the following steps to remove drives for which STA has no utilization data. 

a. Click Filter Data.
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b. In the selection criteria, select the attribute that represents the utilization 
measure of interest to you. Select Greater than and enter 0. 

Following are some suggested attributes for measuring drive utilization.

* To identify drives with the highest utilization rates, use % Utilization (30 
Days). 

* To identify drives that have recorded the most new data, use MB Write (30 
Days), or MB Received (30 Days). 

* To identify drives that have passed the most data at the drive head, use 
MB R/W (30 Days). 

* For drives that have been in the library for their entire periods of use, the 
drive lifetime attributes are also useful measures of activity — for example, 
Drive Lifetime Loads or Drive Lifetime Hours in Motion. 

c. Click Apply. 

4. Perform a multiple-column sort to group the records by drive type and then 
utilization. 

a. Select View > Sort > Advanced.

b. Complete the Advanced Sort dialog box as follows:

* In the Sort By field, select Drive Type.

* In the Then By field, select the attribute that you used in Step b above, and 
Descending. 

c. Click OK. 
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The table is sorted according to your criteria. 

5. To summarize the data by drive type, you must use an external spreadsheet 
application. Use the following steps to export the data displayed in the table to an 
HTML-based Excel-compatible file. 

a. Click the Export icon in the Table Toolbar, and select Drives.xls. 

b. Save the file to a location on your local computer. 

6. Use a compatible spreadsheet application to open the file and summarize the data. 

Report Media Utilization
1. In the Navigation Bar, select Tape System Hardware > Media > Overview. 

2. In the Templates menu, apply the "STA-Media-Utilization" template. 
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This template displays utilization statistics for all media types.

3. Use the following steps to remove media for which STA has no utilization data. 

a. Click Filter Data.

b. In the selection criteria, select the attribute that represents the utilization 
measure of interest to you. Select Greater than and enter 0. 

Following are some suggested attributes for measuring media utilization: 

* To identify media with the greatest amount of movement, use Time spent 
reading or writing.

* To identify media below a specific threshold of available space, use Media 
MB Avail Pre/Post

* To identify media with the greatest number of mounts and dismounts, use 
Media Dismounts (30 days). 

* To identify media with the greatest amount of data read or written, use 
MB R/W (30 days). 

c. Click Apply. 
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4. Perform a multiple-column sort to group the records by media type and then 
utilization. 

a. Select View > Sort > Advanced.

b. Complete the Advanced Sort dialog box as follows:

* In the Sort By field, select Media Type.

* In the Then By field, select the attribute that you used in Step b above, and 
Descending. 

c. Click OK. 

The table is sorted according to your criteria. 



Capacity and Resource Management Questions

Using STA to Answer Tape Environment Questions 10-51

5. To summarize the data by media type, you must use an external spreadsheet 
application. Use the following steps to export the data displayed in the table to an 
HTML-based Excel-compatible file. 

a. Click the Export icon in the Table Toolbar, and select Media.xls. 

b. Save the file to a location on your local computer. 

6. Use a compatible spreadsheet application to open the file and summarize the data. 

Report Library Relative Activity Levels
This procedure addresses the questions, "Which library in my tape environment is the 
busiest? Which is the least busy?" 

The definition of busy varies by site; common definitions include the number of 
exchanges, mounts, or dismounts. This procedure uses the number of mounts. In 
addition, it provides instructions for graphing the data so you can compare the 
libraries to one another and to the system average.

Referenced Tasks
■ "Apply a Template" on page 3-7

■ STA Screen Basics Guide

■ STA Screen Basics Guide

■ STA Screen Basics Guide

■ STA Screen Basics Guide

■ STA Screen Basics Guide

1. In the Navigation Bar, select Tape System Hardware > Libraries > Overview. 
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2. In the Templates menu, apply the "STA-Lib-Utilization" template. 

3. In the Mounts (30 Days) column, click the Sort Ascending or Sort Descending 
arrow. 

4. Use the following steps to add a graph pane showing dismounts.

a. Click the Add Graph icon in the Graphics Area Toolbar. 

A new graph pane, with the attribute MB Read, is added to the end of the 
Graphics Area display. You may need to scroll down to see the graph. 

Note: Other columns you might want to sort by are Enters (30 Days), 
Ejects (30 Days), Occupied Storage Cells, or MB R/W (30 Days). 
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b. Click the Change Graphed Attribute icon in the Graph Pane Toolbar, and 
select the Dismounts attribute from the menu. 

The graph is updated to display the system average for dismount data. 

5. Use the following steps to add selected libraries to the screen graphs.

Adding the libraries to the graphs allows you to compare their attribute values 
against the system average.

a. In the List View table, select the libraries you want to add to the graphs. 

b. Click the Apply Selection icon on the List View Toolbar. 
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In the sample below, the three libraries with most mounts are added to all the 
graphs. 

6. In the Dismounts graph pane, click the Detach Pane icon to detach the graph to 
enlarge it and display more detail. 

Report Media Approaching Capacity
This procedure addresses the questions, "Which media are over 90 percent full? How 
do I generate a list that can be used to create a script to eject them from the library?" 

STA reports media capacity and available space as numeric values only, not as 
percentages. This procedure provides instructions for exporting the numeric values to 
a spreadsheet application, which can then be used to calculate percentages. The 
resulting list can be used by a media eject script. 

Referenced Tasks
■ "Apply a Template" on page 3-7

■ STA Screen Basics Guide

■ STA Screen Basics Guide
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1. In the Navigation Bar, select Tape System Hardware > Media > Overview. 

2. In the Templates menu, apply the "STA-Media-Utilization" template. 

This template includes the Media MB Available and Media MB Capacity 
attributes. 

3. In the Media MB Capacity column, click the Sort Descending arrow. 

The media with the highest capacity are brought to the top of the list. This sort also 
has the advantage of grouping media by type, since capacity tends to vary by 
media type. 
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4. To create a list that can be used by a media eject script, you must use an external 
spreadsheet application. Use the following steps to export the data displayed in 
the table to an HTML-based Excel-compatible file. 

a. Click the Export icon in the Table Toolbar and selected the Media.xls option.

b. Save the file to a location on your local computer. 

5. Using a compatible spreadsheet program, add a Percentage Full column, 
containing calculated values derived from the attributes in the exported table. Sort 
the table by the column values and identify a list of media over 90 percent full. 

Report Drive Firmware Levels
This procedure addresses the question, "Have all my drives been upgraded to the 
latest firmware?" Firmware levels are usually evaluated by drive type or model.

The following methods are described:

■ "Using the Drives – Overview Screen"

■ "Using the Drives – Analysis Screen" on page 10-60

Referenced Tasks
■ "Apply a Template" on page 3-7

■ STA Screen Basics Guide

■ STA Screen Basics Guide

■ "Use the Filter Data Dialog Box to Change a Table Filter" on page 4-10

■ STA Screen Basics Guide

■ STA Screen Basics Guide

Using the Drives – Overview Screen 
1. In the Navigation Bar, select Tape System Hardware > Drives > Overview. 
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2. In the Templates menu, apply the "STA-Drives-Base-Information" template.

This template includes the drive firmware version and other related attributes. 

3. Use the following steps to reorder the table columns so the drive firmware level is 
displayed next to the drive model.

a. Select View > Reorder Columns.
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b. In the Reorder Columns dialog box, arrange the following attributes so they 
are listed together.

* Drive Model

* Drive Firmware Version

c. Click OK. 

The table columns are reordered according to your criteria. 

4. To display firmware levels by drive type, use the following steps to set up a 
multiple-column sort. 

a. Select View > Sort > Advanced in the Table Toolbar. 

b. complete the Advanced Sort dialog box as follows:

* In the Sort By field, select Drive Model.

* In the Then By field, select Drive Firmware Version and select 
Descending. 

c. Click OK. 
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The table is sorted according to your criteria. 

5. Use the following steps to display firmware levels for a specific drive model. 

a. Click Filter Data. 

b. Specify the following selection criteria:

* Drive Model is the drive model of interest. 

c. Click Apply. 

The table is updated according to your selection criteria. 
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Using the Drives – Analysis Screen 
This method provides totals by drive and firmware level, and aggregates the totals by 
library complex. 

1. In the Navigation Bar, select Tape System Hardware > Drives > Analysis. 

2. Use the following steps to display firmware levels for a specific drive model. 

a. Click Filter Data. 

b. Specify the following selection criteria:

* Drive Model is the drive model of interest. 

c. Click Apply. 
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The table is updated according to your selection criteria. 

3. Use the following steps to reorganize the pivot table to aggregate firmware levels 
by drive model.

a. Click the Change Attribute icon on the Pivot Table Toolbar. 

b. In the Change Attributes dialog box, rearrange the attributes so the Selected 
Attributes list is as follows:

* Drive Model 

* Drive Firmware Version

* Library Complex Name

c. Click OK. 

Note: The last attribute in the list — in this case, Library Complex 
Name — always designates the column headers. The remaining 
attributes designate the row layers, nested in the order listed — in this 
case, Drive Firmware Version within Drive Model. 
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The pivot table is updated according to your criteria. 

4. To display a detailed listing of any of the subtotals, click the text link in a cell.

You are taken to the Drives – Overview screen, which displays additional detail 
for the drives included in the selected subtotal. 
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ADashboard Portlets

This section includes descriptions of the available Dashboard portlets. 

■ "Graph Portlets" on page A-1

■ "Table Portlets" on page A-4

■ "Report Portlets" on page A-5

Graph Portlets
Graph portlets include several formats. Bar and pie charts are point-in-time reports of 
related data. Line graphs and area charts show values over a selected date range. See 
the STA Screen Basics Guide for additional information about these graph formats.

Depending on when you display the Dashboard, the last time period on each graph 
may show a drop-off in data because it is just a partial period. 

Alerts
Bar chart showing the total number of STA alerts for drives, media, libraries, CAPs, 
and PTPs generated over a selected date range.

Alert Trends
Line graph showing the total number and severity of STA alerts each day over a 
selected date range.

Note: All data on Dashboard portlets is reported in UTC time. See 
"Times Displayed on the Dashboard" on page 2-3 for details.

Note: Alerts are generated based on user-defined alert policies. 
Because the number of alert policies and their criteria and severity are 
entirely user-defined, this graph does not necessarily indicate issues 
with your tape library system environment. 

Note: Alerts are generated based on user-defined alert policies. 
Because the number of alert policies and their criteria and severity are 
entirely user-defined, this graph does not necessarily indicate issues 
with your tape library system environment. 
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Cum Data Read and Written
Line graph showing the total amount of data read and written over a selected date 
range.

Drive Activity Trends
Area chart showing, by drive model, the total number of dismounts each day over a 
selected date range.

Drive Health
Bar chart showing, by drive model, the total number of drives with each Drive Health 
Indicator as computed by STA.

Drive Health Trends
Line graph showing, by drive model, the average Drive Suspicion Level each day over 
a selected date range.

Drive Utilization (Hourly, Daily, Weekly, or Monthly)
Line graph showing the average percentage of time the drives were occupied each 
hour, day, week, or month. You can filter by drive location (complex, library, or rail, for 
example) and by date range.

I/O Throughput (Hourly, Daily, Weekly, or Monthly)
Line graph showing the total amount of data read and written each hour, day, week, or 
month over a selected date range.

Library Component Health Trends
Line graph showing, by library component type (robots, CAPs, elevators, and 
pass-through ports), the average daily condition over a selected date range. 

Library Component Status
Bar chart showing, by library component type (robots, CAPs, elevators and 
pass-through ports), the current total number of components with each reported 
condition. 

Library Drive Bays
Pie chart showing the current distribution of installed drives by type and empty drive 
slots.

Library Media Slots
Pie chart showing the current distribution of occupied media slots by media type and 
empty slots.

Library Status
Bar chart showing, by library model, the current total number of libraries with each 
Top-Level Indicator as reported by the library.

Note: The conditions are as reported by the library, not by STA 
analytics.

Note: The conditions are as reported by the library, not by STA 
analytics.
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Maximum Mount Times (Hourly, Daily, Weekly, or Monthly)
Line graph showing, for each hour, day, week, or month over a selected date range, the 
total time-to-mount of the single exchange that took the longest time to mount. The 
value plotted is the total time from the start of the exchange to the start of the mount. 

Media – Least Recently Mounted (Hourly, Daily, Weekly, or Monthly)
Line graph showing, for each hour, day, week, or month over a selected date range, the 
piece of media with the longest time since the last exchange. The value plotted is the 
total time since the last exchange. Only media that have had exchange activity are 
included.

Media Health
Bar chart showing, by media type, the total number of media with each Media Health 
Indicator as computed by STA.

Media Health Trends
Line graph showing, by media type, the average Media Suspicion Level each day over 
a selected date range.

Media Movements (Hourly, Daily, Weekly, or Monthly)
Line graph showing the total times media were entered, ejected, or otherwise moved 
each hour, day, week, or month over a selected date range. "Other" movements include 
moves by robots, elevators, or PTPs. 

Media Slots Available (Hourly, Daily, Weekly, or Monthly)
Line graph showing the minimum and maximum media slots available each hour, day, 
week, or month over a selected date range

Media Utilization (Hourly, Daily, Weekly, or Monthly)
Line graph showing an estimate of average media utilization each hour, day, week, or 
month over a selected date range. Media utilization is the percentage of the total 
media capacity that has been used by data—that is, the "fullness" of the media. Only 
media that have had exchange activity are included.

Media Utilization Bands (Hourly, Daily, Weekly, or Monthly)
Line graph showing an estimate of the number of media bands, or utilization ranges, 
used each hour, day, week, or month over a selected date range. A band appears on 
the graph only if there are media with utilization values in that range. 

The <0001% band includes both media that is literally blank and media that is 
effectively blank because it has an internal label but no real data. 

Media Validation
Line graph showing the total number of media validations, and the total passed, 
failed, and unknown for the selected time period.

Mounts (Hourly, Daily, Weekly, or Monthly)
Line graph showing the total number of mounts each hour, day, week, or month over a 
selected date range. The value plotted is the number of mounts, not dismounts.

Robot Health
Bar chart showing the current number of robots by Robot Health as computed by STA.

SL8500 Dismount Efficiency (moves)
Bar chart summarizing the total number of rails on which a media travels to complete 
a dismount request as part of an exchange. This includes movements by robots, 
elevators, and PTPs. If a media crosses a rail without stopping, the rail is not included 
in the count. For example:
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■ For a media moved from a drive to a media slot on the same rail, the count is "1."

■ For a media moved from a drive on rail #4 to a media slot on rail #1, the count is 
"2."

■ For a media moved from a drive on rail #4, to a PTP on rail #3, to a drive on rail #1 
in a different library, the count is "3."

SL8500 Mount Efficiency (moves)
Bar chart summarizing the total number of rails on which a media travels to complete 
a mount request as part of an exchange. This includes movements by robots, elevators, 
and PTPs. If a media crosses a rail without stopping, the rail is not included in the 
count. For example:

■ For a media moved from a media slot to a drive on the same rail, the count is "1."

■ For a media moved from a media slot on rail #1 to a drive on rail #4, the count is 
"2."

■ For a media moved from a drive on rail #1, to a PTP on rail #3, to a drive on rail #4 
in a different library, the count is "3."

Table Portlets
Some table portlets are point-in-time reports of related data. Others are trend reports, 
showing start and end, and high and low values over a selected date range. You can 
hover the cursor over a table cell to display a tooltip containing detailed values and 
dates.

Trend reports include embedded spark charts, which are small line graphs that plot up 
to four key values—Start, End, High, and Low—for a selected date range. See the STA 
Screen Basics Guide for details about spark charts. 

Data Read/Written Trends
Summarizes the amount of data read and written, and average data compression ratio 
over a selected date range. 

The Total Data Stored values are the total amount of data stored on all media in the 
selected libraries as of the indicated dates. 

The Data Compression values displayed in the table are rounded to the nearest whole 
number; the table cell tooltips display decimal value detail.

This portlet displays values for dates within the last six months (180 days) only. If you 
filter for a date range extending past the previous six months, the portlet displays 
values only for dates that fall within the allowed range. Following are examples:

■ Filtering for "Number of Days More Than 25" shows values for the period from 60 
to 25 days ago.

■ Filtering for "Number of Days Less Than 75" shows values for the period 60 days 
ago to current.

■ Filtering for "Number of Days More Than 200" shows no data.

Note: For libraries managed by StorageTek ACSLS, if the media float 
option is enabled, dismount move efficiency will be "1" whenever 
media slots are available within the same LSM as the drive.
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Drive Capacity Planning (30 Days)
Summarizes installed drive slots, installed drives, removed drives, and drive 
utilization statistics over the last 30 days. 

The Drives Under-utilized count includes unknown drives (drives for whichSTA has 
received no data), as well as drives that have never been used.

Drives Fewest Meters Between Recent Cleanings
Lists drives that have run the fewest meters of tape between the two most recent 
cleanings. The table only includes drives for which STA has recorded at least two 
cleaning actions. This is as of the current point in time.

Drives Watch List
Summarizes drives with Action or Evaluate drive health. Lists the drive serial number, 
model, Drive Health Indicator, Drive Health Trend, and most recent annotation. This is 
as of the current point in time.

Media Capacity Planning (30 Days)
Summarizes installed, activated, and occupied media slots, media removed, and 
media utilization statistics over the last 30 days.

Media Exceptions
Lists media that have been removed from the tape library system through some means 
other than a cartridge access port (CAP), SL3000 access expansion module (AEM), 
SL150 mailslot. This is as of the current point in time.

Media Validation
Summarizes media validation results by verification test type. By default, this portlet 
shows data for the last 14 days. The counts in the Pass, Fail, and Unknown columns 
are based on the MV Result attribute, as follows: 

■ Use – MV Result is Use

■ Fail – MV Result is Failed or Degraded

■ Unknown – MV Result is Unknown

This table reports completed validations only; pending or in-process validations are 
not included. It includes validations initiated by all sources, including host 
applications, SL Console, and the library CLI, as well as STA. See "Media Validation 
Initiators" on page 8-22 for details.

Media Watch List
Summarizes media with Action or Evaluate media health. Lists the volume serial 
number (volser), type, Media Health Indicator, Media Health Trend, and most recent 
annotation. This is as of the current point in time.

Monitored Device Trends
Summarizes the number of resources in your tape library system over a selected date 
range. Information includes the total number of libraries, robots, CAPs, pass-through 
ports (PTPs), elevators, drives, media, and media removed through a CAP, SL3000 
AEM, or SL150 mailslot.

Report Portlets
Report portlets are text-only summaries of current information about your tape library 
system.
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Data Read Report
Summarizes total data read from media, including the daily average, daily high and 
low marks, and average compression ratio. 

Data Written Report
Summarizes total data written to media, including the daily average, daily high and 
low marks, and average compression ratio.

Drives Health Report
Summarizes the number of drives by Drive Health Indicator as computed by STA.

Library Status Report
Summarizes the number of libraries by Library Top-Level Indicator reported by the 
library.

Media Health Report
Summarizes the number of media by Media Health Indicator as computed by STA. 
The "Unknown" category includes media for which STA has not received sufficient 
data to calculate health; this may occur for the following reasons:

■ The media has not been mounted in a drive during the time STA has been 
monitoring it. 

■ The STA Supported attribute for the media has a value of True. This indicates the 
media has a type does not meet the minimum requirements for STA analytics—for 
example, SDLT and LTO-2 media. See the STA Requirements Guide for details about 
supported media types.

Media Validation Report
Summarizes media validation activity, including a breakdown of validations 
performed, number of media validated, number of drives used, and validation elapsed 
times.

Monitored Device Counts
Summarizes total devices monitored in your tape library system, including libraries, 
robots, CAPs, pass-through ports (PTPs), elevators, drives, media, and media removed 
through a CAP, SL3000 AEM, or SL150 mailslot

By default, this report includes all devices as of the current date. However, when 
filtered by STA Start Tracking Date (Days) or STA Start Tracking Date (No. Days), the 
report counts include the number of devices with STA Start Tracking dates that fall in 
the specified range of dates or number of days. For example, if you use the filter "STA 
Start Tracking Date Less Than 7 Days Ago," the report only counts devices that were 
added to the tape library environment during the last seven days; devices monitored 
for longer are not included.
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BSTA Predefined Templates

This section includes short descriptions of the predefined templates for each Overview, 
Analysis, and Messages screen. The following sections are included:

Home Tab

■ "Dashboard Templates" on page B-2

Tape System Hardware Tab

■ "Complexes Overview Templates" on page B-3

■ "Libraries – Overview Templates" on page B-4

■ "Libraries – Messages Templates" on page B-4

■ "Drives – Overview Templates" on page B-5

■ "Drives – Analysis Templates" on page B-6

■ "Drives – Messages Templates" on page B-6

■ "Media – Overview Templates" on page B-6

■ "Media – Analysis Templates" on page B-8

■ "Media – Messages Templates" on page B-8

■ "Robots Overview Templates" on page B-8

■ "CAPs Overview Templates" on page B-8

■ "PTPs Overview Templates" on page B-9

■ "Elevators Overview Templates" on page B-9

Tape System Activity Tab

■ "Alerts Overview Templates" on page B-9

■ "Exchanges Overview Templates" on page B-10

■ "Drive Cleanings Overview Templates" on page B-11

■ "Media Validation Overview Templates" on page B-11

■ "All Messages – Overview Templates" on page B-11

■ "All Messages – Analysis Templates" on page B-12
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Dashboard Templates

STA-Default
Provides a comprehensive summary of the condition, configuration, and daily 
performance of your tape library system.

STA-Dashboard-All-Graphs
Displays all available graph portlets in alphabetical order. This template is useful for 
selecting portlets to include in Dashboard templates and Executive Reports.

STA-Dashboard-All-Reports
Displays all available report portlets in alphabetical order. This template is useful for 
selecting portlets to include in Dashboard templates and Executive Reports.

STA-Dashboard-All-Tables
Displays all available table portlets in alphabetical order. This template is useful for 
selecting portlets to include in Dashboard templates and Executive Reports.

STA-Dashboard-Nearline-Daily
Displays daily summary information for drive and media activity in your tape library 
system over the last 30 days. The displayed portlets summarize mount activity, I/O 
throughput, drive and media utilization, and drive and media slot availability. 

STA-Dashboard-Nearline-Hourly
Displays hourly summary information for drive and media activity in your tape 
library system over the last four days. The displayed portlets summarize mount 
activity, I/O throughput, drive and media utilization, and drive and media slot 
availability. 

Note: Data displayed in this template is updated at the end of each 
day. For bar charts, at least one full day's worth of data must have 
been collected by STA in order for data to be displayed. For line 
graphs, at least two data points are required, so at least two days' 
worth of data are required.

Note: Data displayed in this template is updated at the end of each 
hour. For bar charts, at least one full hour's worth of data must have 
been collected by STA in order for data to be displayed. For line 
graphs, at least two data points are required, so at least two hours' 
worth of data are required.
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STA-Dashboard-Nearline-Monthly
Displays monthly summary information for drive and media activity in your tape 
library system over the last 365 days. The displayed portlets summarize mount 
activity, I/O throughput, drive and media utilization, and drive and media slot 
availability. 

STA-Dashboard-Nearline-Weekly
Displays daily summary information for drive and media activity in your tape library 
system over the last 100 days. The displayed portlets summarize mount activity, I/O 
throughput, drive and media utilization, and drive and media slot availability. 

STA-Dashboard-Quick-Start
Displays information about the overall configuration and condition of the tape library 
system; used with the STA Quick Start Guide.

Complexes Overview Templates

STA-Default
Displays basic library complex configuration.

STA-Complex-All
Displays all library complex graphs and table attributes.

STA-Complex-Configuration
Displays library complex configuration information.

STA-Complex-Utilization
Displays information about the amount and rates of library complex activity and drive 
utilization.

Note: Data displayed in this template is updated at the end of each 
month. For bar charts, at least one full month's worth of data must 
have been collected by STA in order for data to be displayed. For line 
graphs, at least two data points are required, so at least two months' 
worth of data are required.

Note: Data displayed in this template is updated at the end of each 
week. For bar charts, at least one full week's worth of data must have 
been collected by STA in order for data to be displayed. For line 
graphs, at least two data points are required, so at least two weeks' 
worth of data are required.
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Libraries – Overview Templates

STA-Default
Displays basic library properties and configuration information. 

STA-Lib-All
Displays all library table attributes.

STA-Lib-Base-Information
Displays the base library configuration and relatively static data; useful for library 
description and inventory listings.

STA-Lib-Configuration
Displays library configuration and connection information; useful for troubleshooting 
connection issues. 

STA-Lib-Health
Displays information about library health, firmware, and SNMP connection with STA. 

STA-Lib-Quick-Start
Displays information about the overall configuration and condition of the library; used 
with the STA Quick Start Guide.

STA-Lib-Utilization
Displays summary information about the amount and rates of library activity and 
drive utilization.

Libraries – Messages Templates

STA-Default
Displays SNMP traps, including detail about the library and device involved. 
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Drives – Overview Templates

STA-Default
Displays drive configuration information and the status of the most recent exchange 
that occurred on the drive. 

STA-Drive-All
Displays all drive graphs and table attributes. 

STA-Drive-Base-Information
Displays the base drive configuration and relatively static data; useful for drive 
description and inventory listings. 

STA-Drive-Enterprise-Performance
Displays summary performance data for enterprise drives only. 

STA-Drive-Health
Displays current and summary health and activity information for all drives.

STA-Drive-Last-Exchange
Displays information for the last exchange that occurred on each drive.

STA-Drive-LTO-Performance
Displays performance data for LTO drives only. 

STA-Drive-LTO-Utilization
Displays utilization statistics for LTO drives only. 

STA-Drive-MV
Displays drives that meet the criteria for performing STA media validation. The 
displayed attributes provide detail that is useful for selecting and monitoring the 
performance of drives that may be assigned to the validation drive pools.

STA-Drive-Performance-30-Days
Displays summary performance data for all drives over the last 30 days. 

STA-Drive-Utilization
Displays utilization statistics for all drives. 
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Drives – Analysis Templates

STA-Default
Summarizes current drive health by library complex. 

STA-Drive-Firmware-Levels
Summarizes current drive firmware levels by drive type.

STA-Drive-Read-Marginal
Summarizes the "Exchange Read Marginal" status for applicable drives, by library 
complex name. Applicable to StorageTek T10000 drives only. 

Drives – Messages Templates

STA-Default
Displays SNMP traps, including detail about the drive involved. 

Media – Overview Templates

STA-Default
Displays base information about the media, its most recent exchange, and the drive 
involved. 

STA-Media-All
Displays all media graphs and table attributes.
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STA- Media-Base-Information
Displays the base media information and relatively static data; useful for media 
description and inventory listing.

STA-Media-Cleaning
Displays base information about cleaning media only. Also displays the status of the 
cleaning media's most recent exchange and the drive involved. 

STA-Media-Expired
Displays information about expired media. Your Oracle support representative may 
ask you to use this template before submitting error log information. 

STA-Media-Health
Displays current and summary health and activity information for all media.

STA-Media-Last-Exchange
Displays information about the last exchange for each piece of media.

STA-Media-LTO-Performance
Displays summary performance information for LTO media only. 

STA-Media-LTO-Utilization
Displays summary utilization information for LTO media only. 

STA-Media-MIR-Stats
Displays data from the media information record (MIR).

STA-Media-MV-Calibration
Displays media that may be used for calibration and qualification of validation drives. 
The displayed attributes provide detail that is useful for selecting and monitoring the 
performance of media that may be candidates for inclusion in the calibration media 
logical group.

STA-Media-MV-Performed
Displays media that have been validated within the last 30 days. The displayed 
attributes provide detail about media validation operations performed on these media.

STA-Media-Stats-Last-Exchange
Displays throughput and efficiency information for the last exchange for each piece of 
media. Your Oracle support representative may ask you to use this template before 
submitting error log information.

STA-Media-T10K-Performance
Displays summary performance information for T10000 media only.

STA-Media-T10K-Utilization
Displays summary utilization information for T10000 media only.

STA-Media-Utilization
Displays summary utilization information for all media. 
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Media – Analysis Templates

STA-Default
Summarizes current media health by library complex.

STA-Media-HealthByMediaType
Summarizes current media health by media type.

Media – Messages Templates

STA-Default
Displays SNMP traps, including detail about the drive involved. 

Robots Overview Templates

STA-Default
Displays properties and activities for all library robots. 

STA-Robot-All
Displays all available data attributes for all library robots.

CAPs Overview Templates

STA-Default
Displays properties and activities for all library cartridge access ports (CAPs), SL3000 
Access Expansion Modules (AEMs), and SL150 mailslots. 

STA-CAP-All
Displays all available data attributes for all library CAPs, SL3000 AEMs, and SL150 
mailslots.
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PTPs Overview Templates

STA-Default
Displays properties and activities for all SL8500 library pass-thru ports (PTPs). 

STA-PTP-All
Displays all available data attributes for all SL8500 library PTPs.

Elevators Overview Templates

STA-Default
Displays properties and activities for all SL8500 library elevators. 

STA-Elevator-All
Displays all available data attributes for all SL8500 library elevators.

Alerts Overview Templates

STA-Default
Displays summary information for all STA alerts. The displayed attributes identify the 
alert policy, severity, criteria, and the tape library system resource or event for which 
the alert was generated. 

STA-Alert-All
Displays all available attributes for all STA alerts.
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Exchanges Overview Templates

STA-Default
Displays identification and status information for the drive, media, and library 
involved in each exchange. 

STA-Exchange-Alerts-All
Displays information about alerts that occurred during exchanges; exchanges that 
have not generated an alert are not included. 

STA-Exchange-Alerts-Errors
Displays all exchanges that resulted in at least one severe or warning tape alert. The 
displayed attributes provide detail about the types of errors that occurred. Severe tape 
alerts indicate an error on the exchange that may put your data at risk. Warning tape 
alerts indicate an error that may be associated with a hardware failure. 

Your Oracle support representative may ask you to use this template before submitting 
error log information. 

STA-Exchange-Alerts-Informational
Displays all exchanges that resulted in at least one informational tape alert. The 
displayed attributes provide detail about the types of alerts that occurred. 
Informational tape alerts do not indicate an error on the exchange—cleaning alerts are 
an example.

STA-Exchange-Alerts-Severe
Displays all exchanges that resulted in at least one severe tape alert. The displayed 
attributes provide detail about the types of errors that occurred. Severe tape alerts 
indicate an error on the exchange that may put your data at risk.

STA-Exchange-Alerts-Warning
Displays all exchanges that resulted in at least one warning tape alert. The displayed 
attributes provide detail about the types of errors that occurred. Warning tape alerts 
indicate an error on the exchange that may be associated with a hardware failure.

STA-Exchange-Base Information
Displays base information for all exchanges, such as drive and volume serial number, 
drive and media health, drive and media exchange status, MB read and written, and 
times. 

STA-Exchange-MIR-Alerts
Displays all exchanges that resulted in alerts related to the media information record 
(MIR). Your Oracle support representative may ask you to use this template before 
submitting error log information.
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Drive Cleanings Overview Templates

STA-Default
Displays identification and status information for the drive, media, and library 
involved in each cleaning exchange.

STA-Cleaning-All
Displays all cleaning exchange attributes.

STA-Cleaning-Base-Information
Displays base information for all cleaning exchanges, such as drive and volume serial 
number, drive lifetime cleans, and current and maximum cleaning uses. 

Media Validation Overview Templates

STA-Default
Displays summary information for all media validation requests. The displayed 
attributes identify the request state, verification test, initiator, and policy name, if 
applicable. The validation results are shown for completed validations. 

STA-MediaValidation-All
Displays all available attributes for all media validations.

All Messages – Overview Templates

STA-Default
Displays SNMP traps, including detail about the library and device involved. 

STA-Messages-All
Displays all attributes available for SNMP traps (no graphs are available for this 
screen).

STA- Messages-Base-Information
Displays base data for SNMP traps; useful for an overview, description, and listing of 
STA messages.
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All Messages – Analysis Templates

STA-Default
Summarizes STA message severity levels by library complex. 
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STA Dialog Box Reference C-1

CSTA Dialog Box Reference

This section contains reference information for the following types of STA data entry 
dialog boxes. 

■ "Login Dialog Box" on page C-1

■ "Dashboard Dialog Box" on page C-2

■ "Filter Dialog Box" on page C-4

■ "Media Validation Overview Dialog Boxes" on page C-5

■ "Logical Groups Dialog Boxes" on page C-8

■ "Alert Policy Wizard" on page C-12

■ "Executive Reports Policies Dialog Boxes" on page C-14

■ "Templates Management Dialog Boxes" on page C-17

■ "Media Validation Policy Wizard and Dialog Boxes" on page C-23

■ "Service Log Dialog Boxes" on page C-26

■ "SNMP Connections Dialog Boxes" on page C-28

■ "User Management Dialog Boxes" on page C-34

■ "Email Configuration Dialog Boxes" on page C-36

For descriptions of dialog boxes relating to user preferences and tables, see the STA 
Screen Basics Guide.

Login Dialog Box
■ "Login" on page C-1

Login
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Description
This dialog box appears when you enter the URL of the STA server in your browser. 
Your STA administrator will provide you with an STA username and password for 
logging in.

Screen Fields

Username
Required.

Enter the STA username you want to log in with.

Password
Required.

Enter the password assigned to the STA username.

Buttons

Login
Click to log in. Once your username and password are authenticated, you are taken to 
the Dashboard.

See Also
■ "Log In to STA" on page 1-3

Dashboard Dialog Box
■ "Annotate" on page C-3

Note: You have up to five chances to log in successfully. After five 
unsuccessful login attempts within a five-minute period, you will be 
locked out of your user account for 30 minutes. For security reasons, 
your account cannot be reset during the lockout period, even by the 
STA administrator, so you must wait the full 30-minutes before 
attempting to log in again.

Note: The Accessibility Settings dialog box may appear before the 
Dashboard.
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Annotate

Description
This dialog box allows you to add or modify a Dashboard portlet annotation. It 
appears when you click Portlet Information on a Dashboard portlet.

Screen Fields

You may add additional notes to this panel:
Type the text you want to appear on Executive Reports.

Annotations can be up to 1,000 ASCII characters in length. There are no formatting 
options, such as boldface or color. Also, spacing options, such as forced line feeds, are 
not preserved on the Executive Reports.

Buttons

Save Annotation
Click to apply the annotation to the Dashboard portlet.

Cancel
Click to dismiss this dialog box without applying the annotation.

See Also
■ "Add or Change a Dashboard Portlet Annotation" on page 2-17

Note: The text you enter is specific to the current Dashboard 
template. For example, if the Drive Health portlet appears in several 
Dashboard templates, each instance of the Drive Health portlet can 
have a different annotation associated with it. 

Note: Annotation text is specific to your STA username. For 
example, annotations entered by one user on the Drive Health portlet 
do not appear to a user logged in with a different STA username.
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Filter Dialog Box
■ "Filter Data" on page C-4

Filter Data

Description
This dialog box allows you to specify the criteria you want to use to filter data in a List 
View or Pivot table. You can specify any number of criteria.

This dialog box appears when you click Filter Data on a table toolbar.

Screen Fields

Filter Matching
Indicate the type of matching you want to use for the filter. Options are:

■ Match ANY of the following – Selects table records that meet any of the criteria 
you specify. This is the default.

■ Match ALL of the following – Selects only records that meet all of the criteria you 
specify.

Filter criteria list
Enter the filter criteria you want to apply to the table. You can add as many rows as 
you want. On each row, you specify the criteria through the following menu selections:

■ Table attribute – All available attributes for the table are listed in the menu. 

Note: If you know the name of the attribute you want to select, you 
can type the first few letters to quickly move the cursor to that item in 
the menu.
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■ Filter operators – Filter operators vary by attribute type. 

■ Attribute value – Attribute values vary by attribute. 

See Table 4–1, " Filter Operators by Attribute Type" for details about the menu 
selections.

Buttons

Add new filter criteria row
Click to add a new row to the list of filter criteria.

Remove this filter criteria row
Click to delete the current row of filter criteria.

Apply
Click to apply your entries. The table is updated to display only those records that 
meet the selection criteria you have specified.

Reset
Click to reset the dialog box to the default settings.

Cancel
Click to dismiss this dialog box without applying your entries.

See Also
■ "Use the Filter Data Dialog Box to Change a Table Filter" on page 4-10

Media Validation Overview Dialog Boxes
■ "Cancel Requests" on page C-5

■ "Resubmit Media" on page C-6

■ "Reorder Pending Requests" on page C-7

Cancel Requests

Description
This dialog box allows you to cancel a selected media validation request. It appears 
when you select an in-progress or pending media validation request on the Media 
Validation Overview screen and then click Cancel.

Buttons

Yes
Click to cancel the selected media validation request.
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No
Click to dismiss the dialog box without canceling the media validation request.

See Also
■ "Cancel Pending Media Validation Requests" on page 8-50

■ "Cancel In-Progress "Complete Verify" Validations" on page 8-52

Resubmit Media

Description
This dialog box allows you to resubmit a selected media validation request. It appears 
when you select a completed media validation request on the Media Validation 
Overview screen and then click Resubmit Media.

Screen Fields

Validation test to run
Select the media validation test you want to run. The menu lists all verification tests 
available on T10000C and T10000D drives.

Perform validations from beginning of tape
Appears only if you have selected Complete Verify or Complete Verify Plus. Select this 
option if you want all selected media to be validated from the beginning of tape (BOT).

Resume interrupted validations when possible, otherwise start at beginning
Appears only if you have selected Complete Verify or Complete Verify Plus. Select this 
option if you want the selected media to be validated from wherever the previous 
validations left off, if this can be determined from the media information record (MIR).

Drive
Select the validation drive you want to use. The menu displays all validation drives in 
the standalone library or library complex.

This option is available only if all media you have selected for validation are in the 
same standalone library or library complex. If this option is not available, STA 
automatically selects compatible drives to perform the validations.
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Buttons

OK
Click to submit the request.

Cancel
Click to dismiss the dialog box without submitting the request.

See Also
■ "Submit Manual Media Validation Requests" on page 8-40

Reorder Pending Requests

Description
This dialog box allows you to reorder pending media validation requests. It appears 
when you click Reorder Pending Requests on the Media Validation Overview screen.

Screen Fields

Reorder Pending Requests
List of all pending media validation requests, in the order they are to be run. Select one 
or more requests you want to re-order. This field supports multi-select.

Buttons

Ordering arrows
These buttons are active only if you have selected one or more items in the Reorder 
Pending Requests list.

OK
Click to apply your updates.

Cancel
Click to dismiss the dialog box without applying your updates.

Arrows Description

Move the selected item(s) up or down, one place at a time.

Move the selected item(s) to the top or bottom of the list.
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See Also
■ "Reorder Pending Media Validation Requests" on page 8-47

Logical Groups Dialog Boxes
■ "Logical Groups" on page C-8

■ "Create or Edit Logical Group" on page C-9

■ "Delete Logical Group" on page C-11

■ "Unassign Entities" on page C-11

Logical Groups

Description
This dialog box allows you to add drives or media to a manual logical group. It 
appears when you select one or more drives or media on the Drives – Overview or 
Media – Overview screen and then click Logical Groups.

Screen Fields

Adding to Logical Group menu
Select the logical group to which you want to add the selected drives or media.

Buttons

OK
Click to apply your entries.

Cancel
Click to dismiss this dialog box without applying your entries.

See Also
■ "Add Drives and Media to a Manual Logical Group" on page 7-13
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Create or Edit Logical Group

Description
This dialog box allows you to create manual and dynamic logical groups. For dynamic 
groups, you use this dialog box to define the matching policy criteria for selecting 
drives and media for the group.

This dialog box appears when you click Add Logical Group or Edit Logical Group on 
the Logical Groups screen.

Screen Fields

Logical Group Name
User-assigned name for the logical group. Your entry can be up to 249 alphanumeric 
characters, and it must be unique.

Logical Group Type
Required field for the Create Logical Group dialog box. Display-only field for the Edit 
Logical Group dialog box.

Indicate the type of logical group. Options are:

■ Dynamic – Drives and media are automatically selected for this group based on 
the selection criteria you define.

■ Manual – Drives and media are selected for this group manually.

Filter Matching

Indicate the type of matching you want to use for the selection criteria. Options are:

■ Match ANY of the following – Selects drives and media that meet any of the 
criteria you specify. This is the default.

Note: This field appears only for dynamic logical groups.
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■ Match ALL of the following – Selects only drives and media that meet all the 
criteria you specify.

Selection criteria rows

Enter the selection criteria you want to use for this group. You can add as many rows 
as you want. On each row, you specify the criteria through the following menu 
selections:

■ Drive and media attributes – Selected drive and media attributes are listed in the 
menu. See "Dynamic Group Selection Criteria" on page 7-3 for the complete list.

■ Selection operators – Selection operators vary by attribute type. These are similar 
to the operators in the Filter Data dialog box. See Table 4–1, " Filter Operators by 
Attribute Type" for details.

■ Attribute value – Attribute values vary by attribute. 

Buttons

Add new filter criteria row

Click to add a new row to the list of selection criteria.

Remove this filter criteria row

Click to delete the associated selection criteria row.

Save
Click to save the logical group. If it is a dynamic group, STA begins building the group 
according to the specified selection criteria.

Cancel
Click to dismiss this dialog box without applying your entries.

See Also
■ "Create a Manual Logical Group" on page 7-11

■ "Create and Define a Dynamic Logical Group" on page 7-17

Note: These fields appear only for dynamic logical groups.

Note: If you know the name of the attribute you want to select, you 
can type the first few letters to quickly move the cursor to that item in 
the menu.

Note: This button appears only for dynamic logical groups.

Note: This button appears only for dynamic logical groups.
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Delete Logical Group

Description
This dialog box allows you to confirm whether you want to delete the selected logical 
group. It appears when you when you select a logical group on the Logical Groups 
screen and then click Delete.

Buttons

Yes
Click to delete the selected logical group.

No
Click to cancel the deletion and keep the selected logical group.

See Also
■ "Delete a Logical Group" on page 7-26

Unassign Entities

Description
This dialog box allows you to confirm whether you want to remove the selected drives 
or media from the manual logical group. It appears when you select one or more 
records in the Drives or Media table on the Logical Groups screen and then click 
Unassign Entities.

Buttons

Yes
Click to remove the selected drives or media from the group.

No
Click to cancel the removal and keep the keep the selected drives or media in the 
group.

See Also
■ "Remove Drives and Media From a Manual Logical Group" on page 7-15
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Alerts Policies Dialog Boxes
■ "Alert Policy Wizard" on page C-12

Alert Policy Wizard

Description
This wizard allows you to define and enable new alert policies. It also allows you to 
modify information for existing policies. 

This wizard appears when you select New Alert Policy or Edit Alert Policy on the 
Alerts Policies screen.

Screen Fields

Policy Name

Policy Name
User-assigned name for the alert policy. Your entry can be up to 250 alphanumeric 
characters, and it must be unique.

Policy Description
Optional field. User-assigned description of the alert policy.

Policy Type

Entity Type
Select the type of library system component or event for which this policy may 
generate alerts.

Select Severity
Select the severity level of the alert policy. Options are:
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■ Severe – May generate alerts every hour

■ Warning – May generate alerts every 24 hours

■ Informative – May generate just one alert

Alert Criteria

Filter Matching
Indicate the type of matching you want to use for the alert policy criteria. Options are:

■ Match ANY of the following – Triggers an alert when any of the criteria you 
specify are met. This is the default.

■ Match ALL of the following – Triggers an alert only when all the criteria you 
specify are met.

Alert criteria rows
Enter the criteria you want to use for this alert policy. You can add as many rows as 
you want. On each row, you specify the criteria through the following menu selections:

■ Attributes – The attributes vary according to the selected Entity Type. 

■ Selection operators – Selection operators vary by attribute type. These are similar 
to the operators in the Filter Data dialog box. See Table 4–1, " Filter Operators by 
Attribute Type" for details.

■ Attribute value – Attribute values vary by attribute. 

Recipients

Email Recipients
Select the check box of each email address to receive emails whenever alerts are 
generated from this policy. 

Review

Enable Alert Policy
Select the check box to create the policy and enable it immediately. De-select the check 
box to create the policy but leave it disabled for now; you can enable it at a later time.

Buttons

Breadcrumbs
Breadcrumbs are activated for wizard screens you have already visited and for the 
next immediate screen. Click a link to go directly to the selected screen.

Back
Click to go back to the previous screen in the wizard.

Next
Click to go to the next screen in the wizard.

Note: If you know the name of the attribute you want to select, you 
can type the first few letters to quickly move the cursor to that item in 
the menu.
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Cancel
Click to exit the wizard without applying your entries.

Save

Click to apply your entries and create or update the alert policy.

See Also
■ "Create an Alert Policy" on page 5-12

■ "Modify an Alert Policy" on page 5-18

Executive Reports Policies Dialog Boxes
■ "Add/Edit Executive Reports Policy" on page C-14

■ "Reports" on page C-16

■ "Delete" on page C-16

Add/Edit Executive Reports Policy

Description
This dialog box allows you to define or modify an Executive Report definition, 
including name, source Dashboard template, run frequency, shared status, and email 
recipients.

This dialog box appears when you click Add or Edit on the Executive Reports Policies 
screen.

Screen Fields

Report Name
Type the name you want to assign to the report. Your entry can be up to 255 
alphanumeric characters.

Note: This button appears only on the last screen of the wizard.
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Source Dashboard Template
The menu lists all Dashboard templates that are available to the current STA 
username. Select the template you want to use as the basis of the Executive Report. 
The report will include all information in this template.

Locale
The menu lists all languages in which Executive Reports can be produced. Select 
English.

Start Date
Specify the date when you want scheduled runs of this report to begin. Reports are run 
shortly after 00:30 UTC, starting on this date. The default is tomorrow, in which case 
the report runs for the first time shortly after 00:30 UTC the day after it is defined.

Run Frequency
In the menu, select the frequency at which you want the report to run. Options are:

■ Daily

■ Every 7 days

■ Every 30 days

■ Every 90 days

■ Every 365 days

Shared
This field allows you to specify whether this report can be shared with all STA users in 
the STA user interface. You must select one of the following options:

■ Public – Report is available to all users.

■ Private– Report is available to the current STA username only. This does not affect 
the email recipients list—copies of the report can be emailed to any addresses that 
have been defined to STA, as described below. 

Email Recipients
Specify the email addresses to which you want copies of this report emailed after each 
report run. An email is sent to each address with a PDF attachment of the report.

The menu lists all email addresses that have been defined to STA. In the menu, select 
the check box next to each email address you want to receive this report. You can select 
as many addresses as you want. Select the "All" check box to select all check boxes in 
the list. 

Buttons

Save
Click to apply your entries. The report will be run automatically at the first scheduled 
date. You can also run the report manually from the Setup & Administration > 
Executive Reports Policies screen.

Save and Run
Click to apply your entries and run this report now. This does not affect the report's 
regular schedule.

Cancel
Click to dismiss this dialog box without applying your entries.
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See Also
■ "Create or Modify an Executive Report Policy" on page 6-10

Reports

Description
This dialog box allows you to confirm whether you want to run the selected Executive 
Report. The report is run at the first available opportunity, which could take up to two 
minutes. 

This dialog box appears when you click Run on the Executive Reports Policies screen.

Buttons

OK
Click to run the report.

Cancel
Click to dismiss the dialog box without running the report.

See Also
■ "Run an Executive Report On Demand" on page 6-6

Delete

Description
This dialog box allows you to confirm whether you want to delete the selected 
Executive Report definition.

This dialog box appears when you click Delete on the Executive Reports Policies 
screen.
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Buttons

Yes
Click to delete the selected Executive Report definition. This does not affect copies of 
this report that have already been run; they can still be viewed from the Home > 
Executive Reports screen.

No
Click to cancel the deletion and keep the selected Executive Report definition.

See Also
■ "Delete an Executive Report Policy" on page 6-13

Templates Management Dialog Boxes
■ "Reset (Templates)" on page C-17

■ "Import Template" on page C-18

■ "Rename Template" on page C-19

■ "Delete Template" on page C-20

■ "Save Template" on page C-21

■ "Save Template (Overwrite)" on page C-22

■ "Default Template" on page C-22

Reset (Templates)

Description
This dialog box allows you to restore all STA predefined templates that have been 
deleted. The templates will be restored and made available to all users.

This dialog box appears when you click Restore Predefined Templates on the 
Templates Management screen. 
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Screen Fields
None

Buttons

Yes
Click to restore all STA predefined templates.

No
Click to dismiss this dialog box without restoring the templates.

See Also
■ "Restore the STA Predefined Templates" on page 3-21

Import Template

Description
This dialog box allows you to import a template from your local computer so it is 
available to your STA username.

Screen Fields

Template File
Click Browse and navigate to the location of the template file you want to import. The 
file must have a .xml extension.

Buttons

OK
Click to import the specified template.

Cancel
Click to dismiss the dialog box without importing the template. 

See Also
■ "Import a Template" on page 3-18
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Rename Template

Description
This dialog box allows you to rename a custom template. 

Screen Fields

New Name
Type the name you want to assign. Your entry can be up to 255 alphanumeric 
characters, and it must be unique.

Buttons

OK
Click to apply your changes.

Cancel
Click to dismiss the dialog box without applying your changes. 

See Also
■ "Rename a Template" on page 3-17
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Delete Template

Description
This dialog box allows you to confirm the deletion of a template. It appears when you 
click Delete on the Templates Management screen and your Confirmation preferences 
indicate you want to be prompted before deleting a template.

Screen Fields

Do not ask for confirmation in the future
Select this check box to suppress this dialog box for future template deletions. 

You can restore the dialog box at any time; see the STA Screen Basics Guide for 
instructions.

Buttons

Delete
Click to delete the template.

Cancel
Click to dismiss the dialog box without deleting the template. 

See Also
■ "Delete a Template" on page 3-19
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Save Template

Description
This dialog box allows you to save the current screen settings as a template. It appears 
when you click Save Template on the Templates Toolbar.

Screen Fields

Template Name
User-defined name for this template. Your entry can be up to 255 alphanumeric 
characters in length. 

If you type a new name, a new template is created. If you type a name that already 
exists, the specified template is overwritten with any changes you have made to the 
screen. Depending on your Confirmation preferences, you may be prompted for a 
confirmation before overwriting an existing template.

Shared
Indicate whether you want the template to be visible to other STAusernames. Options 
are:

■ Private – The template is available to the current STAusername only.

■ Public – The template is available to all STAusernames.

Buttons

Yes
Click to save the template.

No
Click to dismiss the dialog box without saving the template. 

See Also
■ "Create a Template" on page 3-12
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Save Template (Overwrite)

Description
This dialog box allows you to confirm modifications to an existing template. It appears 
when you are about to overwrite an existing template and your Confirmation 
preferences indicate you want to be prompted before doing so.

Screen Fields

Do not ask for confirmation in the future
Select this check box to suppress this dialog box for future template modifications. 

You can restore the dialog box at any time; see the STA Screen Basics Guide for 
instructions.

Buttons

Yes
Click to overwrite the template to match the current layout.

No
Click to dismiss the dialog box without overwriting the template. 

See Also
■ "Modify a Template" on page 3-14

Default Template

Description
This dialog box allows you to confirm the currently applied template as the default for 
this screen. It appears when you click Default Template in the Templates toolbar on 
any screen and your Confirmation preferences indicate you want to be prompted 
before setting a new default.
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Screen Fields

Do not ask for confirmation in the future
Select this check box to suppress this dialog box when you set a default template in the 
future. 

You can restore the dialog box at any time; see the STA Screen Basics Guide for 
instructions.

Buttons

Yes
Click to set this template as the default.

No
Click to dismiss the dialog box without setting the default template. 

See Also
■ "Set the Default Template for a Screen" on page 3-10

Media Validation Policy Wizard and Dialog Boxes
■ "Media Validation Configuration Confirmation" on page C-23

■ "Media Validation Policy Wizard" on page C-24

Media Validation Configuration Confirmation

Description
This dialog box allows you to confirm whether you want to enable or disable the 
media validation feature on STA. This is a global setting and affects media validation 
operations for your entire tape library system.

This dialog box appears when you select the Enabled or Disabled radio buttons in the 
Media Validation State field on the Media Validation Configuration screen.

Buttons

Yes
Click to confirm you r selection.

Cancel
Click to dismiss this dialog box without applying your selection.
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See Also
■ "Enable or Disable Media Validation on STA" on page 8-30

Media Validation Policy Wizard

Description
This wizard allows you to define and enable new media validation policies. It also 
allows you to modify information for existing policies. 

This wizard appears when you click New Media Validation Policy, Edit Media 
Validation Policy, or Copy Media Validation Policy on the Media Validation Policies 
toolbar.

Screen Fields

Enter Policy Name

Policy Name
User-assigned name for the media validation policy. Your entry can be up to 250 
alphanumeric characters, and it must be unique.

Policy Description
Optional field. User-assigned description of the media validation policy.

Select Target

Select media type and optional library complex
Click this button to indicate you want to have media selected for validation based on 
media type and optional library complex.

Media Type
Select the type of media.
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Library Complex (Optional)
Select the library complex.

Select logical group
Click this button to indicate you want to have media selected for validation based on a 
defined logical group.

Logical Group
Select the logical group.

Set Up Policy

Policy Criteria
Select the criteria for selecting media within the group you have specified on the 
previous screen. Options are:

■ Random selection – This is the default.

■ Media Health = Action

■ Media Health = Evaluate

■ Media Health = Monitor

■ Extended period of non-use

■ Newly entered

■ Bad MIR detected

Validation Test Type
Select the type of validation to be performed by this policy. Options are:

■ Basic Verify

■ Standard Verify

■ Complete Verify

■ Complete Verify Plus

■ Verify Rebuild MIR

Review

Enable Policy
Select the check box to create the policy and enable it immediately. De-select the check 
box to create the policy but leave it disabled for now; you can enable it at a later time.

Buttons

Breadcrumbs
Breadcrumbs are activated for wizard screens you have already visited and for the 
next immediate screen. Click a link to go directly to the selected screen.

Back
Click to go back to the previous screen in the wizard.

Next
Click to go to the next screen in the wizard.
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Cancel
Click to exit the wizard without applying your entries.

Save

Click to apply your entries and create or update the alert policy.

See Also
■ "Create a Media Validation Policy" on page 8-54

■ "Modify a Media Validation Policy" on page 8-63

Service Log Dialog Boxes
■ Section , "Create New Log Bundle"

■ Section , "Log Bundle Run Info"

■ Section , "Delete Selected Log Bundle"

Create New Log Bundle

Description
This dialog box allows you to assign a name to a new RDA (Remote Diagnostic Agent) 
log bundle.

This dialog box appears when you click Create New Log Bundle on the Logs Toolbar.

Screen Fields

Log Bundle Name
Enter a name. Log name requirements are:

■ Maximum of 210 characters

■ Can only contain alphanumeric characters and underscores, but cannot contain 
four or more consecutive underscores.

■ Spaces are replaced with underscores.

Note: This button appears only on the last screen of the wizard.
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■ Cannot begin with the following uppercase characters:

COM
LPT
PRN
CON
AUX
NUL

Buttons

Save
Click to apply your entries.

Cancel
Click to dismiss this dialog box without applying your entries.

See Also
■ STA Administration Guide

Log Bundle Run Info

Description
This dialog box displays detailed information from the latest log bundle creation run. 
It appears when you select a log bundle on the Service – Logs screen and click Log 
Bundle Run Info. This is a display-only dialog box.
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Buttons

Close
Click to dismiss the dialog box.

See Also
■ STA Administration Guide

Delete Selected Log Bundle

Description
This dialog box allows you to confirm whether you want to delete the selected log 
bundle. It appears when you when you select a bundle on the Service – Logs screen 
and then click Delete. The name of the selected bundle is displayed in the dialog box.

Buttons

Delete
Click to delete the log bundle.

Cancel
Click to dismiss the dialog box without deleting the log bundle. 

See Also
■ STA Administration Guide

SNMP Connections Dialog Boxes
■ "Define SNMP Client Settings" on page C-29

■ "Define Library Connection Details" on page C-31

■ "Confirmation (Delete Library Connection)" on page C-33
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Define SNMP Client Settings

Description
This dialog box allows you to define SNMP connection settings for STA so it can 
receive SNMP data from one or more libraries. You must define settings for both the 
SNMP v3 and SNMP v2c protocols. The appropriate settings (SNMP v3 or SNMP v2c) 
will be used with each monitored library, depending on library firmware level and 
which SNMP protocol the library is configured to use. See the STA Installation and 
Configuration Guide for details.

You must define all of the following settings:

■ For SNMP v3 connections:

– User name

– Connection authorization password

– Privacy password

■ For SNMP v2c connections:

– User community name

– Trap recipient name

This dialog box appears when you click Edit on the SNMP Client Attributes Toolbar.

Screen Fields

STA SNMP Connection Username (Auth)
Required.

Note: The following fields define the SNMP v3 connection settings 
for STA, and all are required. If all monitored libraries use SNMP v2c 
for STA communications, these entries will be ignored and you can 
enter any values.



SNMP Connections Dialog Boxes

C-30 StorageTek Tape Analytics User's Guide

Enter the name of the STA SNMP v3 user. This user must also be defined on all 
monitored libraries that use the SNMP v3 protocol for STA communications.

Enter STA SNMP Connection Password (Auth)
Required.

Enter the connection authorization password for the SNMP v3 user. This password 
must also be defined on all monitored libraries that use the SNMP v3 protocol for STA 
communications.

Verify STA SNMP Connection Password (Auth)
Required.

Re-type the connection password to ensure that you have entered it correctly. An error 
message will be displayed if the two passwords do not match.

Connection Password Encryption (Auth)
Display only.

Encryption technique for storing the connection password. This is always SHA (Secure 
Hash Algorithm).

Enter Privacy Encryption Password (Privacy)
Required.

Enter the privacy encryption password for the SNMP v3 user. This password must 
also be defined on all monitored libraries that use the SNMP v3 protocol for STA 
communications.

Verify Privacy Encryption Password (Privacy)
Required.

Re-type the privacy password to ensure that you have entered it correctly. An error 
message will be displayed if the two passwords do not match.

Privacy Encryption Protocol (Privacy)
Display only.

Encryption technique for the SNMP privacy mechanism. This is always DES (Data 
Encryption Standard).

STA Engine ID
Display only.

Globally unique SNMP engine ID for the STA server. This is assigned by STA and is 
distinct from the library engine ID provided by each library. Both are required to 
ensure secure communication.

Trap Levels
Display only.

List of all the SNMP traps that STA can process. This does not necessarily mean that 
these traps have been configured on the monitored libraries; you must verify this on 
each library.

Note: The following fields define the SNMP v2c connection settings 
for STA, and both are required.
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User Community
Required.

Enter the name of the STA SNMP v2c user. This user must also be defined on all 
monitored libraries that use the SNMP v2 protocol for STA communications. The 
default is public.

Trap Community
Required.

Enter the name of the STA SNMP v2c trap recipient. This trap recipient must also be 
defined on all monitored libraries that use the SNMP v2 protocol for sending traps to 
STA. The default is public.

Buttons

Save
Click to apply your entries.

Cancel
Click to dismiss this dialog box without applying your entries.

See Also
■ STA Installation and Configuration Guide

Define Library Connection Details

Note: If all monitored libraries use SNMP v3 for STA 
communications, this entry will be ignored and you should leave the 
value set to public.

Note: If all monitored libraries use SNMP v3 for sending STA traps, 
this entry will be ignored and you should leave the value set to public.
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Description
This dialog box allows you to define connection details for a library that you want to 
connect to STA.

This dialog box appears when you click Add or Edit on the SNMP Monitored Libraries 
Toolbar.

Screen Fields

Library Complex
Display only.

Library complex ID. This ID is automatically generated by STA when you successfully 
retrieve the latest library configuration data.

Library Name
Required.

Enter the name you want to assign to the library. This name will be used to identify the 
library throughout the STA screens. You may want to use the library host name.

Library Primary IP Address
Required.

Enter the IP address of the public port on the library. For SL150 libraries, this is the 
Network Port 1 port; for SL500 libraries, it is the 1B port; for SL3000 and SL8500 
libraries, it is the 2B port.

Library Secondary IP Address
This field does not apply to SL150 and SL500 libraries and should be left blank.

For SL3000 and SL8500 libraries, your entry in this field depends on the specific 
configuration of the library. This entry enables STA to maintain uninterrupted SNMP 
communications with the library if either a Redundant Electronics switch or a Dual 
TCP/IP failover occurs.

■ For libraries with the Redundant Electronics feature, enter the IP address of the 2B 
port on the alternate (standby) controller card

■ For libraries with the Dual TCP/IP feature, enter the IP address of the 2A port on 
the active controller card.

■ For libraries with both features, you can choose which IP address to enter, 
depending on which feature you want STA to support without interruption. See 
"Configuring the Libraries for STA"in the STA Installation and Configuration Guide 
for detailed instructions.

■ For libraries with neither of these features, leave this field blank.

STA IP Address
Required.

The menu lists all available IP addresses for the STA server. Select the IPv4 address the 
library should use to send SNMP data to the server. If there is more than one listed and 
you are not sure which one to use, see your STA administrator for assistance.

Note: For SL3000 and SL8500 libraries using the Redundant 
Electronics feature, this is the 2B port on the active controller card.
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Library Engine ID
Unique SNMP engine ID of the library automatically provided by the library 
whenever a library data collection is performed. 

Under normal circumstances, you should not modify this field. However, if you have 
reason to believe the library engine ID has changed (due to a firmware upgrade, for 
example), you should blank out this field and STA will detect the new engine ID 
during the next Check/Test Connection or Get Latest Data operation. This is the only 
time you should modify this field.

Automated Daily Data Refresh
Enter the time of day when you want STA to collect the latest configuration data from 
the library. The data will be collected automatically every 24 hours at this time, local to 
the time zone you specify in the Time Zone field.

The default is 00:00 (12:00 am). Use 24-hour time format for your entry (for example, 
13:00 is 1:00 pm).

Library Time Zone
In the menu, select the library's local time zone.

Buttons

Save
Click to apply your entries.

Cancel
Click to dismiss this dialog box without applying your entries.

See Also
■ STA Installation and Configuration Guide

Confirmation (Delete Library Connection)

Description
This dialog box allows you to confirm whether you want to delete the selected library 
connection. It appears when you when you select a monitored library on the 
Configuration – SNMP Connections screen and then click Delete.

Note: It is recommended that you choose a time period when there is 
typically lighter library usage, so the data collection does not conflict 
with other significant library activity.

Caution: If you leave this field blank, scheduled automatic library 
data collections will be disabled. This will cause your STA library 
configuration data to become out of sync with the library.
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Buttons

OK
Click to delete the selected library connection.

Cancel
Click to cancel the deletion and keep the library connection.

See Also
■ STA Installation and Configuration Guide

User Management Dialog Boxes
■ "User Configuration" on page C-34

■ "Delete User" on page C-35

User Configuration

Description
This dialog box allows you to create or modify an STA username.It appears when you 
click Create New User or Modify User on the Configuration – Users screen.

Screen Fields

User Name

Type the name you want to assign to this STA user. Your entry must be unique.

Description
Type a brief description of the STA username. 

Role
Select the role you want to assign to this STA username. Options are:

Note: This field is active only for Create New User.
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■ Viewer – Can access all Home, Tape System Hardware, and Tape System Activity 
screens. 

■ Operator – Has all privileges of the Viewer role. Also has editing privileges for 
some Setup & Administration screens and view-only privileges on Configuration 
screens. 

■ Administrator – Has all privileges of the Operator role, plus has full editing 
privileges for all Setup & Administration screens.

Enter Password

Verify Password

Enter Password
Type the password to want to assign to the user. The entry is masked as you type. 
Password requirements are as follows:

■ Must be 8–32 characters in length

■ Must have at least one special character

■ Must not have any of the following special characters:

< > & ? ( ) {}*'

Verify Password
Type the password again to verify that you have entered it correctly.

Buttons

Save
Click to apply your entries.

Cancel
Click to dismiss this dialog box without applying your entries.

See Also
■ STA Installation and Configuration Guide

Delete User
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Description
This dialog box allows you to confirm whether you want to delete the selected user. It 
appears when you select an STA username on the Configuration – Users screen and 
then click Delete.

Screen Fields

If this user has private templates or groups, how do you wish to handle them?
Indicate what you want to do with any logical groups or private templates owned by 
this STA username. Options are:

■ Make them public – Keep the templates, Executive Report policies, and logical 
groups, but make them public and available to all STA usernames. This is the 
default.

■ Delete them – Delete all private templates, Executive Report policies, and logical 
groups owned by this STA username.

Buttons

Delete
Click to delete the STA username.

Cancel
Click to dismiss the dialog box without deleting the STA username.

See Also
■ STA Installation and Configuration Guide

Email Configuration Dialog Boxes
■ "Define SMTP Server Details" on page C-37

■ "Define Email Details" on page C-38
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Define SMTP Server Details

Description
This dialog box allows you to define the email settings for the SMTP server used to 
send emails from the STA application.

This dialog box appears when you click Edit Selected SMTP Server on the 
Configuration – Email screen.

Screen Fields

SMTP Host Address
Enter the IP address or fully qualified DNS alias of your SMTP email server.

SMTP Port
Enter the SMTP port number for outgoing mail transport. Typically, this is port 25, but 
check with your IT system administrator to verify that this is the port used at your site.

From Name
Enter the name you want displayed in the "From" line in email from the server.

From Email Address
Enter the email address from which the email is being sent. If you do not want users to 
reply to this email, you may want to enter an address in the format:

DoNotReply@Your_Company.com

Enabled?
Select this check box to enable the SMTP email server. De-select this check box to 
disable the email server.

Use Secure Connection Protocol
Select this check box to select the appropriate secure connection protocol. See your IT 
system administrator to determine which connection is right for you. You must select 
one of the following options:
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■ TLS – Click to select Transport Layer Security.

■ SSL– Click to select Secure Sockets Layer.

Requires Authentication
Select this check box to indicate that the SMTP server requires authentication.

Username
Enter a username supported by the SMTP server. Required only if you have selected 
the Requires Authentication check box.

Enter Password
Enter the password assigned to the user. Required only if you have selected the 
Requires Authentication check box.

Verify Password
Enter the password again to verify that you have entered it correctly. Required only if 
you have selected the Requires Authentication check box.

Buttons

Save
Click to apply your entries.

Cancel
Click to dismiss this dialog box without applying your entries.

See Also
■ STA Installation and Configuration Guide

Define Email Details

Description
This dialog box allows you to add an email address eligible to receive emails from 
STA.

This dialog box appears when you click Add Email or Edit Selected Email on the 
Email Addresses Toolbar on the Configuration – Email screen.
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Screen Fields

Address
Enter a destination to send email to in the form:

your_name@your.company.com

Language-Locale
In the menu, select English if it is not already displayed.

Time Zone
In the menu, select the recipient's local time zone.

Buttons

Save
Click to apply your entries.

Cancel
Click to dismiss this dialog box without applying your entries.

See Also
■ STA Installation and Configuration Guide
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